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Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

 DANGER 
indicates that death or severe personal injury will result if proper precautions are not taken. 

 

 WARNING 
indicates that death or severe personal injury may result if proper precautions are not taken. 

 

 CAUTION 
indicates that minor personal injury can result if proper precautions are not taken. 

 

 NOTICE 
indicates that property damage can result if proper precautions are not taken. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

 WARNING 
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 
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Overview  
 

Description 

 
The DC-UPS modules augment the SITOP 24 V power supply units for uninterruptible rated 
currents up to 40 A from the UPS1100 battery modules based on maintenance-free lead or 
LiFePo batteries. SITOP UPS1600 with its integrated electronics automatically detects the 
battery type that it charges with the optimum temperature-controlled charging characteristic 
curve. The intelligent battery management monitors all relevant data, also for parallel-
connected battery modules. The Ethernet/PROFINET interface is used to output the battery 
status and various actual values, such as voltage and current. Thanks to the integrated web 
server, remote diagnosis is also possible. 

The low profile SITOP UPS1600 DC-UPS module provides a dynamic overload behavior, for 
example, to switch on industrial PCs. The high charging current quickly restores the buffer 
readiness after a supply system failure. And for the deployment in stand-alone operation, the 
UPS can be activated from the battery for missing supply system voltage, e.g. to start the 
generators. 

 

The key benefits of the product include: 

● Compact SITOP UPS1600 24 V/10 A, 20 A and 40 A DC-UPS modules with digital 
inputs/outputs, optional with USB or two Ethernet/PROFINET interfaces 

● SITOP UPS1100 24 V/1.2 Ah, 2.5 Ah, 3.2 Ah, 7 Ah and 12 Ah battery modules with 
maintenance-free lead-gel batteries or 5 Ah with LiFePo batteries and integrated 
electronics 

● Intelligent battery management with automatic detection of the battery modules, and 
selection of the optimum temperature-controlled charging characteristic; monitoring of 
readiness for operation, aging and charge status. 

● All diagnostic data and alarm messages are available via USB and Ethernet/PROFINET 

● High dynamic overload capability: 3-fold rated current for 30 ms and 1.5-fold rated current 
for 5 seconds per minute 

● High charging currents 

● Start from battery modules for missing supply system voltage 
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● OPC UA server with encrypted interface 

● Remote monitoring via the integrated web server 

● SITOP UPS Manager (free software download) supports the configuration and monitoring 
for PC-based systems 

● Completely integrated in TIA: user-friendly engineering in SIMATIC STEP 7 and 
SIMATIC STEP 7 in the TIA Portal, S7 function blocks for integration in the user 
programs and WinCC faceplates 

Ordering data 
The following device options are available: 
 
SITOP UPS1600 uninterruptible power supply 
Type Order number 
Input 24 V DC 
Output 24 V DC / 10 A 

6EP4134-3AB00-0AY0 

Input 24 V DC 
Output 24 V DC / 10 A 
With USB interface 

6EP4134-3AB00-1AY0 

Input 24 V DC 
Output 24 V DC / 10 A 
With PROFINET (PN) interface 

6EP4134-3AB00-2AY0 

Input 24 V DC 
Output 24 V DC / 20 A 

6EP4136-3AB00-0AY0 

Input 24 V DC 
Output 24 V DC / 20 A 
With USB interface 

6EP4136-3AB00-1AY0 

Input 24 V DC 
Output 24 V DC / 20 A 
With PROFINET (PN) interface 

6EP4136-3AB00-2AY0 

Input 24 V DC, 
Output 24 V DC / 40 A 

6EP4137-3AB00-0AY0 

Input 24 V DC, 
Output 24 V DC / 40 A 
With USB interface 

6EP4137-3AB00-1AY0 

Input 24 V DC, 
Output 24 V DC / 40 A 
With PROFINET (PN) interface 

6EP4137-3AB00-2AY0 
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SITOP UPS1100 battery module 
Type Order number 
Battery module 1.2 Ah (lead) 6EP4131-0GB00-0AY0 
Battery module 2.5 Ah (pure lead) 6EP4132-0GB00-0AY0 
Battery module 3.2 Ah (lead) 6EP4133-0GB00-0AY0 
Battery module 5 Ah (LiFePO4) 6EP4133-0JB00-0AY0 
Battery module 7 Ah (lead) 6EP4134-0GB00-0AY0 
Battery module 12 Ah (lead) 6EP4135-0GB00-0AY0 

 
 
Accessory for SITOP UPS1600 
Type Order number 
Device identification labels 20 mm × 7 mm,  
pastel turquoise 

3RT1900-1SB20 
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 Safety instructions 1 
 

 

 
 

 WARNING 

Correct handling of the devices 

When operating electrical devices, it is inevitable that certain components will carry 
dangerous voltages. 

Therefore, failure to handle the units properly can result in death or serious physical injury 
as well as extensive property damage. 

Only appropriately qualified personnel may work on or in the vicinity of this equipment. 

Perfect, safe, and reliable operation of this equipment is dependent on proper 
transportation, storage, installation and mounting. 

Before installation or maintenance work can begin, the system's main switch must be 
switched off and measures taken to prevent it being switched on again. 

If this instruction is not observed, touching live parts can result in death or serious injury. 
 

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines, and networks. 

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Siemens’ products and solutions only form one element of such a concept. 

Customer is responsible to prevent unauthorized access to its plants, systems, machines 
and networks. Systems, machines and components should only be connected to the 
enterprise network or the internet if and to the extent necessary and with appropriate security 
measures (e.g. use of firewalls and network segmentation) in place. 

Additionally, Siemens’ guidance on appropriate security measures should be taken into 
account. For more information about industrial security, please visit: 
 http://www.siemens.com/industrialsecurity. 

Siemens’ products and solutions undergo continuous development to make them more 
secure. Siemens strongly recommends to apply product updates as soon as available and to 
always use the latest product versions. Use of product versions that are no longer supported, 
and failure to apply latest updates may increase customer’s exposure to cyber threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed under 
 http://www.siemens.com/industrialsecurity. 
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 Description, device design, dimension drawing 2 
2.1 Device description 

2.1.1 SITOP UPS1600 
The SITOP UPS1600 10 A, 20 A and 40 A are built-in devices of the SITOP series for 
mounting on TH35-15/7.5 standard mounting rails (EN 60715). When installing the 
SITOP UPS1600 devices and SITOP UPS1100 battery modules, the relevant DIN/VDE 
regulations or country-specific regulations (e.g. VDE 0510 Teil 2 / EN 50272-2) must be 
carefully complied with. 

See Section Installation (Page 203)  

In combination with the SITOP UPS1100 battery modules, they are used to buffer the load 
current from the 24 V load power supplies of the SITOP series. 
With their high dynamic overload capability up to the 300 % rated current for 30 ms or up to 
the 150 % rated current for 5 seconds per minute, they are suitable for applications with 
programmable logic controllers (PLCs) and industrial PCs, because they permit high switch-
on currents even in buffer operation.  

The input of the SITOP UPS1600 DC-UPS module must be connected with the output of the 
supplying 24 V DC power supply unit. The UPS1100 battery module is connected to the BAT 
terminals. The loads to be buffered are supplied via the output of the SITOP UPS1600 DC-
UPS module with the voltage connected at the input.  

The Energy Storage Link is new. This is an additional two-wire connection between the 
SITOP UPS1600 base device and the coded SITOP UPS1100 battery modules. 
Furthermore, the base device detects and manages as many as six battery modules and 
selects the optimum, temperature-controlled charging characteristic curve. The latter 
provides the basis for the long service life of the battery modules. The Energy Storage Link 
also monitors the operational readiness as well as the supply cables (wire breakage) and the 
charge state (voltage, current) of the rechargeable batteries. 
The connection to the SITOP UPS1100 battery module is checked every 20 seconds (for 
voltage, reverse polarity protection). A test with a defined load of the lead or LiFePo batteries 
is also performed automatically every four hours (basic setting). 
Battery modules of other type series and manufacturers can also be used, although with 
limited diagnostic functions, such as the display of the charging current or the end-of-charge 
voltage and without the possibility of temperature-controlled charging. 

In the event of failure of the 24 V DC supply voltage or voltage dip below the set switch-in 
threshold, the loads are supplied by switching over to the battery module. Buffering is 
realized until the line supply returns or until the buffer time, set using the rotary coding 
switch, has expired. If the buffer time has been set to MAX, then shutdown is realized when 
the exhaustive discharge threshold is reached. 

Using the output voltage interrupt function you can select as to whether the output voltage is 
interrupted once the set buffer time expires if, in the meantime, the input voltage returns 
(status when the device is delivered: the output voltage is not interrupted). For devices 
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without interface, the interruption lasts 5 s. For devices with interface, the interruption 
duration can be adjusted. 

For devices with software release up to V2.0.1, this function is only available for devices with 
interface, as the output voltage is only interrupted after a shutdown signal is received. 

For software version > V2.0.1, the interruption of the output voltage is independent of 
receiving a shutdown signal. 

For the "Maximum buffer time" setting, the output voltage is only interrupted by the UPS 
Manager. In this case, the rotary coding switch "Connection threshold" must be set to REN.  

Rotary switches can be used to set the battery module switch-in threshold and the buffer 
time. The charging current for the battery modules is set automatically, and can be changed 
using the interface (only for types -1AY0 and -2AY0), as well as via the signal connector. 

Eight LEDs, two potential-free changeover contacts and one floating NO contact indicate the 
SITOP UPS1600 status. 

The USB interface (only -1AY0) or PROFINET/Ethernet interface (only -2AY0) handles the 
communication to the PC/controllers. 
For details, see Sections Connections and terminal designation (Page 20) and Operator 
controls (Page 25). 

Operating data and diagnostic data can be transferred using two integrated Industrial 
Ethernet/PROFINET ports and visualized or further processed externally as an alternative to 
the proven USB connection. An integrated web server allows authorized users to export 
relevant data remotely via a web browser without requiring any additional software to be 
installed on the remote system. When delivered, the web server is not active (applies from 
version V2.1 and higher). Using the two rotary coding switches, the web server can be 
activated, and a temporary Internet address assigned, see SITOP UPS1600 (Page 25). 
The free-of-charge SITOP UPS Manager, which runs on Windows XP and Windows 7 
systems (32 and 64 bit), allows full access. This allows the overall DC-UPS installation to be 
configured and monitored easily using a PC. The software tool provides many possibilities 
for the visualization of operating and diagnostic information, such as in the form of alarm lists 
or easily understandable trend diagrams which, for example, provide a view of the 
chronological change of the charging current or load current of the DC-UPS at a glance. 
The SITOP UPS1600 is fully integrated in Totally Integrated Automation (TIA), the Siemens 
open system architecture for integrated automation solutions. The engineering is performed 
in the TIA Portal and reduces to just a few clicks for the user. The UPS modules can be 
selected directly in the hardware catalog and transferred into the graphic network 
representation. 
For applications without network connection, the SITOP UPS1600 is available in the variants 
with USB interface or digital inputs/outputs. 
For stand-alone operation, the DC-UPS can be activated without input voltage from the 
battery, for example, to start a generator via a directly supplied controller. (see Chapter 
Jumper variants (Page 26)) 
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① DC input X1 
② DC output X1 
③ BAT X1 
④ Signal connector X2 
⑤ PROFINET (Ethernet) interface X3 (only for ... - 2AY0) 
⑥ USB interface X3 (only for ... - 1AY0) 
⑦ Rotary coding switch, switch-in threshold 
⑧ Rotary coding switch, buffer time 
⑨ Signaling (LEDs) 
⑩ DIN rail slider 
⑪ Convection 
⑫ Clearance above/below 

Figure 2-1 SITOP UPS1600 design (example 6EP4136-3AB00-2AY0) 
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2.1.2 SITOP UPS1100 
The SITOP UPS1100 battery modules consist of a battery holder with two maintenance-free, 
closed lead or LiFePO batteries with terminals for the connection cables to the 
SITOP UPS1600 uninterruptible power supply. The UPS1100 contains a printed-circuit 
board for monitoring the battery functions and the communication with the SITOP UPS1600. 
A green LED lights continually to indicate that there is a communication connection to the 
SITOP UPS1600. The LED flashes when the batteries are being replaced or for faults and 
alarms. 

 

 Note 

Battery module UPS1100 5 Ah with LiFePo batteries can only be used in conjunction with 
UPS1600 from software version V2.1. 

 

Up to 6 SITOP UPS1100 of the same type can be connected in parallel with a 
SITOP UPS1600. 

When replacing a battery, see Chapter Battery replacement (Page 208). 

 

 
① DC input X1 
② Signal terminal X2 
③ Fuses F1/F2 (F2 only for 7 Ah and 12 Ah) 
④ Signaling (LED) 
⑤ Mounting rail holder (not for the 7 Ah and 12 Ah versions) 
⑥ Natural convection 
⑦ Clearance above 

Figure 2-2 SITOP UPS1100 design (example 6EP4133-0GB00-0AY0) 
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 Note 

For the UPS1100, clearance is required above it in order to open the cover. Clearance below 
is not required for thermal reasons - however, space is required to feed in the cable. 
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2.2 Connections and terminal designation 

2.2.1 SITOP UPS1600 

2.2.1.1 Power terminals 
The input terminals ① can be used to establish the connection to the supply voltage. The 
output terminals ② are used to connect to the supplied loads. 

Cables must be used that are suitable for at least 90 °C (only for applications for UL508). 

The UPS1100 battery modules are connected via BAT ③. 

(see also Chapter Installation (Page 203)) 
 
Connections and terminal designations  
(see Figure 2-1 SITOP UPS1600 design (example 6EP4136-3AB00-2AY0) (Page 17)) 

① DC input IN+, IN- One screw terminal each 

② DC output OUT+, OUT- One screw terminal each 

③ BAT+, BAT- One screw terminal each 

④ Signal connector Connector with 14 screw terminals 

⑤ PROFINET (Ethernet) connection RJ45 plug-in contact (only for ...-2AY0) 

⑥ USB connection USB-B plug-in contact (only for...-1AY0) 

 

 
Figure 2-3 Terminal data SITOP UPS1600 10 A, 20 A 
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Figure 2-4 Terminal data SITOP UPS1600 40 A 

2.2.1.2 Signal terminal 

 
④ Signal connector 

 
Wire jumper  

Figure 2-5 Signal connector 

 
Figure 2-6 Signal connector connection schematic 
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Pin Terminal designation Function 

1 BAT. 24 V DC OK / BAT 
REL1 (changeover contact):  
   Energized state: Normal operation 
Quiescent state: Buffer mode or off 

2 - 
3 OK 

4 ALARM Ready for buffer operation / alarm 
REL2 (changeover contact): 
   Energized state: Buffer mode is possible 
   Quiescent state: Not ready for buffering 
   Cycle 0.25 Hz: Defective battery 

5 - 
6 RDY TO BUFFER 

7 BAT. > 85 % Battery > 85% 
REL3 (NO contact): 
   Energized state: Buffering of the selected buffer time is possible,  
   or charge state > 85 % 

8 - 

9 ON/OFF On/Off (buffer operation permitted/prevented) 
10 - - 
11 BAT. X2.1 Battery communication or charging current setting 
12 BAT. X2.2 Battery supply or charging current setting 
13 INTERRUPT Interrupt (interruption of the output voltage) 
14 START Start from the battery 

Relay contact: Contact rating, max. AC 30 V/0.5 A; DC 60 V/0.3 A; DC 30 V/1 A 

The jumper (4a) (see Figure Signal connector (Page 21)) between pin 9 and 10 is necessary 
to operate the device in buffer mode. 

Delivery state: Jumper between pin 9 and 10 

2.2.1.3 USB port 

 
Figure 2-7 USB port 

The USB interface (type B) ⑥ fully conforms to the USB 2.0 standard (12 MBd). Strain relief 
(see Section USB connector (Page 189)) is implemented using a defined cable/connector 
(Y-Con USB - Yamaichi). 
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2.2.1.4 PROFINET/Ethernet connection 

 
Figure 2-8 PROFINET/Ethernet connection 

The Ethernet interface ⑤ corresponds to the standard full duplex up to 100 Mbit/s electrical 
(100BASE-TX) according to IEEE 802.3.. 

Properties of the Ethernet interface: 

● Transfer rate 10/100 Mbit/s 

● Two RJ45 sockets, i.e. integrated switch, for RJ45 connector 

● Cable type 100Base-TX (CAT5) 

● Auto negotiation 

● Auto crossover communication via TCP/IP and PROFINET 

The strain relief (see Section PROFINET/Ethernet connector (Page 190)) is implemented 
using a Siemens IE FastConnect RJ45. 

The physics of the Ethernet interface is implemented so that PROFINET IO according to 
standards IEC 61158 and IEC 61784-2 is possible. For PROFINET, conformance class B 
must be maintained as a minimum. 

The Ethernet/PROFINET interface permits: 

● Configuration and monitoring using the SITOP UPS Manager 

● Monitoring via the Web server 

● Integration and communication of the DC-UPS with other automation components from 
Siemens and the open environment, e.g. IPC, PLC, HMI, OPC UA 

● Firmware update of the device via UPS Manager, web server or STEP 7 
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2.2.2 SITOP UPS1100 

2.2.2.1 Power terminals 
Input terminals ① and signal terminal ② can be used to establish the connection to 
SITOP UPS1600. (also see Chapter Installation (Page 203)). 
 
Connections and terminal designations (see Figure 2-2 SITOP UPS1100 design (example 6EP4133-
0GB00-0AY0) (Page 18)) 

① DC input +, - One screw terminal each 

② Signal terminal 1, 2 One screw terminal each 

 

 
Figure 2-9  Terminal data for 6EP4131-0GB00-0AY0, 6EP4132-0GB00-0AY0, 6EP4133-0GB00 

and 6EP4133-0JB00-0AY0 

 

 
Figure 2-10 Terminal data for 6EP4134-0GB00-0AY0 and 6EP4135-0GB00-0AY0 
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2.3 Operator controls 

2.3.1 SITOP UPS1600 

2.3.1.1 Rotary coding switch, switch-in threshold 
The switch-in threshold can be set using the rotary coding switch ⑦ on the device front 
between 21.0 V and 25.0 V (21 - 21.5 - 22 - 22.5 - 23 - 24 - 25 volt). The delivery state is 
22.5 V 

For devices with an interface (…-1AY0, …-2AY0), the coding switch has an additional REN 
position. If this is selected, the software settings (for the switch-in threshold and the backup 
time) apply rather than the hardware settings. In the switch position REN, the connection 
X2.13 (INTERRUPT - reset after buffer operation) of the signal terminal (see Section Signal 
terminal (Page 21)) has no effect. 

 
Figure 2-11 Rotary coding switch, switch-in threshold 

 

 Note 

It is only permissible to operate the rotary switch using an insulated screwdriver. 
 

For notes on actuating the rotary coding switch (screwdriver, torque), see Figure 2-3 
Terminal data SITOP UPS1600 10 A, 20 A (Page 20). 

2.3.1.2 Rotary coding switch, backup time 
The buffer time is set using the rotary coding switch ⑧ on the device front between 30 
seconds and MAX in steps of 0.5 minute (30 s), 1 minute, 2 minutes, 5 minutes, 10 minutes, 
20 minutes and MAX. The MAX setting means that buffering is realized for as long as 
possible. The device only shuts down when the battery has discharged down to the stop 
buffering voltage (factory setting, 18.5 V). Delivery state is MAX 

The rotary coding switch has an additional setting OFF (see following diagram). If this is 
selected and the additional threshold rotary coding switch is not set to REN, then buffering is 
deactivated. 

If the buffer time is to be set using the software (only for devices with an interface (…-1AY0, 
…-2AY0)) (possible setting range, see Section Parameterizing SITOP UPS1600 (Page 77)), 
the rotary coding switch for the connection threshold must be set to REN (see Section 
Rotary coding switch, switch-in threshold (Page 25)). 
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Figure 2-12 Rotary coding switch, buffer time 

 

 Note 

It is only permissible to operate the rotary switch using an insulated screwdriver. 
 

For notes on actuating the rotary coding switch (screwdriver, torque), see Figure 2-3 
Terminal data SITOP UPS1600 10 A, 20 A (Page 20) 

2.3.1.3 Jumper variants 

On/Off (pin 9) 

The wire jumper on the signal connector ④ between pin 9 and pin 10 is used to 
enable/disable the buffer mode (see Figure 2-5 Signal connector (Page 21)). 

Buffer operation is only possible if the ON/OFF wire jumper is connected. The ON/OFF wire 
jumper has priority over the position of the switch-in threshold rotary coding switch. Delivery 
state: Wire jumper is connected between pin 9 and 10 

As a consequence, buffer operation can be enabled or prevented using a floating contact 
(e.g. a contact in the plant or system). The contact is switched instead of the ON/OFF wire 
jumper. 

 

 Note 

The contact in the switched-on state must have a resistance of < 10 Ohm,  
contact load must be a minimum of 15 V / 5 mA. 

 

 Note 

The external circuit must meet the requirements relating to SELV circuits according to 
EN60950-1. 
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Changes are also effective in the buffer mode. 

Table 2- 1 With interface (up to firmware release less than V1.20) 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection thresh-
old 

Wire jumper 
ON/OFF with respect to - 

Result 

OFF 21 - 25 Yes Buffering not permitted 
0,5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time corresponding 
to the settings or maxi-
mum buffer time) 

OFF, 0,5 - MAX 21 - 25 No Buffering not permitted 
OFF, 0,5 - MAX REN Not relevant The software settings 

apply 
 

Table 2- 2 With interface (from firmware release V1.20 up to V2.0.x) 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection thresh-
old 

Wire jumper 
ON/OFF with respect to - 

Result 

OFF 21 - 25 Yes Buffering not permitted 
0,5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time corresponding 
to the settings or maxi-
mum buffer time) 

OFF, 0,5 - MAX 21 - 25, REN No Buffering not permitted 
OFF, 0,5 - MAX REN Yes The software settings 

apply  
 

Table 2- 3 With interface (from firmware release V2.1) 

Rotary coding 
switch 

buffer time 

Rotary coding 
switch 

switch-in threshold 

Wire jumper 
ON/OFF with respect to - 

Result 

OFF 21 - 25 Yes Buffering not permitted 
0,5 - MAX 21 - 25 No  Buffering not permitted 
0,5 - MAX 21 - 25 Yes Buffer mode permitted 

(buffer time corresponding 
to the settings or maxi-
mum buffer time) 

OFF, 
0,5 - MAX 

21 - 25 REN No Buffering not permitted 
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Rotary coding 
switch 

buffer time 

Rotary coding 
switch 

switch-in threshold 

Wire jumper 
ON/OFF with respect to - 

Result 

0,5 - MAX REN Yes The software settings 
apply 

OFF REN Not relevant The web server can be 
activated, and a temporary 
Internet address assigned 
(precondition: IP address 
is 0.0.0.0 (when deliv-
ered)) 

 

Table 2- 4 Without interface 

Rotary coding 
switch, 

buffer time 

Rotary coding 
switch, 

connection thresh-
old 

Wire jumper ON/OFF with 
respect to - 

Result 

OFF 21 - 25 Yes Buffering not permitted 
OFF 21 - 25 No Buffering not permitted 

0,5 - MAX 21 - 25 Yes Buffer mode permitted 
(buffer time corresponding 
to the settings or maxi-
mum buffer time) 

0,5 - MAX 21 - 25 No Buffering not permitted 

Interruption of the output voltage (pin 13) 

A wire jumper on the signal connector ④ between pin 13 and pin 10 is used to 
enable/disable the interruption of the output voltage, after the set buffer time expires, for the 
parameterized time (default value 5 seconds) when the line supply returns during the buffer 
time. The default value can only be changed for devices with USB or Ethernet/PROFINET 
interface. 

To prevent data losses, PCs must be shut down in time before the buffer time ends. If the 
input voltage returns after the shutdown has already started, the SITOP UPS1600 terminates 
the buffer mode and transitions into normal operation. The PC will be shut down, however, it 
is not switched off. PCs, which do not have an on/off switch, can only be rebooted by 
switching off the power and switching on again. When the "Interrupt output voltage" jumper is 
inserted, the UPS generates this pulse. 

Start from the battery (pin 14) 

The start from the battery is initiated by connecting pin 14 to pin 10. This jumper must not 
provide a permanent connection, but must be controlled using a button. The input is 
designed so that a single lamp with a permissible supply voltage of between 12 and 30 V 
and 8 to 15 mA can be switched in series to the switching contact. If the button is actuated 
when the input voltage is not available, and if buffering is permitted, then the UPS goes into 
the buffer mode. The UPS1600 shuts down if, at the end of the selected buffer time, an input 
voltage is still not available. 

The SITOP UPS1600 starts in normal operation if the input voltage is available. 
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This can occur if the UPS was remotely shut down via the interface. 
 

 Note 

From UPS Manager Version V4.71.13 and UPS1600 Version V2.1.0, when starting from the 
battery, buffer operation is identified when powering up. After the set time "Shut down PC on 
power failure" the PC is correctly powered down and switched off. For earlier versions of the 
UPS Manager and the UPS1600 Version, when starting from the battery after the buffer time 
expires, the output of the UPS1600 is switched off without first having powered-down the 
PC. 

 

Charge current setting (pin 10 / 11 / 12) 

For uncoded batteries, the size of the charge current can be changed by placing jumpers 
between terminals X2.10 (-) and X2.11 or X2.12. These settings are only effective if the 
"Connection threshold" rotary coding switch is not set to REN. 

Table 2- 5 Charge current 

SITOP UPS1600 
10 A 

SITOP UPS1600 
20 A and 40 A 

Terminal X2.11 Terminal X2.12 

0.3 A 0.8 A open open 
0.8 A 1.75 A open connected with X2.10 
Max. Max. connected with X2.10 open 

Remark 
The charge current can be automatically reduced if the charge current plus the load current 
at the UPS1600 results in an overload of the feeding power supply. The charge current can 
also be reduced if the ambient temperature of the UPS1600 is higher than 40 °C - or if the 
input voltage at the UPS1600 is less than 24 V. 
Derating: 
10 A: 3 A-->2 A 
20 A: 4 A-->3 A 
40 A: 5 A-->3 A 
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2.3.2 SITOP UPS1100 

2.3.2.1 Buttons for battery replacement 
For the SITOP UPS1100, below the cover there is a button ⑧ for battery replacement, see 
Battery replacement (Page 208) 

 

 
Figure 2-13 Buttons for battery replacement 
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2.4 Operating displays and signaling 

2.4.1 SITOP UPS1600 

2.4.1.1 LEDs 
 

 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

Status display 
 
 
 
 
 
• Remark 

LED 1: Operating mode DC-UPS 
LED 2: Charge state 
LED 3: Buffer readiness 
LED 4: Battery test 
LED 5: for PROFINET-specific diagnostic displays 
LED 6: for PROFINET-specific diagnostic displays 
LED 7: Connection status Ethernet port 1 
LED 8: Connection status Ethernet port 2 
LEDs 5 to 8 are only active for... -2AY0 

 

 
LEDs Labeling, just the same as at the housing Description 
LED 1 O.K./BAT. Operating mode DC-UPS 
LED 2 BAT. > 85 % Charge state 
LED 3 ALARM Ready for buffering 
LED 4 BAT. FAULT Battery test 
LED 5 SF for PROFINET-specific diagnostic displays 
LED 6 RUN for PROFINET-specific diagnostic displays 
LED 7 P2 Connection status Ethernet port 1 
LED 8 P1 Connection status Ethernet port 2 

 
Figure 2-14 Operating displays 

Legend: 
 

  LED off 

  LED lights up 

 
0.5/3 

LED flashes in the interval: 0.5 s on - 3 s off 
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LED 1 (O.K./BAT) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Off DC-UPS off 

 Red DC-UPS defect (severe hardware fault) 

 Flashing red (0.5/0.5) Firmware update 

 Flashing red (1/1) Software corrupted 

 Flashing yellow 
(0.5/0.5) 

Critical temperature identified, overtemperature or overvoltage at the input 

 Flashing yellow (0.5/3) Buffer mode, output off 

 Yellow Buffer mode, output on 

 Flashing green (0.5/3) DC-UPS OK, output off 

 Green DC-UPS OK, output on 

 

LED 2 (BAT>85 %) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Flashing green 
(0.5/0.5) 

Firmware update 

 Off Battery charge state <85 % 

 Green Battery charge state >85 % 

 

The LED and the relay contact (see Chapter Relay outputs (Page 34)) have two meanings: 

1. If no other settings have been made, then the LED lights up after reaching a charge state 
greater than 85 %. The LED goes dark if the charge state falls below 85 %. 

2. If an expected buffer current and a buffer time are set under the hardware configuration, 
then the LEDs and the relay contact serve as an indicator when buffering is possible with 
the two parameters – or is no longer possible. 

 

 Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, for 
the evaluation, instead of the expected buffer current, the actually measured buffer current is 
used. As a consequence, the status of the LEDs and the relay can also change. 
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LED 3 (alarm) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Red Output off for 45 seconds because of overcurrent, overtemperature or buffer operation not 
possible 

 Off Buffer operation possible 

 

LED 4 (battery/BAT.Fault) 
 

Signaling 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

 Off Battery O.K. or uncoded battery modules connected or buffer time rotary coding switch at 
position MAX 

 Flashing yellow 
(0.5/0.5) 

Battery outside the permitted temperature range 

 Red Battery defective 

 Yellow Selected buffer time cannot be attained 

 

LED 5 and LED 6 (PROFINET LEDs) 
 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 
6EP4137-3AB00-2AY0 

LED 5 (SF) LED 6 (RUN)  

 Off  Off No connection to a PROFINET IO controller 

 Off  Flashing green 
(0.5/0.5) 

Configuration by the PROFINET IO controller 

 Off  Green Application started successfully, module O.K. 

 Red  Green Application started successfully, module not O.K. 

 Flashing red (0,1/0,1)  Green Application in progress, diagnosis can be called 

 Flashing red (0.5/0.5)  Flashing green 
(0.5/0.5) 

Self-test running (flashing alternately every 3 s) 

 Flashing red (0.5/0.5)  Off DCP requires device identification (LED flashes for 
3 seconds) 

 Flashing red (0.5/0.5)  Flashing green 
(0.5/0.5) 

Firmware update 

LEDs 5 and 6 are active only for ... -2AY0. 
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LED 7 (Ethernet LED / P2) 
 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 
6EP4137-3AB00-2AY0 

 Off Device not connected with controller  

 Green Device connected with controller, no activity 

 Green/orange alternately Device connected with controller, send/receive data (RX/TX) 

LED 7 is active only for ... -2AY0 

LED 8 (Ethernet LED / P1) 
 

Signaling 6EP4134-3AB00-2AY0 
6EP4136-3AB00-2AY0 
6EP4137-3AB00-2AY0 

 Off Device not connected with controller  

 Green Device connected with controller, no activity 

 Green/orange alternately Device connected with controller, send/receive data (RX/TX) 

LED 8 is active only for ... -2AY0 

2.4.1.2 Relay outputs 

 
Figure 2-15 Signal connector connection schematic 

 

 REL1 (changeover contact): 
Energized state: Normal operation (X2.2 - X2.3) 
Deenergized state: Buffer mode or off 

 REL2 (changeover contact): 
Energized state: Buffer operation is possible (X2.5 - X2.6) 
Deenergized state: Not ready for buffering 
Cycle 0.25 Hz: Battery defective or different – or more than 6 battery modules connected – or 
the selected buffer time is not reached. 

REL3 (NO contact): 
Energized state: Buffering of the selected buffer time is possible, or charge state > 85 %. 
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Contact rating: 
30 V AC/0.5 A 60 V DC/0.3 A 30 V DC/1 A 

 

 Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, for 
the evaluation, instead of the expected buffer current, the actually measured buffer current is 
used. As a consequence, the status of the LEDs and the relay can also change. 
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2.4.2 SITOP UPS1100 

2.4.2.1 LEDs 
 

 6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4132-0GB00-0AY0 (2.5 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4133-0JB00-0AY0 (5 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 
6EP4135-0GB00-0AY0 (12 Ah) 

Status display LED battery 

 

 
Figure 2-16 6EP4131-0GB00-0AY0 example 

 

Table 2- 6 LED ④ battery 

Signaling 6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4132-0GB00-0AY0 (2.5 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4133-0JB00-0AY0 (5 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 
6EP4135-0GB00-0AY0 (12 Ah) 

 Flashing green 
(0.5/0.5) 

Error or alarm, battery replacement initiated 

 Off Battery off, no communication 

 Green Battery OK 
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2.5 Block diagram 

2.5.1 SITOP UPS1600 

 
Figure 2-17 Block diagram SITOP UPS1600 
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2.5.2 SITOP UPS1100 

 
Figure 2-18 Block diagram SITOP UPS1100 
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2.6 Dimensions and weight 

2.6.1 SITOP UPS1600 

 
Figure 2-19 6EP4134-3AB00-0AY0, 6EP4134-3AB00-1AY0, 6EP4136-3AB00-0AY0,6EP4136-

3AB00-1AY0 dimensioned drawing 

 
Figure 2-20 6EP4134-3AB00-2AY0, 6EP4136-3AB00-2AY0 dimensioned drawing 
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Figure 2-21 Dimension drawing 6EP4137-3AB00-0AY0, 6EP4137-3AB00-1AY0 

 
Figure 2-22 Dimension drawing 6EP4137-3AB00-2AY0 
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 6EP4134-3AB00-0AY0 6EP4134-3AB00-1AY0 6EP4134-3AB00-2AY0 
Dimensions (W × H × D) in 
mm 

50 × 138.7 × 125 50 × 138.7 × 125 50 × 138.7 × 125 

Weight Approx. 0.38 kg Approx. 0.4 kg Approx. 0.45 kg 

 
 

 6EP4136-3AB00-0AY0 6EP4136-3AB00-1AY0 6EP4136-3AB00-2AY0 
Dimensions (W × H × D) in 
mm 

50 × 138.7 × 125 50 × 138.7 × 125 50 × 138.7 × 125 

Weight Approx. 0.39 kg Approx. 0.41 kg Approx. 0.45 kg 

 
 

 6EP4137-3AB00-0AY0 6EP4137-3AB00-1AY0 6EP4137-3AB00-2AY0 
Dimensions (W × H × D) in 
mm 

70 × 138.7 × 150 70 × 138.7 × 150 70 × 138.7 × 150 

Weight Approx. 0.65 kg Approx. 0.65 kg Approx. 0.7 kg 
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2.6.2 SITOP UPS1100 

 
Figure 2-23 6EP4131-0GB00-0AY0 dimensioned drawing 

 
Figure 2-24 Dimension drawing 6EP4132-0GB00-0AY0  
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Figure 2-25 6EP4133-0GB00-0AY0 dimensioned drawing 

 
Figure 2-26 Dimension drawing 6EP4133-0JB00-0AY0 
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Figure 2-27 6EP4134-0GB00-0AY0 dimensioned drawing 

 
Figure 2-28 Dimension drawing 6EP4135-0GB00-0AY0 
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 6EP4131-0GB00-0AY0 
(1.2 Ah) 

6EP4132-0GB00-0AY0 
(2.5 Ah) 

6EP4133-0GB00-0AY0 
(3.2 Ah) 

Dimensions (W × H × D) in 
mm 

89 × 130.3 × 106.7 265 × 115 × 76 190 × 169.3 × 78.7 

Weight Approx. 1.9 kg Approx. 3.7 kg Approx. 3.8 kg 
 

 

 6EP4133-0JB00-0AY0 
(5 Ah) 

6EP4134-0GB00-0AY0 
(7 Ah) 

6EP4135-0GB00-0AY0 
(12 Ah) 

Dimensions (W × H × D) in 
mm 

189 × 185.5 × 112.7 186 × 186 × 110.3 253 × 186 × 110 

Weight Approx. 3.4 kg Approx. 6.1 kg Approx. 9.8 kg 
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 Engineering and remote access 3 
3.1 General 

This section describes the software tools offered by Siemens that are compatible with 
SITOP UPS1600 . The software tools are introduced with their functions, the associated 
requirements and the operation. The software products are: 

● SIMATIC STEP 7 in the TIA Portal 

● SIMATIC STEP 7 

● SITOP UPS Manager 

● Web server 

● OPC UA 

Functions of the individual software products 

● SIMATIC STEP 7 in the TIA Portal 
The SITOP UPS1600 can be used with STEP 7 in the TIA portal from version 12 with 
service pack 1 (SP1). 
From SW version V2.2, STEP 7 can be used in the TIA Portal from version 13 with 
service pack 1. 
After SITOP UPS1600 has been saved in the hardware catalog of STEP 7 in the TIA 
Portal , it can be integrated in the project, parameterized and diagnosed. 

● SIMATIC STEP 7 
SITOP UPS1600 can be used with SIMATIC STEP 7 from Version 5.4. 
After SITOP UPS1600 has been integrated in the hardware catalog of STEP 7 it can be 
integrated in projects, parameterized and diagnosed. 

● SITOP UPS Manager 
Using the SITOP UPS Manager , theSITOP UPS1600 can be parameterized. In addition, 
the protection of individual computers or computer networks can be determined by 
shutdown conditions after the failure of the supply voltage. 

● Web server 
The web server is used to monitor the SITOP UPS1600. It operates independently of the 
UPS Manager and the PROFINET access. 

 

 Note 

SIMATIC STEP 7 and the SITOP UPS Manager cannot simultaneously access the 
SITOP UPS1600. 
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3.2 Overview of application examples 
At our support web site you can find the following application example to parameterize the 
SITOP UPS1600 uninterruptible power supply: 

● "SITOP UPS1600: Graphic blocks and STEP 7 communication blocks" to integrate 
SITOP UPS1600 into an automation system : 
(https://support.industry.siemens.com/cs/ww/en/view/78817848) 

https://support.industry.siemens.com/cs/ww/en/view/78817848


 Engineering and remote access 
 3.3 SIMATIC STEP 7 in the TIA Portal 

SITOP UPS1600 / UPS1100 
Manual, 04.2017, A5E37775406-8-76 49 

3.3 SIMATIC STEP 7 in the TIA Portal 

3.3.1 Introduction 
The uninterruptible power supply SITOP UPS1600 can be used with SIMATIC STEP 7 in the 
TIA Portal from Version 12 with service pack 1 (SP1). From SW version V2.2, STEP 7 can 
be used in the TIA Portal from Version 13 with service pack 1.  

In SIMATIC STEP 7 in the TIA Portal , the basic device SITOP UPS1600 and its battery 
modules SITOP UPS1100 can be integrated in projects, parameterized and diagnosed. 

 

 Note 

If you wish to use SIMATIC STEP 7 V13 in the TIA Portal, then you must install the 
appropriate Hardware Support Package (HSP) or the appropriate generic station description 
file (GSD) in order to use the SITOP UPS1600 and the supplementary modules. This step is 
not required from SIMATIC STEP 7 V14 in the TIA Portal. Using SITOP UPS1600 with HSP 
is only possible from TIA Version V13; in TIA Version12, only using GSD. 

You can find additional information at Installing the Hardware Support Package (HSP) 
(Page 50) or Installing the generic station description file (GSD) (Page 52). 

 

 Note 

TIA and SITOP UPS Manager cannot simultaneously access SITOP UPS1600. The service 
of the SITOP UPS Managers may not run while the system is accessed via TIA. 
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3.3.2 Installing the Hardware Support Package (HSP) 
 

 Note 
SIMATIC STEP 7 V13 service pack 1 

The following step is only relevant for SIMATIC STEP 7 V13 with service pack 1 in the TIA 
Portal. 

The HSP is available at our SITOP-homepage (http://www.siemens.com/sitop-ups1600) or 
directly at (https://support.industry.siemens.com/cs/ww/en/view/75854606). 

 

Procedure 

To install the Hardware Support Package, proceed as follows: 

1. Start STEP 7 in the TIA Portal. 

2. In the "Options" menu, click on "Support Packages". 

 
Dialog "Detailed information" opens. 

All Support Packages from the directory that you specified as storage location for Support 
Packages in the settings are listed in a table. 

3. You have the following possibilities to install the Hardware Support Package: 

– If the Support Package is already present on your computer or on the supplied DVD, 
you can add it to the list from the "Add from the file system". 

– If you want to add a Support Package from the "Service & Support" page in the 
Internet, download it with "Load from the Internet". 
You can then add it to the file system. 

4. Select the support package that you want to install. 

5. Click on "Install", and follow the instructions of the installation program. During the 
installation you will be prompted to close all TIA Portal instances. 

6. Close all TIA Portal instances and click on "Continue". 

7. After the Support Package has been installed, the TIA Portal is reinitialized by clicking on 
"Restart". 

The installed devices are imported into the module catalog and can then be integrated in 
the project.  

You can find the SITOP UPS1600 in the hardware catalog under "Power Supplies\SITOP 
UPS\UPS1600". 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854606
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 Note 

You can find additional information on installing hardware support packages in the manual of 
your STEP 7 software. 
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3.3.3 Installing the generic station description file (GSD) 
 

 Note 
SIMATIC STEP 7 V13 

The following step is only relevant for SIMATIC STEP 7 V13 in the TIA Portal. 

 The GSD is available at our SITOP-homepage (http://www.siemens.com/sitop-ups1600) or 
directly at (https://support.industry.siemens.com/cs/ww/en/view/75854605). 

 

Preconditions 

● You know where the GSD file is saved. 

Procedure 

To install the generic station description file, proceed as follows: 

1. Download the GSD file from the Internet. 

2. Start SIMATIC STEP 7 V13 in the TIA Portal. 

3. In the project view, click in the menu "Options" on "Install general station description file 
(GSD)" or "Manage general station description file (GSD)". 

 
The "Manage general station description file (GSD)" dialog is opened. 

4. Select the source path under which you locally saved the GSD file that you downloaded. 

5. Select the GSD file. 

6. Click on "Install", and follow the instructions of the installation program. 

The installed devices are imported into the module catalog and can then be integrated in the 
project. You can find the UPS1600 in the hardware catalog at "Other field 
devices\PROFINET IO\I/O\Siemens AG\UPS1600". 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854605
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3.3.4 Inserting SITOP UPS1600 into a project 
To be able to use the SITOP UPS1600, you must assign it as IO device to an IO controller 
(SIMATIC S7 control). Further, SITOP UPS1600 can be equipped in the project with one or 
several SITOP UPS1100 battery modules. 

The main views used to configure the SITOP UPS1600 are the Network view and the Device 
view. 

 
 

 Note 

Additional information on the Network view and Device view, as well as the Topology view is 
available in the manual for your STEP 7 software. 

 

Preconditions 

● The hardware support package or the general station description file of the 
SITOP UPS1600 has been installed. 

● STEP 7 in the TIA Portal has been opened, and a project with an IO controller (SIMATIC 
S7 control) has been created. 

Inserting SITOP UPS1600 from the hardware catalog 
1. Open the network view. 

2. Open the "Hardware catalog" task card. 

3. If you use the SITOP UPS1600 with the hardware support package:  
In the "Catalog" palette, navigate to SITOP UPS1600 under Power Supplies\SITOP 
UPS\UPS1600. 

4. If you use the SITOP UPS1600 with the generic station description file:  
In the "Catalog" palette, navigate to the SITOP UPS1600 under "Other 
devices\PROFINET IO\I/O\Siemens AG\UPS1600". 



Engineering and remote access  
3.3 SIMATIC STEP 7 in the TIA Portal 

 SITOP UPS1600 / UPS1100 
54 Manual, 04.2017, A5E37775406-8-76 

5. Select the required SITOP UPS1600 using a mouse click. 
In the "Information" area you can see information about the selected SITOP UPS1600, 
and if necessary change the preselected version. 

6. Drag the SITOP UPS1600 and drop it into the Network view. 

 
Alternatively, you can add the module to the Network view by double-clicking on the entry 
in the hardware catalog. 

You have now inserted the SITOP UPS1600 into the project. The rectangle displayed in 
the network view symbolizes the SITOP UPS1600. 

3.3.5 Assigning the SITOP UPS1600 to a controller 
To be able to use the SITOP UPS1600 you must assign an IO controller as IO device. 

1. Click in the network view on the blue lettering "Not assigned" at the left next to the symbol 
of the SITOP UPS1600. 

 
A menu opens with the available controllers. 

 
2. Select a controller in the menu. 
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3. Select the connection between the controller and SITOP UPS1600. 

 
4. Make the required settings in the "Network data". 

5. Double-click on SITOP UPS1600 to display it in the device view. 

6. Select the PROFINET-interface. 

 
7. Under "Ethernet addresses" in the inspector window enter the IP address of the 

SITOP UPS1600, which was already assigned in theTIA Portal. 

You have assigned a controller to the SITOP UPS1600. 

3.3.6 Assigning a battery module SITOP UPS1100 to the basic device SITOP 
UPS1600 

The basic functions of the uninterruptible power supply are available with all of the battery 
modules that are compatible with the SITOP UPS1600. The SITOP UPS1100 5 Ah LiFePo 
battery is first supported by the UPS1600 with SW version V2.1. 
Additional functions are available with the SITOP UPS1100 battery module: 

● Automatic detection of the battery module rated values 

● Automatic management of up to six battery modules 

● Temperature-controlled charging 

● Battery fast test 

● Diagnostics using the SITOP UPS Manager and the web server 
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Using an example, in the following steps, it is shown how the SITOP UPS1600 is assigned a 
SITOP UPS1100 battery module. 

 

 Note 

Only SITOP UPS1100 battery modules of the same type can be inserted into the slots of a 
SITOP UPS1600.  

The number of battery modules that can be configured is limited to six. The description is 
only applicable to devices that were linked to via the HSP. 

 

Preconditions 

● STEP 7 in the TIA Portal has been opened and a project has been created. 

● A SITOP UPS1600 has been integrated in the project. 

Procedure 

The procedure is only applicable for devices integrated via HSP. 
For GSD devices, values can be manually specified for a (third-party) battery module; 
however, it is not necessary to add a battery module to the configuration. 

1. In the device view, select the SITOP UPS1600 basic device. 

2. In the Hardware catalog , navigate to the SITOP UPS1100 battery module under Power 
Supplies\SITOP UPS\UPS1100. 

3. Select the required battery module in the hardware catalog. 
In the "Information" area you can see information about the expansion module, and when 
necessary you can change the preselected (default) version. 

4. Drag the battery module and drop it into the Device view. 
Alternatively, the battery module can be added by double-clicking on the entry in the 
hardware catalog. 
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5. Drag the battery module and drop at the first free slot to the right next to the 
SITOP UPS1600. 
The battery module is inserted at the selected slot. 

 
6. Save the hardware configuration. 

You have assigned a battery module to the basic device SITOP UPS1600. 

How you change the number and type of SITOP UPS1100 battery modules used is 
described under Parameterizing UPS1600 with STEP 7 in the TIA Portal (Page 58). 
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3.3.7 Parameterizing the UPS1600 
The adjustable parameters of the SITOP UPS1600 can be found in STEP 7 in the TIA Portal 
in the inspector window under Properties when the appropriate device was selected. 

For parameterization, in the area navigation, the settings under "Base Unit", "Energy 
storage" and "Webserver" are relevant.  

 
Navigation area Description 
Profinet security Profinet security DCP write protection activated 

 

 
Navigation area Description 
Base Unit Buffering All parameters, which involve the behavior of SITOP UPS1600 when 

buffering 
Signaling Setting of the alarm signaling and the wait time for stable input voltage. 

Energy storage – Parameters for the battery modules used 
Web server General information Define as to whether the SITOP UPS1600 may be accessed via web 

server (yes / no) 
Activate web server on this module  
Enable automatic logoff  
Access with HTTPS only. 

Automatic update Activate automatic update / Activation interval 
 

 
Navigation area Description 
OPC UA server OPC UA server acti-

vated 
Here, activate the OPC UA server. 

Unencrypted access 
activated 

You have the option of activating unencrypted access to the 
OPC UA server. However, this option is not recommended. 

OPC UA server port Specify which port should be used. 
 

 
Navigation area Description 
NTP client NTP client activated Here, activate the NTP client. 

NTP server 
address 1 … 4 

Enter up to 4 addresses for an NTP server. 

A detailed description of the individual parameters of the subgroups is contained in the 
associated section under Parameterizing the UPS in STEP 7 in the TIA Portal (Page 58). 

The procedure is the same for all parameters. This section describes the general procedure 
to reach the configuration dialog, using as example the parameters for buffering. The 
individual parameters and their possible values are described in the following subsections. 

Each parameter has a start value. A click on "Reset to initial values" resets all parameters of 
a subgroup to the associated start value. 

Preconditions 

● The SITOP UPS1600 was integrated in the opened project. 
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Proceed as follows 

1. Select the SITOP UPS1600 in the Device view. 

2. In the inspector window select "Properties > General > Device configuration". 

Entries for parameterization are provided in the navigation area. 

 

"Buffering" parameters 
 
Parameter Value range Initial value 
Buffering allowed Yes / No Yes 
Connection threshold 21 - 25 V 22.5 V 
Buffer time 1 - 32767 s 600 s 
Maximum buffer time 1) Yes / No No 
Additional buffer time after PC shutdown. 3) 1 - 300 s 60 s 
Expected buffer current 1) 0 - 40 A 0 A 
Stop buffering voltage 18 - 23 V 18.5 V 
Enable reset Yes / No No 
Reset time 1 - 120 s 5 s 
Battery test interval 2) 1 - 65535 h 4 h 
 1) Parameter only available from SW version V2.0 and higher 

2) Parameter only available from SW version V2.1 and higher 
3) valid from V2.0.4 or V2.1 

● Buffering permitted 
When the connection threshold is fallen below, selects whether the system is buffered or 
the output is shut down. 

● Switch-in threshold 
Setting the switch-in threshold. 

● Buffer time 
Length of time during which the system should be buffered by the SITOP UPS1600. 
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● Maximum buffer time 

The setting means that buffering is realized for as long as possible. The device only shuts 
down when the battery has discharged down to the defined stop buffering voltage. The 
value entered for the "Buffer time" parameter is not relevant in this case.  

● Additional buffer time after PC shutdown 
Time during which the system should be buffered by the SITOP UPS1600 after the PC 
was shut down. 

● Expected buffer current 

Load current, which is expected at the device output during buffer operation. Please 
adjust the correct application load current required. For current settings between 0 A and 
rated current, the display in the diagram "Remaining buffer time" is adapted. 

If a value of 0 A is entered, then for this parameter, the average value of the actual load 
current measured at the output over the last 10 min is assumed. The value of this 
parameter is used when calculating the remaining buffer time. The entered value may not 
exceed the rated device current. 

 
  Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, 
to determine the expected buffer time, instead of the expected buffer current, the actually 
measured buffer current is used.  

 

● Stop buffering voltage 
The voltage at which battery discharge is terminated. The stop buffering voltage defined 
for this type is always used for a coded battery (UPS1100). 

● Enable reset 
If the value is set to "Yes" then the output voltage is interrupted after the selected buffer 
time expires if, in the meantime, the input voltage returns. This option is useful, when, for 
example, computer networks are protected by the UPS that can be activated by a reset 
when the power supply is restored. For buffer time "MAX", the output voltage is not 
interrupted. 

● Reset time 
Here, you define the interrupt duration. 

● Battery test interval 

The time interval between battery tests can be set using the parameter. 

"Signaling" parameter 
 
Parameter Value range Default setting 
Downtime alarm 0 - 20,000 ms 100 ms 
Wait time for stable input voltage 0.2 - 65 s 1.0 s 
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● Downtime alarm 
The time in which no alarm is issued to the system although it is buffered. 

● Wait time for a stable input voltage 
Time where the input voltage must continually lie above the connection threshold so that 
buffering is exited and a transition is made into normal operation. 

"Energy storage" parameter 
The "energy storage" has two different areas that depend on the battery type being used. 
First select whether you are using a SITOP UPS1100 battery module or some other energy 
storage device. 

Possible parameters when using a SITOP UPS1100 battery module 
 
Parameter Value range 
Module Drop-down menu with the SITOP UPS1100 battery modules saved by the HSP 
Number of modules 0 - 6 
Total capacity 0 - 72 Ah 

● Module 
Type of SITOP UPS1100 battery module. 

● Number of modules 
Number of installed modules. 

● Total capacity 
Total capacity of the installed battery modules. 

Possible parameters for the deployment of a different battery module 
 
Parameter Value range Default setting 
Total capacity 0.1 - 3,200 Ah 10 Ah 
End-of-charge voltage 24 - 30 V 27.3 V 
Charge current 0.001 - 3 or 4 or 5 A 0.3 A 
Faulty battery voltage 1 - 18 V 6 V 
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● Total capacity 
Total capacity of the installed batteries. 

● End of charge voltage 
Maximum voltage up to which the battery may be charged. 

● Charge current 
The battery is not charged with more than the selected charge current. The 
manufacturer's details for the permitted battery charge current must be observed. 
Further, the following, device-dependent values apply: 

– SITOP UPS1600 10 A: Maximum permissible charge current 3,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 2,000 mA 

– SITOP UPS1600 20 A: Maximum permissible charge current 4,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

– SITOP UPS1600 40 A: Maximum permissible charge current 5,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

Faulty battery voltage 
If the battery voltage undershoots this value, it is considered as being faulty by the 
SITOP UPS1600 and is not charged. 

"Web server" parameters 
 
Parameter Value range Default setting 
Activate web server on this module Yes / No Yes (up to V2.0) 

No (from V2.1) 
Permit access only with HTTPS Yes / No Yes 
Log off automatically after 15 minutes Yes / No No 
Update interval 0 / 5 s / 10 s / 20 s / 30 s / 60 s 30 s 
Enable automatic update Yes / No No 

Set here whether access to the UPS via web server is permitted. 

● Activate web server on this module 
Define whether this device can be accessed via the web server. 

● Permit access only with HTTPS 
Define whether access is only permissible via HTTPS. 

● Log off automatically after 15 minutes 
You define whether a user should be automatically logged off after closing the web 
server. 

● Update interval 
You define in which intervals the actual values are sent to the web server. 

● Enable automatic update 

When you enable "Automatic update" then the actual values of the SITOP UPS1600 and 
connected supplementary modules are sent to the web server. 
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3.3.8 Loading the configuration (commissioning) 
In the delivered state, the SITOP UPS1600 has not yet been assigned an IP address and the 
DHCP protocol is deactivated. 

When the SITOP UPS1600 is first connected with a controller (SIMATIC S7- control system), 
it must be assigned a device name and an IP address by the controller. A new configuration 
can be loaded to the device using STEP 7 in the TIA Portal . 

Identifying a SITOP UPS1600 in the network 
From the STEP 7 in the TIA Portal , you can get the LED "SF" at the SITOP UPS1600 to 
flash. This means that you can clearly identify a module in the network, e.g. if several 
SITOP UPS1600 are installed in the network. 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the network. 

● PG/PC with STEP 7 in the TIA Portal is connected with the network. 

Proceed as follows 

1. Open the "Online > Accessible nodes" menu. 

2. As type of PG/PC interface, select "PN/IE". 

3. Select the PG/PC interface connected with the system. 

4. Select the connection with the subnet, in which the SITOP UPS1600 is located. 
All of the available SITOP UPS1600 devices in the selected subnet are displayed. 

5. Select the required SITOP UPS1600. 

6. Activate the "Flash LED" checkbox. 

 
7. Check at which SITOP UPS1600 in the network the "SF" LED flashes. 

By checking the flashing LEDs, you can uniquely identify all SITOP UPS1600 in a network. 
Note the device name and the IP address of the required SITOP UPS1600 in order to load a 
configuration. 

Changing the device name of the SITOP UPS1600 
1. In STEP 7 , in the tabular area of the Network view, select the "Network overview" table. 

2. Overwrite the name in the "Device" column in the row of the PROFINET device involved. 

You have changed the name of the SITOP UPS1600 device. 

The name is adapted in the graphical area of the network view. 
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Changing the PROFINET device name of the SITOP UPS1600 via the properties of the PROFINET 
interface 

You can change the PROFINET device name using the properties of the PROFINET 
interface. 

1. In the Network or Device view of the Hardware and Network editor of STEP 7, select the 
PROFINET interface of a PROFINET device. 

2. In the Inspector window navigate to "Ethernet addresses" in the "PROFINET" area. 

3. Deactivate the "Generate automatically the PROFINET device name" checkbox. 

4. Enter the new PROFINET device name in the appropriate field. 

 

Changing the IP address of a SITOP UPS1600 
1. In the Network or Device view of the hardware and network editor from STEP 7 in the TIA 

Portal , select the PROFINET interface of a PROFINET device. 

2. In the Inspector window, navigate to "Ethernet addresses" in the "IP protocol" area. 

3. Check whether the "Set IP address in the project" option is activated. 

4. Enter the new IP address in the appropriate field. 

Loading the configuration to the SITOP UPS1600 
To commission the UPS, you must load the project data that you created offline into the 
connected SITOP UPS1600. This project data results from the configuration of the hardware, 
networks and connections in STEP 7. 
Initially, the complete project data is loaded. Only the changes are loaded for subsequent 
load actions. 

Preconditions 

● The project data is consistent. 

● The device name must be identical offline and online. 

● The SITOP UPS1600 is accessible online. 

● The SITOP UPS1600 is located in the PROFINET IO system of an IO controller. 

● The PG/PC is connected to the same network to which the SITOP UPS1600 and the 
controller are connected. The interface of the PG/PC must be set to TCP/IP. 



 Engineering and remote access 
 3.3 SIMATIC STEP 7 in the TIA Portal 

SITOP UPS1600 / UPS1100 
Manual, 04.2017, A5E37775406-8-76 65 

 

 Note 

Ensure that the article number of the SITOP UPS1600 configured offline matches the article 
number of the device connected online. The following response is obtained after loading the 
configuration into the device: 

 

 
Figure 3-1 Online / offline 
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Procedure 

1. In the "Project tree", right-click on the SITOP UPS1600 controller. 
The shortcut menu opens. 

 
2. In the shortcut menu, in submenu "Download to device", select option "Hardware 

configuration". 

The project data are compiled. The "Load" button is activated as soon as loading is 
possible. 

3. Click on "Load". 

Data is loaded. The "Result of the load operation" dialog window is then opened. In this 
dialog, you can check whether the load task was successful and select any further 
actions. 

4. Click on the "Finish" button. 

Result 

The set parameters have been loaded to the SITOP UPS1600 via the controller. 
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3.3.9 Diagnostics 
The following data can be retrieved using the online and diagnostics function: 

 
Navigation area Value 
General Module Short designation 

Article number 
Hardware 
Firmware 

Module information Device name 
Module name 
Plant designation 
Location ID 

Manufacturer information Description of manufacturer 
Serial number 
Copyright entry 
Profile 
Profile details 

PROFINET interface Ethernet address / network connec-
tion  

MAC address 

Ethernet address / IP parameter IP address 
Subnet mask 
Default router 
IP settings 
IP setting time 

Ports List of ports 
Functions Assign an IP address MAC address 

IP address 
Subnet mask 
Router address 

Firmware update / UPS1600 Article number 
Firmware 
Name 
Rack 
Slot 
Firmware file 
Firmware version 
Suitable for modules with 
Status 
Activate firmware after update 

Assign name PROFINET device name 
Type 

Reset to factory settings MAC address 
IP address 
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Navigation area Value 
PROFINET device name 

Retrieve the online and diagnostics data of SITOP UPS1600 
Proceed as follows to start the online and diagnostics view of the particular module:  

Project tree: 

1. Open the device folder of the SITOP UPS1600 in the Project tree. This is located (after 
the assignment to the control system) in the folder of the control system under 
"Distributed I/O " > [name of the PROFINET connection]. 

2. Double-click on "Online & diagnostics". 

Alternatively: 

3. Select the device folder of the SITOP UPS1600 in the Project tree. 

4. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

Device view: 

1. Open the device view of the device configuration. 

2. Select the SITOP UPS1600. 

3. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

Network view: 

1. Open the network view of the device configuration. 

2. Select the SITOP UPS1600. 

3. In the shortcut menu or in the "Online" main menu, select the "Online & diagnostics" . 

4. Click on "Connect online". 

The information is displayed under "Diagnostics / General". 
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3.3.10 Firmware update 
 

 WARNING 

The SITOP UPS1600 is reset while updating the firmware. For safety reasons, the output is 
switched off. 

Ensure that no damage is caused to the plant or system. 

Ensure that the PG/PC and/or all switches, routers and gateways that are used have an 
independent power supply during the firmware update. 

 

 WARNING 

Firmware update with UPS-Manager 

If for the firmware update, the UPS Manager is used, please note that for a firmware update 
from version V2.1 to V2.2 or higher, then a UPS Manager with version V4.72 or higher must 
be used. This also applies to firmware updates from V2.2.0 to higher versions. 

 

 Note 

Install the current version of the SITOP UPS Managers, before you start the firmware 
update. It is possible that an older version (less than V4.5X) of the SITOP UPS Managers 
does not support this firmware update. The installation file for the SITOP UPS Manager is 
available at no charge on the SITOP home page (http://www.siemens.com/sitop) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

 

 Note 

Do not switch-off the devices during the firmware update. 
 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/en/79207181). Different firmware updates 
are offered depending on the amp rating of the SITOP UPS1600. 

 

 Note 
Observe the compatibility of the firmware! 

Other firmware updates are not compatible. 

Determine the amp rating of your SITOP UPS1600 and download the appropriate firmware 
update. 

 

 Note 

It is not possible to downgrade the device firmware to a release with a version number lower 
than the firmware installed in the device itself. Information on how to read out the firmware 
release from the device is provided in Section Diagnostics (Page 67). 

 

http://www.siemens.com/sitop
https://support.industry.siemens.com/cs/ww/en/view/75854607
http://support.automation.siemens.com/WW/view/en/79207181
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 Note 
"Reset to Factory" function: 

All configuration parameters are reset to the default setting; 0.0.0.0 is used for the IP 
address. A new IP address must then be assigned, as otherwise there is no connection to 
the UPS Manager or TIA Portal. 

 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the system. 

● PG/PC with STEP 7 in the TIA Portal is connected with the system. 

● Online connection is established. 

Procedure 

The firmware update consists of several files, which are combined in a zip file. 

1. Download the firmware update. 

2. Unpack the ZIP file into a temporary directory. 

3. In the network view, select the components whose firmware is to be updated. 

4. Change to the device view. 

5. Click on "Go online". 

6. In the shortcut menu of the SITOP UPS1600, select "Online & Diagnostics". 
The "Online access" menu opens. 

 
7. In the "Functions" folder, select the "Firmware update" group. 

8. Click on the "Browse" button in the "Firmware loader" area to select the path to the 
directory with the unzipped files. 

9. Select the appropriate file "*.upd". All SITOP UPS1600 are displayed in the table, for 
which an update is possible with the selected firmware file. 

10.Click on the "Start update" button. If the selected file can be interpreted by the module, it 
will be loaded into the module. For version V2.1 - depending on the UPS1600 type - the 
firmware file is called "ups20a.upd", for example. If this requires changing the operating 
state of the CPU, you will be prompted to do this with dialogs. 

11.Confirm the notes that are displayed. 
The firmware is sent from the controller to the component . While sending, LED 4 ("SF") 
and LED 6 ("RUN") flash at the SITOP UPS1600. 
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12.Confirm the message from the TIA Portal that the data was successfully sent by pressing 
"OK".  
The firmware is saved in the internal component memory. The following LEDs flash while 
saving: 

– LED 1 ("OK/Bat") 

– LED 2 (">85%") 

 
  Note 

It can take several minutes to save the firmware in the component. Do not switch-off the 
devices. 

 

13.The device is automatically restarted after the LEDs no longer flash. 

 
  Note 

During the firmware update, if the power supply of the SITOP UPS1600, or PG/PC or 
intermediate switches, routers or gateways is interrupted, then under certain 
circumstances, a fallback firmware is activated. If the SITOP UPS1600 can then no 
longer be accessed remotely, you must assign the a new IP address, or under the menu 
item "Assign name" you must enter a new name in the field "PROFINET device names" 
(see the manual for the particular unit). 

 

14.The firmware has been updated. Only now is it permissible to switch off the 
SITOP UPS1600. 

 

 Note 

After updating the firmware, in the hardware configuration of your project, you must replace 
the SITOP UPS1600 involved by SITOP UPS1600 with the current firmware version. The 
configured configuration then matches the actual configuration again. 

 

 Note 

For GSD, the SITOP UPS1600 must be deleted, and newly integrated; this means that 
parameters, addresses and names must be newly set - and it is also possible that a new 
GSD file must first be installed. 
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3.3.11 Restore factory settings 
A reset to the factory settings deletes all configurations of the PROFINET interface saved in 
the SITOP UPS1600 and restores the factory settings. This affects, for example: 

● IP address 

● Device name 

The parameter values for SITOP UPS1600 and the energy storage device are kept. 

Proceed as follows to reset the SITOP UPS1600 factory settings: 

1. Select SITOP UPS1600 in the Network view and change to the Device view. 

2. Click on "Go online". 

3. In the SITOP UPS1600 shortcut menu, select "Online & diagnostics". 

4. In the "Functions" folder, select the "Reset to factory settings" group. 

 
5. Click on the "Reset" button. 

6. Respond to the confirmation prompt with "OK". 
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3.4 SIMATIC STEP 7 

3.4.1 Introduction 
The uninterruptible power supply SITOP UPS1600 can be used with SIMATIC STEP 7 from 
Version 5.4 and higher. 

In SIMATIC STEP 7 , the basic device SITOP UPS1600 and its SITOP UPS1100 battery 
modules can be integrated in the project, parameterized and diagnosed. 

 

 Note 

SIMATIC STEP 7 and the SITOP UPS Manager cannot simultaneously access the 
SITOP UPS1600. It is not permissible that the SITOP UPS Manager service runs while the 
system is being accessed via SIMATIC STEP 7. 

 

3.4.2 Installing the generic station description file (GSD) 
To use the SITOP UPS1600 and the SITOP UPS1100 battery modules in SIMATIC STEP 7, 
you must install the corresponding generic station description file (GSD). The GSD file is 
available at our SITOP-homepage (http://www.siemens.com/sitop-ups1600) or directly at 
(https://support.industry.siemens.com/cs/ww/en/view/75854605). 

Preconditions 

● SIMATIC STEP 7 has been opened and a project has been created. 

● At least one station has been added. 

● You know where the GSD data have been saved. 

Procedure 

1. Download the GSD file from the Internet. 

2. Close all stations in HW Config. 

3. Click on "Browse ...", and select the folder in which the GSD file is located. 

4. Select the GSD file and click on "Install". 

 
  Note 

If the file was not able to be installed, or if errors occurred during installation, then 
SIMATIC STEP 7 creates a report file. You can open this log file by clicking on the 
"Display log" button. 

 

5. In the "Options" menu, click on "Update Catalog". 

The installed devices are imported into the module catalog and can then be integrated in the 
project. You can find SITOP UPS1600 in the hardware catalog under 
"PROFINET IO\I/O\UPS1600". 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854605
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3.4.3 Inserting SITOP UPS1600 into a project 
To be able to use the SITOP UPS1600 it must be assigned as IO device to an IO controller 
(SIMATIC S7 control) . 

Preconditions 

● The GSD file of the SITOP UPS1600 has been correctly installed. 

● SIMATIC STEP 7 has been opened, and a project with an IO controller 
(SIMATIC S7 control) has been created. 

Creating a subnet 
1. Open the Hardware view "HW Config". 

2. Call the shortcut menu of line "PN-IO" 

3. Select "Insert PROFINET IO system". 

 
4. In dialog field "Properties - Ethernet interface PN-IO", select the "Parameters" tab. 

5. Set the IP address of the PROFINET interface. 
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6. Create a new subnet. 

 
7. Confirm the properties of the new subnet. 

8. Close the "Properties - Ethernet interface PN-IO" dialog box. 

The subnet is displayed as a horizontal line in the hardware view. 

 

Inserting SITOP UPS1600 from the hardware catalog 
1. Select the subnet. 

2. Open the "Catalog" window using the "View > Catalog" menu command. 
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3. In the hardware catalog, navigate to the SITOP UPS1600 under "PROFINET IO \ I/O \ 
UPS1600". 

 
4. Click the desired SITOP UPS1600; keep the left mouse button pressed and drag the 

SITOP UPS1600 to the subnet. 

5. Double-click on "SITOP UPS1600". 

6. In the open dialog Device name, enter the device number and IP address in the Ethernet. 

7. Save the hardware configuration. 

You have now inserted the SITOP UPS1600 into the project. The rectangle displayed in 
the editor symbolizes the SITOP UPS1600. 
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3.4.4 Parameter assignment 

3.4.4.1 Parameters of the basic device and battery module 
The adjustable parameters of the basic device SITOP UPS1600 and the SITOP UPS1100 
battery modules are structured according to subgroups in SIMATIC STEP 7. These 
subgroups are shown in the table below. 

 
Subgroup Description 
Buffer parameters All parameters, which involve the behavior of SITOP UPS1600 when buffering. 
Battery parameters Parameterizing the battery being used. 
Charging parameters Parameters for the charging behavior: 

• End-of-charge voltage 
• Charge current 

Reset parameters Activate interruption of the output voltage for supply system restoration. 
Buffering parameters Load current that is expected at the device output during buffer operation. 
Maintenance R test - the battery state is determined by subjecting it to a load. 
Identification Definition of the location and contact data to be able to identify the 

SITOP UPS1600. 
Web server Definition as to whether the SITOP UPS1600 may be accessed via web server 

(yes / no). 

A detailed description of the individual parameters of the subgroups is contained in the 
associated section under Parameterizing SITOP UPS1600 (Page 77). 

3.4.4.2 Parameterizing SITOP UPS1600 
The procedure is the same for all parameters. This section describes the general procedure 
to reach the configuration dialog. The individual parameters and their possible values are 
described in the following subsections. 

Each parameter has a start value. A click on "Reset to initial values" resets all parameters of 
a subgroup to the associated start value. 

Preconditions 

● The SITOP UPS1600 has been integrated in the opened project and networked. 

Proceed as follows 

1. Open Network view "NetPro" ("Tools > Configure network"). 
The controller and the networked SITOP UPS1600 are displayed. 

2. In the Network view click on SITOP UPS1600. The hardware configuration opens. 

3. Double click in the hardware configuration on the SITOP UPS1600 entry in the station 
window for slot 0.1. 

4. In the configuration dialog click on the "Parameters" tab. 
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5. Click the desired subgroup. 
The subgroup opens. 

 
6. Enter the values. 

7. Confirm your entry by clicking on "OK". 

The parameters are stored in the project. 

Buffer parameters 
 
Parameter Value range Default setting 
Buffer time 1 … 32767 s 600 s 
Additional buffer time after the PC was powered down1) 1 … 300 s 60 s 
Connection threshold 21 … 25 V 22.5 V 
Stop buffering voltage 18 ... 23 V 18.5 V 
Wait time for stable input voltage 200 … 65,000 ms 1000 ms 
Downtime alarm 0 … 20.000 ms 125 ms 
Buffering allowed Yes / No Yes 
Enable reset after buffering Yes / No No 
 1)  valid from V2.0.4 or V2.1 
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● Buffer time 
Time where the system is to be buffered by SITOP UPS1600. The "Buffering allowed" 
parameter is used to specify whether buffering should be performed. If a value of 32767 
is entered, then the SITOP UPS1600 interprets this as MAX, and only shuts down the 
buffering when the stop buffering voltage is reached. 

● Additional backup time after the PC has been shutdown 
The time to be buffered by the SITOP UPS1600 once the PC has been shut down. 

● Connection threshold 
If the connection threshold value is fallen below, the SITOP UPS1600 starts buffering. If 
the value of the connection threshold is subsequently exceeded again, then the 
SITOP UPS1600 stops buffering. 

● Stop buffering voltage 
The voltage at which battery discharge is terminated. 

● Wait time for a stable input voltage 
Time where the input voltage must continually lie above the connection threshold so that 
buffering is exited and a transition is made into normal operation. 

● Downtime alarm 
The time in which no alarm is issued to the system although it is buffered. 

● Buffering allowed 
Select between buffers with the specified values or passive measurement of the power 
supply by the SITOP UPS1600. 

● Activate reset after buffering 
If the value is set to "yes", then, in the meantime, if the input voltage returns after the 
buffer time has expired, the SITOP UPS1600 shuts down the output for the selected 
interrupt time. 

Battery parameters 
 
Parameter Value range Default setting 
Faulty battery voltage 1 … 18 V 6 V 
Battery capacity 0.1 … 3,200 Ah 10 Ah: 
Ignore data of coded battery Yes / No No 

● Battery defective voltage 
If the battery voltage undershoots this value, it is considered as being defective by the 
SITOP UPS1600 and is not charged. 

● Battery capacity 
If no UPS1100 battery modules are being used: Enter the total capacity of the installed 
batteries. 

● Ignore data of coded battery 
Set the value to "Yes" if you define the parameters for the UPS1100 yourself. 
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Charging parameters 
 
Parameter Value range Default setting 
End-of-charge voltage 24 … 30 V 26 V 
Charge current 1 … 4,000 mA 800 mA 

● End-of-charge voltage 

The end-of-charge voltage is the maximum voltage up to which the battery is charged. 

● Charge current 
The battery is not charged with more than the selected charge current. The 
manufacturer's details for the permitted charge current of the battery must be observed. 

 
  Note 

When UPS1100 battery modules are used, both parameters are automatically set, and do 
not have to be defined. 

 

The following, device-dependent maximum values apply:  

– SITOP UPS1600 10 A: Maximum permissible charge current 3,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 2,000 mA 

– SITOP UPS1600 20 A: Maximum permissible charge current 4,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

– SITOP UPS1600 40 A: Maximum permissible charge current 5,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

Reset parameters 
 
Parameter Value range Default setting 
Reset time 1 … 120 s 5 s 

Here, you define the interrupt duration for the "Interrupt output voltage" function (reset after 
buffering) 

Buffering parameters (2) 
 
Parameter Value range Default setting 
Expected buffer current 0 ... 40 A 0 A 

Load current, which is expected at the device output during buffer operation. Please adjust 
the correct application load current required. For current settings between 0 A and rated 
current, the display in the diagram "Remaining buffer time" is adapted. 
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If a value of 0 A is entered, then for this parameter, the average value of the actual load 
current measured at the output over the last 10 min is assumed. The value of this parameter 
is used when calculating the remaining buffer time. The entered value may not exceed the 
rated device current. 

 

 Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, to 
determine the expected buffer time, instead of the expected buffer current, the actually 
measured buffer current is used. 

 

Maintenance 
 
Parameter Value range Default setting 
R test interval 1 ... 65535 h 4 h 

R test: The battery state is determined by subjecting it to a cyclic load. 

Identification 
 
Parameter Value range 
Contact Free text 
Location Free text 

● Contact 
Enter, for example, a contact address or the name of a staff member. 

● Location 
Enter a description of the location that can be used to locate the SITOP UPS1600. 

Web server 
 
Parameter Value range Default setting 
Activate web server on this module Yes / No No 
Permit access only with HTTPS Yes / No Yes 
Log off automatically after 15 minutes  Yes / No No 
Enable automatic update Yes / No Yes 
Update interval 0 / 5 s / 10 s / 20 s / 30 s / 60 s 10 s 

Set here whether access to the SITOP UPS1600 via web server is permitted. 

● Activate web server on this module 
Define whether this device can be accessed via the web server. 

● Permit access only with HTTPS 
Define whether access is only permissible via HTTPS. 
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● Log off automatically after 15 minutes 
You define whether a user should be automatically logged off after closing the web 
server. 

● Update interval 
You define in which intervals the actual values are sent to the web server. 

3.4.5 Loading the configuration to the SITOP UPS1600 (commissioning) 
In the delivered state, the SITOP UPS1600 has not yet been assigned any IP address and 
the DHCP protocol is deactivated. 

When the SITOP UPS1600 is first connected with an IO controller (SIMATIC S7 control 
system), it must be assigned a device name and an IP address by the IO controller. STEP 7 
can be used to load a new configuration to the device. 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the system. 

● PG/PC with SIMATIC STEP 7 is connected with the network. 

Displaying accessible nodes 
 

 Note 

If nodes can only be accessed via interposed switches or routers (with protocol conversion), 
they are not displayed in the list of the accessible nodes. 

 

1. Click in menu "Target system" on "Display accessible nodes". 

The "Accessible nodes" window is opened with the following displays: 

– Station 

– SITOP UPS1600 

The following table shows which information is displayed in the "Object name" column. 
 
Accessible nodes Object name Description 
S7-CPU, PC station Name of the station The "Details" view also shows the operating state, module 

type and, if available, information from the associated STEP 
7 project (station name, CPU name, system identification). 

Loading the IO controller for the first time 
Once you have configured the SITOP UPS1600 and the station, you must load this 
configuration to the IO controller (SIMATIC S7 control system). This is the way that the IO 
controller is assigned its configured IP addresses. 

Before loading, carry out a consistency test to check the configuration for duplicate 
addresses, identical names, etc. 
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Inform yourself whether the IO controller to be loaded can also be initially loaded via the 
PROFINET interface. If not, you must first load the hardware configuration via the MPI 
interface . 

1. Select in the "Target system > Load" menu. 

2. Select the module to be loaded. 

3. In the "Select node address" dialog, if necessary, click the "Display" button to display the 
actual accessible modules (these include the IO controller to be loaded with its current IP 
address or its MAC address, if no IP address is yet available). 

4. Select the IO controller to be loaded from the accessible modules. 

This module is displayed in the "Enter connection to target station" dialog box. 

5. Start loading by clicking on the "OK" button. 

The IO controller is assigned the configured IP address. 
 

 Note 

Ensure that the article number of the SITOP UPS1600 configured offline matches the article 
number of the device connected online.  

 

The following response is obtained after loading the configuration into the device: 
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Figure 3-2 Online / offline 

Allocating the SITOP UPS1600 a device name (online) 
In order that the configured IO controller can address the SITOP UPS1600, you must assign 
each individual IO device (including SITOP UPS1600) the configured device name. 

For the procedure described below, the SITOP UPS1600 and the station for the PG/PC must 
be accessible online on the Ethernet. 

1. Open HW Config. 

2. In the "Target system > Ethernet" menu, click on "Assign device name". 

3. In the "Assign device name" dialog, in the "Device name" field, select SITOP UPS1600. 

4. In the "Available devices" select the SITOP UPS1600. Using the "Flash" button, you can 
flash the LED on the SITOP UPS1600 so that the device can be uniquely identified. 

5. Click on the "Assign name" button. 

After the name assignment, you can bring the IO controller into the RUN operating state. 

When powering up, the IO controller distributes the configuration information to the 
SITOP UPS1600 and then goes into cyclic operation. 
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3.4.6 Diagnostics 
The following data can be fetched using the Diagnostics function: 

 
Group Value 
SITOP UPS1600 general Article number 

Serial number 

Fetching diagnostics data 
You can use the "Station > Open online" menu command in "HW Config" to select the 
SITOP UPS1600 and view the diagnostics data. 

3.4.7 Firmware update 
 

 WARNING 

The SITOP UPS1600 is reset while updating the firmware. For safety reasons, the output is 
switched off. 

Ensure that no damage is caused to the plant or system. 

Ensure that the PG/PC and/or all switches, routers and gateways that are used have an 
independent power supply during the firmware update. 

 

 WARNING 

Firmware update with UPS-Manager 

If for the firmware update, the UPS Manager is used, please note that for a firmware update 
from version V2.1 to V2.2 or higher, then a UPS Manager with version V4.72 or higher must 
be used. This also applies to firmware updates from V2.2.0 to higher versions. 

 

 Note 

Install the current version of the SITOP UPS Managers, before you start the firmware 
update. It is possible that an older version (less than V4.5X) of the SITOP UPS Managers 
does not support this firmware update. The installation file for the SITOP UPS Manager is 
available at no charge on the SITOP home page (http://www.siemens.com/sitop) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

 

 Note 

Do not switch-off the devices during the firmware update. 
 

http://www.siemens.com/sitop
https://support.industry.siemens.com/cs/ww/en/view/75854607
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The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/en/79207181). Different firmware updates 
are offered depending on the amp rating of the SITOP UPS1600. 

 

 Note 
Observe the compatibility of the firmware! 

Other firmware updates are not compatible. 

Determine the amp rating of your SITOP UPS1600 and download the appropriate firmware 
update. 

 

 Note 

It is not possible to downgrade the device firmware to a release with a version number lower 
than the firmware installed in the device itself. Information on how to read out the firmware 
release from the device is provided in Section Determining the firmware version (Page 132). 

 

 Note 
"Reset to Factory" function: 

All configuration parameters are reset to the default setting; 0.0.0.0 is used for the IP 
address. A new IP address must then be assigned, as otherwise there is no connection to 
the UPS Manager or TIA Portal. 

 

See also 
Diagnostics (Page 85) 

Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the PROFINET IO 
system. 

● PG/PC with STEP 7 is connected with the network. 

Procedure 

The firmware update consists of several files, which are combined in a zip file. 

1. Download the firmware update. 

2. Unpack the ZIP file into a temporary directory. 

3. Open the "Accessible nodes" window with the "Target system > Display accessible 
nodes" menu command. 

 
  Note 

For an online connection via the "Accessible nodes" window, PG/PC and "Accessible 
nodes" must be connected to the same physical Ethernet subnet. 

 

4. Select the "Target system > Update firmware" menu command. 

http://support.automation.siemens.com/WW/view/en/79207181
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5. Select the SITOP UPS1600 whose firmware is to be updated. 

6. In the open "Update firmware" dialog, press the "Browse" button to select the path to the 
directory with the unzipped files. 
In this directory, select the corresponding "*.upd" file. 

7. After you have selected a file, the information in the bottom fields of the "Update 
firmware" dialog box indicate the components for which the file is suitable and from which 
firmware version. 

8. Click the "Run" button. 

9. STEP 7 checks whether the selected file can be interpreted by the module; if the check is 
positive, then the file is loaded to the module. 

10.If this requires changing the operating state of the IO controller, then you will be prompted 
to do this in the relevant dialog boxes. 

11.The module then automatically updates the firmware. 

 
  Note 

A separate connection is established to the CPU for the firmware update, if available. In 
this case, the task can be interrupted. If no resources are available for another 
connection, an existing connection will be used automatically. In this case, the task 
cannot be interrupted; the "Cancel" button in the transfer dialog is grayed-out and cannot 
be operated. 

 

12.Confirm the notes that are displayed. 
The firmware is sent from the IO controller to the component, and saved in the internal 
component memory. The following LEDs flash while saving: 

– LED 1 ("OK/Bat") 

– LED 2 (">85%") 

 
  Note 

It can take several minutes to save the firmware in the component. Do not switch-off the 
devices. 

 
  Note 

During the firmware update, if the power supply of the SITOP UPS1600, or PG/PC or 
intermediate switches, routers or gateways is interrupted, then under certain 
circumstances, a fallback firmware is activated. If the SITOP UPS1600 can then no 
longer be accessed remotely, you must assign the SITOP UPS1600 a new IP address, or 
under the menu item "Assign name" you must enter a new name in the field "PROFINET 
device names" (see the manual for the particular device). 

 

13.The SITOP UPS1600 automatically updates the firmware. 

14.The firmware has been updated. Only now is it permissible to switch off the 
SITOP UPS1600. 

15.Using STEP 7 (read out the diagnostics buffer of the IO controller), check whether 
SITOP UPS1600 successfully starts with the new firmware. 
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 Note 

After updating the firmware, in the hardware configuration of your project, you must replace 
the SITOP UPS1600 involved by the SITOP UPS1600 with the current firmware version. The 
configured configuration then matches the actual configuration again. 
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3.4.8 Restore factory settings 
With STEP 7 Version 5.5, it is possible to restore the factory setting of modules using the 
"Target system -> Edit Ethernet node". 

1. To select the MAC address of the SITOP UPS1600, which should be reset to the factory 
setting, click in dialog "Edit Ethernet node" on "Browse". 

2. Click on the "Reset" button. 

This deletes the IP address and the device name from the module. The parameter values 
for SITOP UPS1600 and the energy storage device are kept. 
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3.5 Cyclic and acyclic data 
The data communicated between SITOP UPS1600 and the PROFINET IO-Controller can be 
viewed in SIMATIC STEP 7 or SIMATIC STEP 7 in the TIA Portal. Here, a distinction is 
made between cyclic data (input/output data) and acyclic data (reading/writing data sets). 

Input/output data 

SITOP UPS1600 sends, in cyclic intervals (1 ms - 512 ms for IRT or 1 ms - 2048 ms for RT), 
data about the actual operating states to the PROFINET IO-Controller. You will find more 
information on this at Input and output data (Page 90). 

Reading and writing data sets 

Reading and writing data sets are sent acyclically from the SITOP UPS1600 to the 
PROFINET IO-Controller or from the PROFINET IO-Controller to the SITOP UPS1600. 
Additional information can be found at Reading and writing data sets (Page 91).  

3.5.1 Input and output data 
An overview of the input and output data, which is cyclically sent from the SITOP UPS1600 
to the PROFINET IO controller is provided in the following tables.  
 
Slot Subslot Data Description Data size 
0 2 Input voltage Input voltage is present: 

• 0: NOT OK 
• 255: OK 

Unsigned8 

Buffer mode Buffer mode:  
The load connected to the 
SITOP UPS1600 is supplied via 
the energy storage device con-
nected to the SITOP UPS1600: 
• 0: inactive 
• 255: active 

Unsigned8 

Ready for buffering  Ready for buffer operation as the 
energy storage device of the 
buffer component has been suffi-
ciently charged. 
• 0: NOT OK 
• 255: OK 

Unsigned8 

Charge sufficient  Charge level sufficient: When this 
flag is set, the required charge 
level has been achieved: 
• 0: NOT OK 
• 255: OK 

Unsigned8 
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Slot Subslot Data Description Data size 
Battery change 
recommended  

Battery replacement recommend-
ed: Battery capacity is insufficient 
to achieve the specified buffer 
time: 
• 0: no 
• 255: yes 

Unsigned8 

Not used - Unsigned8 
Battery charge level  Battery charge level in %: 

• 0-100: 0-100% 
• 255: unknown battery 

Unsigned8 

Battery connection 
maintenance  
from V2.1 

Connection to the battery inter-
rupted: Check the connection and 
fuse: 
• 0: no maintenance required 
• 255: maintenance required 

Unsigned8 

3.5.2 Reading and writing data sets 
An overview of all data sets, which are communicated between the SITOP UPS1600 and the 
PROFINET IO-Controller is provided in the following table. Here, a distinction is made 
between the following data sets: 

● Reading data sets: Data which is sent from the SITOP UPS1600 to the 
PROFINET IO-Controller . 

● Writing data sets: Data which is sent from the PROFINET IO-Controller to the 
SITOP UPS1600. 

 
Index Slot Subslot Data set Type Description Data size 
0x0001 0 1 Buffering parameters Reading / 

writing 
Buffer parameters. 
 

14 bytes 

0x0002 0 1 Battery parameters Reading / 
writing 

Parameters of the connected battery 
modules 

5 bytes 

0x0003 0 1 Charging parameters Reading / 
writing 

Charge parameters of the connected 
battery modules 

4 bytes 

0x0004 0 1 Reset parameters Reading / 
writing 

Reset parameters. 1 byte 

0x0005 0 1 Battery information 
parameters 

Reading Information about the connected battery 
modules SITOP UPS1100. This infor-
mation is available via the link "Energy 
Storage". 

1024 bytes 

0x0006 0 1 Device information 
Parameters 

Reading Information about the  
SITOP UPS1600. 

148 bytes 

0x0007 0 1 Hardware settings 
parameters 

Reading Hardware settings of the  
SITOP UPS1600 (settings that were 
made at the front of the device). 

8 bytes 
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Index Slot Subslot Data set Type Description Data size 
0x0008 0 1 Buffering parameters 

from V2.0 
Reading / 
writing 

Buffer parameters of the  
SITOP UPS1600 

2 bytes 

0x0009 0 1 Maintenance parame-
ters from V2.1 

Reading / 
writing 

Maintenance parameters of the  
SITOP UPS1600 

2 bytes 

0x0010 0 1 DC-UPS command Writing Sends special commands to the  
SITOP UPS1600 

4 bytes 

0x0010 0 1 Result of DC-UPS 
command 

Reading Response to the previously sent  
"DC-UPS command" 

4 bytes 

0x0011 0 1 Battery 1 information 
parameters 

Reading Information regarding the connected 
battery module 1 SITOP UPS1100. 
This information is available via the link 
"Energy Storage". 

68bytes 
(from V2.2) 

0x0012 0 1 Battery 2 information 
parameters 

Reading Information regarding the connected 
battery module 2 SITOP UPS1100. 
This information is available via the link 
"Energy Storage". 

68bytes 
(from V2.2) 

0x0013 0 1 Battery 3 information 
parameters 

Reading Information regarding the connected 
battery module 3 SITOP UPS1100. 
This information is available via the link 
"Energy Storage". 

68bytes 
(from V2.2) 

0x0014 0 1 Battery 4 information 
parameters 

Reading Information regarding the connected 
battery module 4 SITOP UPS1100. 
This information is available via the link 
"Energy Storage". 

68bytes 
(from V2.2) 

0x0015 0 1 Battery 5 information 
parameters 

Reading Information regarding the connected 
battery module 5 SITOP UPS1100. 
This information is available via the link 
"Energy Storage". 

68bytes 
(from V2.2) 

0x0016 0 1 Battery 6 information 
parameters 

Reading Information regarding the connected 
battery module 6 SITOP UPS1100. 
This information is available via the link 
"Energy Storage". 

68bytes 
(from V2.2) 

0x0020 0 1 State information Reading Status information about 
 SITOP UPS1600 and the connected 
battery modules SITOP UPS1100. 
Information about the SITOP UPS1100 
battery modules is available via the link 
"Energy Storage". 

64 bytes 
70 bytes 
(from V2.1) 

0x0040 0 1 Identification value 
parameters 

Reading / 
writing 

Device identification parameters. 80 bytes 
108 bytes 
(from V2.1) 

0x0041 0 1 Web server  
parameters 

Reading / 
writing 

Web server settings of the  
SITOP UPS1600. 

1 byte 
6 bytes (from 
V2.1) 

0x0042 0 1 OPC UA server Reading/ 
writing 

OPC UA settings of the 
SITOP UPS1600. 

4 bytes (from 
V2.2) 

0x0043 0 1 NTP client parameters Reading/ 
writing 

Setting for connection to NTP servers 66 bytes 
(from V2.2) 
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Index Slot Subslot Data set Type Description Data size 
0x0044 0 1 NTP client status pa-

rameters 
Reading Status NTP client 40 bytes 

(from V2.2) 
0x0045 0 1 PROFINETSecurity Reading/ 

writing 
Setting for DCP write protection 2 bytes  

(from V2.2) 

You can find detailed information about the individual data sets in Section Data sets 
(Page 93) 

3.5.2.1 Data sets 
In this section you can find detailed information about the individual data sets that are sent 
from the PROFINET IO-Controller to the SITOP UPS1600 - and which can be read from the 
SITOP UPS1600. 

0x0001: Buffering parameters (reading/writing) 
 
Data Description Data type 
Buffer time [1 s] Buffer time: After the selected buffer time has expired, the  

SITOP UPS1600 switches off the load output. The actual buffer 
time that can be achieved depends on the connected loads and 
energy storage devices. 

Unsigned16 

Buffer time 2 [1 s] Additional buffer time after the PC was shut down. (only valid in 
conjunction with PC software SITOP UPS Manager) 

Unsigned16 

Buffer threshold [0.01 V] Connection threshold: Switching voltage for buffering. Buffering is 
active below this value. 

Unsigned16 

Stop buffering voltage [0.01 V] Buffer operation is exited if the battery voltage is below this value. Unsigned16 
Input voltage OK time [1 ms] Wait time for stable input voltage: Minimum time during which the 

input voltage during buffer operation must be available at the  
SITOP UPS1600 to exit buffer operation of the SITOP UPS1600 
and to again supply the connected loads via the input voltage 
(normal operation). 

Unsigned16 

Downtime alarm [1 ms] Downtime alarm: Alarm filter: An alarm is only sent if it is active for 
longer than the set time. 

Unsigned16 

Buffering allowed Activate or deactivate buffer operation. The setting is only accept-
ed in operating mode Remote Enable (REN) of the  
SITOP UPS1600. 

Unsigned8 

Enable reset after buffering Enable reset after buffering: If, during buffer operation, the input 
voltage becomes available again, then the output is switched off 
for a selectable time in order to reset the connected devices. 

Unsigned8 
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0x0002: Battery parameters (reading/writing) 
 
Data Description Data type 
Battery defect voltage [0.01 V] Battery defect voltage: If the battery voltage falls below the set 

value, then the battery is identified to be defective. 
Unsigned16 

Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the  
SITOP UPS1600. 

Unsigned16 

Ignore battery coding Ignore data of the coded battery: When this parameter is set to 
"1", then data of the coded battery is ignored. Instead, data is 
taken from the parameterization ("Battery Parameters", "Charging 
Parameters"). 

Unsigned8 

0x0003: Charging parameters (reading/writing) 
 
Data Description Data type 
End of charge voltage [0.01 V] End of charge voltage: Battery voltage when charging changes to 

trickle charging. The connected energy storage device is then 
charged up to 100 %. 

Unsigned16 

Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

0x0004: Reset parameters (reading/writing) 
 
Data Description Data type 
Reset time [1 s] Reset time: Time during which the SITOP UPS1600 output is 

shutdown if the connected devices are reset. 
Unsigned8 

0x0005: Battery information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of connected battery modules. Here, only the 

SITOP UPS1100 battery modules (coded batteries) are counted. 
Unsigned8 

Fill byte(s) - 3 x Unsigned8 
Batt 1: Standby time [1 s] Standby time Unsigned32 
Batt 1: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 1: Total charging current 
[1 mAh] 

Total charge level (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 1: Total culled current [1 mAh] Total charge level used (battery-specific data): Total discharge 
over the lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 1: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 1: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 
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Data Description Data type 
Batt 1: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-

vices connected to the  
SITOP UPS1600. 

Unsigned16 

Batt 1: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 1: Battery type Battery type Unsigned8 
Batt 1: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 1: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3 x Unsigned8 
Batt 1: Order number Order number (Article number). VisibleString(30) 
Batt 1: Serial number Serial number VisibleString(30) 
Batt 1: Manufacturing date Manufacturing date VisibleString(30) 
Batt 1: Version number Version number VisibleString(50) 
Batt 2: Standby time [1 s] Standby time Unsigned32 
Batt 2 Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 2: Total charging current 
[1 mAh] 

Total charge level (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 2: Total culled current [1 mAh] Total charge level used (battery-specific data): Total discharge 
over the lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 2: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 2: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 2: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the  
SITOP UPS1600. 

Unsigned16 

Batt 2 Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 2: Battery type Battery type Unsigned8 
Batt 2: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 12 Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3 x Unsigned8 
Batt 2: Order number Order number (Article number). VisibleString(30) 
Batt 2: Serial number Serial number VisibleString(30) 
Batt 2: Manufacturing date Manufacturing date VisibleString(30) 
Batt 2: Version number Version number VisibleString(50) 
Batt 3: Standby time [1 s] Standby time Unsigned32 
Batt 3: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 
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Data Description Data type 
Batt 3: Total charging current 
[1 mAh] 

Total charge level (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 3: Total culled current [1 mAh] Total charge level used (battery-specific data): Total discharge 
within the service life of the SITOP UPS1600. 

Unsigned32 

Batt 3: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 3: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 3: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the  
SITOP UPS1600. 

Unsigned16 

Batt 3: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 3: Battery type Battery type Unsigned8 
Batt 3: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 3: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3 x Unsigned8 
Batt 3: Order number Order number (Article number). VisibleString(30) 
Batt 3 Serial number Serial number VisibleString(30) 
Batt 3: Manufacturing date Manufacturing date VisibleString(30) 
Batt 3: Version number Version number VisibleString(50) 
Batt 4: Standby time [1 s] Standby time Unsigned32 
Batt 4: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 4: Total charging current 
[1 mAh] 

Total charge level (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 4: Total culled current [1 mAh] Total charge level used (battery-specific data): Total discharge 
over the lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 4: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 4: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 4: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the  
SITOP UPS1600. 

Unsigned16 

Batt 4: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 4: Battery type Battery type Unsigned8 
Batt 4: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 4: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3 x Unsigned8 
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Data Description Data type 
Batt 4: Order number Order number (Article number). VisibleString(30) 
Batt 4: Serial number Serial number VisibleString(30) 
Batt 4: Manufacturing date Manufacturing date VisibleString(30) 
Batt 4: Version number Version number VisibleString(50) 
Batt 5: Standby time [1 s] Standby time Unsigned32 
Batt 5: Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 5: Total charging current 
[1 mAh] 

Total charge level (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 5: Total culled current [1 mAh] Total charge level used (battery-specific data): Total discharge 
within the service life of the SITOP UPS1600. 

Unsigned32 

Batt 5: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 5: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 5: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the 
 SITOP UPS1600. 

Unsigned16 

Batt 5: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 5: Battery type Battery type Unsigned8 
Batt 5: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 5: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3 x Unsigned8 
Batt 5: Order number Order number (Article number). VisibleString(30) 
Batt 5: Serial number Serial number VisibleString(30) 
Batt 5: Manufacturing date Manufacturing date VisibleString(30) 
Batt 5: Version number Version number VisibleString(50) 
Batt 6: Standby time [1 s] Standby time Unsigned32 
Batt 6 Buffer time [1 s] Required buffer time, after which the SITOP UPS1600 shuts down 

in the buffer mode. 
Unsigned32 

Batt 6: Total charging current 
[1 mAh] 

Total charge level (battery-specific data): Total charge within the 
service lifetime of the SITOP UPS1600. 

Unsigned32 

Batt 6: Total culled current [1 mAh] Total charge level used (battery-specific data): Total discharge 
within the service life of the SITOP UPS1600. 

Unsigned32 

Batt 6: EOCV [0.01 V] "End-of-charge voltage": Battery voltage when charging changes 
to trickle charging. The energy storage device is then charged up 
to 100 %. 

Unsigned16 

Batt 6: Charge current [1 mA] Charge current: Current magnitude used to charge the connected 
battery modules during the constant charging process. 

Unsigned16 

Batt 6: Battery capacity [0.1 Ah] Battery capacity: Total battery capacity of all energy storage de-
vices connected to the  
'SITOP UPS1600. 

Unsigned16 
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Data Description Data type 
Batt 6: Stop buffering voltage 
[0.01 V] 

Stop buffering voltage: Buffer operation is exited if the battery 
voltage is below this value. 

Unsigned16 

Batt 6: Battery type Battery type Unsigned8 
Batt 6: Minimal temperature [1 °C] Lowest specified operating temperature of the battery module 

being used SITOP UPS1100. 
Signed8 

Batt 6: Maximal temperature [1 °C] Highest specified operating temperature of the battery module 
being used SITOP UPS1100. 

Signed8 

Fill byte(s) - 3 x Unsigned8 
Batt 6: Order number Order number (Article number). VisibleString(30) 
Batt 6: Serial number Serial number VisibleString(30) 
Batt 6: Manufacturing date Manufacturing date VisibleString(30) 
Batt 6: Version number Version number VisibleString(50) 

0x0006: Device information parameters (reading) 
 
Data Description Data type 
HW revision Hardware version Unsigned16 
SW revision Software release Unsigned16 
Boot loader version Boot loader version Unsigned16 
Max output current [1 A] Maximum output current Unsigned8 
Fill byte(s) - Unsigned8 
MLFB/Order number MLFB/order number (Article number) VisibleString(30) 
Serial number Serial number VisibleString(30) 
Device name Device name VisibleString(30) 
Version number Version number VisibleString(50) 

0x0007: Hardware setting parameters (reading) 
 
Data Description Data type 
Buffer time [1 s] Buffer time: After the selected buffer time has expired, the  

SITOP UPS1600 switches off the load output. The actual buffer 
time that can be achieved depends on the connected loads and 
energy storage devices. 

Unsigned16 

Buffer threshold [0.01 V] Connection threshold: Switching voltage for buffering. Buffering is 
active below this value. 

Unsigned16 

Buffering allowed Activate or deactivate buffer operation. The setting is only accept-
ed in operating mode Remote Enable (REN) of the  
SITOP UPS1600. 

Unsigned8 

Enable reset Enable reset: If, during buffer operation, the input voltage be-
comes available again, then the output of the SITOP UPS1600 is 
switched off for a selectable time in order to reset connected 
loads. 

Unsigned8 
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Data Description Data type 
Start from battery Start from battery: Setting at the signal terminal for function "Start 

from battery". 
Unsigned8 

Selected battery profile Profile of the selected battery: The battery charging behavior is set 
at the signal terminals. The setting is only used, if the 
SITOP UPS1600 is not in the "Remote Enable" (REN) mode 

Unsigned8 

0x0008: Buffering parameters (reading/writing) 
 
Data Description Data type 
Expected buffer current [0.1 Ah] 
from V2.0 and higher 

Expected buffer current: Estimated average load current during 
buffer operation. 

Unsigned16 

0x0009: Maintenance parameters (reading/writing) 
 
Data Description Data type 
Resistor test interval [1 h] from 
V2.1 

R test interval Unsigned16 

0x0010: DC-UPS command (writing) 
 
Data Description Data type 
CommandID Remote reset: 8195 Unsigned16 
Parameter 1 Not used Unsigned8 
Parameter 2 Toff : output voltage down time [s] 

>= V1.0 
Unsigned8 

 

 
Data Description Data type 
CommandID Remote reset 2: 8207 Unsigned16 
Parameter 1 Td: Waiting time after end of communication [s] Unsigned8 
Parameter 2 Toff : output voltage down time [s] 

>= V2.0.0 
Unsigned8 

 

 
Data Description Data type 
CommandID Output ON/OFF: 8200 Unsigned16 
Parameter 1 0 Unsigned8 
Parameter 2 0: output OFF 

1: output ON 
Unsigned8 
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Data Description Data type 
CommandID Reset to Factors-Values: 8209 Unsigned16 
Parameter 1 Not used Unsigned8 
Parameter 2 Not used 

>= V2.1.0 
Unsigned8 

0x0010: Result of DC-UPS command (reading) 
 
Data Description Data type 
CommandID CommandID (of the previously sent command) Unsigned16 
Parameter 1 0: OK 

> 0: Error 
Unsigned16 

0x0011: Battery 1 information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of batteries Unsigned8 from 

V2.2 
Battery 1 available 0 ... not available 1 ... available Unsigned8 from 

V2.2 
Minimal temperature Minimal temperature Signed8 from 

V2.2 
Maximal temperature Maximal temperature Signed8 from 

V2.2 
Standby time Standby time Unsigned32 

from V2.2 
Buffer time Buffer time Unsigned32 

from V2.2 
Total charging current  Total charging current Unsigned32 

from V2.2 
Total culled current Total culled current Unsigned32 

from V2.2 
EOCV End-of-charge voltage Unsigned16 

from V2.2 
Charge current Charge current Unsigned16 

from V2.2 
Battery capacity Battery capacity Unsigned16 

from V2.2 
Stop buffering voltage Stop buffering voltage Unsigned16 

from V2.2 
Battery type Battery type Unsigned8 from 

V2.2 
Order number Order number VisibleString(19) 

from V2.2 
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Data Description Data type 
Serial number Serial number VisibleString(15) 

from V2.2 
Manufacturing date Manufacturing date 3 × Unsigned8 

from V2.2 
Version number Version number 2 × Unsigned8 

from V2.2 

0x0012: Battery 2 information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of batteries Unsigned8 from 

V2.2 
Battery 2 available 0 ... not available 2 ... available Unsigned8 from 

V2.2 
Minimal temperature Minimal temperature Signed8 from 

V2.2 
Maximal temperature Maximal temperature Signed8 from 

V2.2 
Standby time Standby time Unsigned32 

from V2.2 
Buffer time Buffer time Unsigned32 

from V2.2 
Total charging current  Total charging current Unsigned32 

from V2.2 
Total culled current Total culled current Unsigned32 

from V2.2 
EOCV End-of-charge voltage Unsigned16 

from V2.2 
Charge current Charge current Unsigned16 

from V2.2 
Battery capacity Battery capacity Unsigned16 

from V2.2 
Stop buffering voltage Stop buffering voltage Unsigned16 

from V2.2 
Battery type Battery type Unsigned8 from 

V2.2 
Order number Order number VisibleString(19) 

from V2.2 
Serial number Serial number VisibleString(15) 

from V2.2 
Manufacturing date Manufacturing date 3 × Unsigned8 

from V2.2 
Version number Version number 2 × Unsigned8 

from V2.2 
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0x0013: Battery 3 information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of batteries Unsigned8 from 

V2.2 
Battery 3 available 0 ... not available 3 ... available Unsigned8 from 

V2.2 
Minimal temperature Minimal temperature Signed8 from 

V2.2 
Maximal temperature Maximal temperature Signed8 from 

V2.2 
Standby time Standby time Unsigned32 

from V2.2 
Buffer time Buffer time Unsigned32 

from V2.2 
Total charging current  Total charging current Unsigned32 

from V2.2 
Total culled current Total culled current Unsigned32 

from V2.2 
EOCV End-of-charge voltage Unsigned16 

from V2.2 
Charge current Charge current Unsigned16 

from V2.2 
Battery capacity Battery capacity Unsigned16 

from V2.2 
Stop buffering voltage Stop buffering voltage Unsigned16 

from V2.2 
Battery type Battery type Unsigned8 from 

V2.2 
Order number Order number VisibleString(19) 

from V2.2 
Serial number Serial number VisibleString(15) 

from V2.2 
Manufacturing date Manufacturing date 3 × Unsigned8 

from V2.2 
Version number Version number 2 × Unsigned8 

from V2.2 

0x0014 Battery 4 information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of batteries Unsigned8 from 

V2.2 
Battery 4 available 0 ... not available 4 ... available Unsigned8 from 

V2.2 
Minimal temperature Minimal temperature Signed8 from 

V2.2 
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Data Description Data type 
Maximal temperature Maximal temperature Signed8 from 

V2.2 
Standby time Standby time Unsigned32 

from V2.2 
Buffer time Buffer time Unsigned32 

from V2.2 
Total charging current  Total charging current Unsigned32 

from V2.2 
Total culled current Total culled current Unsigned32 

from V2.2 
EOCV End-of-charge voltage Unsigned16 

from V2.2 
Charge current Charge current Unsigned16 

from V2.2 
Battery capacity Battery capacity Unsigned16 

from V2.2 
Stop buffering voltage Stop buffering voltage Unsigned16 

from V2.2 
Battery type Battery type Unsigned8 from 

V2.2 
Order number Order number VisibleString(19) 

from V2.2 
Serial number Serial number VisibleString(15) 

from V2.2 
Manufacturing date Manufacturing date 3 × Unsigned8 

from V2.2 
Version number Version number 2 × Unsigned8 

from V2.2 

0x0015: Battery 5 information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of batteries Unsigned8 from 

V2.2 
Battery 5 available 0 ... not available 5 ... available Unsigned8 from 

V2.2 
Minimal temperature Minimal temperature Signed8 from 

V2.2 
Maximal temperature Maximal temperature Signed8 from 

V2.2 
Standby time Standby time Unsigned32 

from V2.2 
Buffer time Buffer time Unsigned32 

from V2.2 
Total charging current  Total charging current Unsigned32 

from V2.2 
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Data Description Data type 
Total culled current Total culled current Unsigned32 

from V2.2 
EOCV End-of-charge voltage Unsigned16 

from V2.2 
Charge current Charge current Unsigned16 

from V2.2 
Battery capacity Battery capacity Unsigned16 

from V2.2 
Stop buffering voltage Stop buffering voltage Unsigned16 

from V2.2 
Battery type Battery type Unsigned8 from 

V2.2 
Order number Order number VisibleString(19) 

from V2.2 
Serial number Serial number VisibleString(15) 

from V2.2 
Manufacturing date Manufacturing date 3 × Unsigned8 

from V2.2 
Version number Version number 2 × Unsigned8 

from V2.2 

0x0016: Battery 6 information parameters (reading) 
 
Data Description Data type 
Number of batteries Number of batteries Unsigned8 from 

V2.2 
Battery 6 available 0 ... not available 6 ... available Unsigned8 from 

V2.2 
Minimal temperature Minimal temperature Signed8 from 

V2.2 
Maximal temperature Maximal temperature Signed8 from 

V2.2 
Standby time Standby time Unsigned32 

from V2.2 
Buffer time Buffer time Unsigned32 

from V2.2 
Total charging current  Total charging current Unsigned32 

from V2.2 
Total culled current Total culled current Unsigned32 

from V2.2 
EOCV End-of-charge voltage Unsigned16 

from V2.2 
Charge current Charge current Unsigned16 

from V2.2 
Battery capacity Battery capacity Unsigned16 

from V2.2 
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Data Description Data type 
Stop buffering voltage Stop buffering voltage Unsigned16 

from V2.2 
Battery type Battery type Unsigned8 from 

V2.2 
Order number Order number VisibleString(19) 

from V2.2 
Serial number Serial number VisibleString(15) 

from V2.2 
Manufacturing date Manufacturing date 3 × Unsigned8 

from V2.2 
Version number Version number 2 × Unsigned8 

from V2.2 

0x0020: State information (reading) 
 
Data Description Data type 
Remaining buffer time [1 s] Probable remaining buffer time. The remaining buffer time is cal-

culated based on the present battery charge and the average 
current over a 10 minute period. 

Unsigned32 

Total operating time [1 h] Total operating time. Unsigned32 
Total calculated battery capacity 
[0.1 Ah] 

Total calculated battery capacity Unsigned16 

Calculated battery 1 capacity 
[0.1 Ah] 

Battery 1: Calculated battery capacity Unsigned16 

Calculated battery 2 capacity 
[0.1 Ah] 

Battery 2: Calculated battery capacity Unsigned16 

Calculated battery 3 capacity 
[0.1 Ah] 

Battery 3: Calculated battery capacity Unsigned16 

Calculated battery 4 capacity 
[0.1 Ah] 

Battery 4: Calculated battery capacity Unsigned16 

Calculated battery 5 capacity 
[0.1 Ah] 

Battery 5: Calculated battery capacity Unsigned16 

Calculated battery 6 capacity 
[0.1 Ah] 

Battery 6: Calculated battery capacity Unsigned16 

Input voltage [0.01 V] Input voltage: Measured rms value of the supply voltage at the 
input of the SITOP UPS1600. 

Unsigned16 

Input current [5 mA] Current measured at the input of the SITOP UPS1600. Unsigned16 
Output voltage [0.01 V] Voltage measured at the output of the SITOP UPS1600. Unsigned16 
Load current [5 mA] Load current measured at the output of the SITOP UPS1600. Unsigned16 
Measured charge current [1 mA] Measured battery charge current of the SITOP UPS1600. Unsigned16 
Battery voltage [0.01 V] Measured battery voltage of the connected battery modules Unsigned16 
Output current [5 mA] Load current measured at the output of the SITOP UPS1600. Unsigned16 
Charge voltage [0.01 V] Voltage used to charge the batteries during the constant charging 

process. 
Unsigned16 

Fill byte(s) - 3 x Unsigned8 
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Data Description Data type 
Valid configuration Valid configuration: Indicates whether the software parameters or 

the parameters at the rotary switches are used. The corresponding 
setting should be made at the rotary switch for the buffer thresh-
old. 

Unsigned8 

Number of batteries Number of connected battery modules. Here, only the 
SITOP UPS1100 battery modules (coded batteries) are counted. 

Unsigned8 

Fill byte(s) - 7 x Unsigned8 
Battery 1 change recommended Battery 1: Battery replacement recommended: The battery capaci-

ty is not sufficient for the defined buffer time. 
Unsigned8 

Battery 2 change recommended Battery 2: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 3 change recommended Battery 3: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 4 change recommended Battery 4: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 5 change recommended Battery 5: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 6 change recommended Battery 6: Battery replacement recommended: The battery capaci-
ty is not sufficient for the defined buffer time. 

Unsigned8 

Battery 1 Connection Fault Battery1: Connection fault Unsigned8 
Battery 2 Connection Fault Battery 2: Connection fault Unsigned8 
Battery 3 Connection Fault Battery 3: Connection fault Unsigned8 
Battery 4 Connection Fault Battery 4: Connection fault Unsigned8 
Battery 5 Connection Fault Battery 5: Connection fault Unsigned8 
Battery 6 Connection Fault Battery 6: Connection fault Unsigned8 
Battery 1 temperature [1 °C] Battery 1: Battery temperature Integer8 
Battery 2 temperature [1 °C] Battery 2: Battery temperature Integer8 
Battery 3 temperature [1 °C] Battery 3: Battery temperature Integer8 
Battery 4 temperature [1 °C] Battery 4: Battery temperature Integer8 
Battery 5 temperature [1 °C] Battery 5: Battery temperature Integer8 
Battery 6 temperature [1 °C] Battery 6: Battery temperature Integer8 
Device temperature [1 °C] Temperature in the housing Integer8 
LED pattern Status of LEDs 1 to 4 for the SITOP UPS1600 1) Unsigned8 

1) Object structure LED pattern 
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0x0040: Identification value parameters (reading/writing) 
 
Data Description Data type 
Contact Name of the contact person. You can change the name to suit 

your requirements (maximum 22 characters). 
VisibleString(40) 
VisibleString(64) 
from V2.1 

Location Location designation: Indicates the unique location of the 
SITOP UPS1600 (max. 22 characters). 

VisibleString(40) 
VisibleString(44) 
from V2.1 

0x0041: Web server parameters (reading/writing) 
 
Data Description Data type 
WebserverEnabled  Enable/disable the web server of the SITOP UPS1600: 

• 0: disable 
• 255. enable 

Unsigned8 

AutoReloadEnabled from V2.1 Enable/disable automatic update: 
• 0: disable 
• 255. enable 

Unsigned8 

ReloadTime from V2.1 Update interval: 
• 0: Off 
• 5: 5s 
• 10: 10s 
• 20: 20s 
• 30: 30s 
• 60: 60s 

Unsigned8 

AutoLogout from V2.1 Enable/disable automatic logoff: 
• 0: disable 
• 255. enable 
When automatic logoff is activated, the logged on user ("Guest" or 
"Admin") is automatically logged off when the SITOP UPS1600 
web server is inactive for 15 minutes. 

Unsigned8 

HttpAccessEnable from V2.1 Enable/disable HTTP access: 
• 0: disable 
• 255: enable 

Unsigned8 

Fill byte(s) from V2.1 - Unsigned8 
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0x0042: OPC UA server (reading/writing) 
 
Data Description Data type 
OPCServerEnabled Activate/deactivate the OPC UA interface of the SITOP UPS1600: 

• 0: disable 
• 255: enable 

Unsigned8 

OPCUnencrypdedAccessEnable Activate/deactivate unencrypted access via the OPC UA interface 
of the SITOP UPS1600: 
• 0: disable 
• 255: enable 

Unsigned8 

OPCPort Set port for OPC UA interface (1 to 65535) Unsigned16 

0x0043: NTP client parameters (reading/writing) 
 
Data Description Data type 
NTPServerEnabled Activate/deactivate NTP server: 

• 0: disable 
• 255: enable 

Unsigned8 from 
V2.2 

Fill byte(s) - Unsigned8 from 
V2.2 

NTPServer1 IP address of NTP server 1 Unsigned8 from 
V2.2 

NTPServer2 IP address of NTP server 2 Unsigned8 from 
V2.2 

NTPServer3 IP address of NTP server 3 Unsigned8 from 
V2.2 

NTPServer4 IP address of NTP server 4 Unsigned8 from 
V2.2 

0x0044: NTP client status parameters (reading) 
 
Data Description Data type 
Last synchronization time Time that the last synchronization took place VisibleString(20) 

from V2.2 
Next synchronization time  Time of the next planned synchronization VisibleString(20) 

from V2.2 

0x0045: PROFINETSecurity (reading/writing) 
 
Data Description Data type 
DCPReadonlyIfConnected Setting for DCP write protection Unsigned8 from 

V2.2 
Fill byte(s) - Unsigned8 from 

V2.2 
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3.6 SITOP UPS Manager 
 

 Note 

Ensure that only the UPS Manager accesses the SITOP UPS1600. 
 

 Note 

Install the current version of the SITOP UPS Manager so that you can use the full functional 
scope of the SITOP UPS1600. 

The installation file for the SITOP UPS Manager is available at no charge on the SITOP 
home page (http://www.siemens.com/sitop-ups1600) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

 

3.6.1 Functions of the SITOP UPS Manager 
You can fulfill the following tasks using the SITOP UPS Manager : 

● Configuration of the SITOP UPS1600 uninterruptible power supply and the battery 
modules (see Chapter Configuring the SITOP UPS1600 (Page 119)) 

● Protect a computer or a computer network provided by the uninterruptible power supply 
with the master-slave technique 

● Data backup by controlled shutdown 

● Alarm-controlled starting of any application (SMS, e-mail) 

New functions from V4.71: 

● OPC UA server as non-proprietary software interface. 

● Sitting IP address and name in the SITOP UPS1600. 

● Identifying SITOP UPS1600 by flashing LED SF. 

By specifying additional applications and alarms, you define a comprehensive protection of 
your computer or computer network. 

The applications can be started depending on the following events: 

● Supply voltage failure 

● Restoration of the supply voltage 

● State of the buffer readiness by the UPS: 

– General buffer readiness 

– Remaining buffer time 

● Status of the UPS battery: 

– Battery replacement required 

– Battery charge 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854607
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3.6.2 The user interface of the SITOP UPS Manager 

 
① Tabs for selecting the submenus 
② Language selection 
③ Save bar 
④ Connection lamps 

Use the tab ① to reach the individual submenus. 

The language selection ② is used to select the user interface language of the SITOP UPS 
Manager. The German, English, French, Italian, Spanish, and Chinese languages are 
available. 

You use the functions of the save bar ③ to load the configuration into or from the 
SITOP UPS1600 – and open or save the configurations to a data medium. 

The colors of the connection lamps ④ indicate the status of the incoming and outgoing 
connection. Both lamps must light green.  

 
Left-hand connection lamp: Connection status SITOP UPS Manager application - SITOP 
UPS Manager service 
Right-hand connection lamp: Connection status SITOP UPS Manager service - SITOP 
UPS1600 
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3.6.3 Installation/uninstallation 
The installation file for the SITOP UPS Manager is available at no charge on the SITOP 
home page (http://www.siemens.com/sitop-ups1600) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

Operational requirements 

Operating systems 

The Windows XP and Windows 7 (32 bit and 64 bit) operating systems are supported. 

Ethernet or USB interface 

To install and use the SITOP UPS Manager in conjunction with the SITOP UPS1600, the 
computer must be connected with the SITOP UPS1600 via Ethernet or USB port. 

Windows user group 

Users of the SITOP UPS Manager must be members of the Windows user group "power 
users". 

Installation preconditions 

Administration rights 

You require administrator rights to install the SITOP UPS Manager. 

Installation paths without blanks 
 

 Note 
Paths must not contain any blanks! 

The path names of the directories for SITOP UPS Manager and batch files must not contain 
any blanks. 

 

Installation steps 

Procedure when installing for the first time 

1. Close all applications before you start the installation. 

2. Double-click on the "Setup_SITOP-UPSManager_x.xx.x" file. 

http://www.siemens.com/sitop-ups1600
https://support.industry.siemens.com/cs/ww/en/view/75854607
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3. Follow the installation instructions. Enter the requested information in the dialogs: 

– Installer language, English or German 

– Agreement declaration with the license conditions 

– Installation scope: 
Activate option "USB driver" if your SITOP UPS1600 has a USB interface. You can 
select between application and service. 

– Installation path: 
Use the recommended target directory "C:\Program Files\x68\SITOPUPSManager" or 
select another one. If you select another target directory, please note that spaces are 
not permissible in the path name (to be taken into consideration up to version 4.61). 

– Start menu folder 
Select the folder structure under which the SITOP UPS Manager should appear in the 
start menu. 

4. If you are using a SITOP UPS1600 with USB interface, then connect the 
SITOP UPS1600 to the computer using this interface. 

5. Click "Finish" to complete the installation. 

Procedure for an already existing installation 
 

 Note 

The procedure described below is only necessary if a SITOP UPS Manager with version 
number less than 4.50 is to be installed. These steps are automatically executed for versions 
from V4.50 and higher. 

 

1. Back up the file "dcups.ini", which is located in directory "ini" in the installation directory of 
the SITOP UPS Managers. 

2. Carry out steps 1 to 5 of the procedure described above when installing for the first time. 

3. Replace file "dcups.ini", which is located in directory "ini" in the installation directory of the 
SITOP UPS Managers, as a result of the file backed up in Step 1. 

Result 
After the successful installation, the SITOP "UPS Manager" is contained in the start menu 
under the selected start menu folder. 

No further installations are required to operate the SITOP UPS Manager. 

Uninstallation 
The UPS Manager can be uninstalled using "Start → All programs → SITOPUPS Manager → 
Uninstall". 



 Engineering and remote access 
 3.6 SITOP UPS Manager 

SITOP UPS1600 / UPS1100 
Manual, 04.2017, A5E37775406-8-76 113 

3.6.4 Options of establishing a connection to the SITOP UPS1600 
Depending on the type, the SITOP UPS1600 provides either a USB interface or an Ethernet 
interface. 

Depending on the type, the SITOP UPS1600 communicates via USB or Ethernet with the 
SITOP UPS Manager. 

The SITOP UPS Manager supports the master-slave operation only for an existing Ethernet 
connection. This permits, for example, a controlled shutdown of the computers in the 
network by the applications started with the SITOP UPS Manager. 

3.6.5 Establishing a connection via Ethernet 
The SITOP UPS1600 requires an IP address for communication with the UPS Manager. This 
is assigned by the network administrator. Use the Primary Setup Tool to configure the 
SITOP SITOP UPS1600 interface. 

Configuring the SITOP UPS1600 with the Primary Setup Tool 
The Primary Setup Tool is a Siemens product that is free of charge, and which is used to 
identify and configure network-capable devices. You can download the Primary Setup Tool 
at (http://support.automation.siemens.com/WW/view/en/19440762). 

From SW Version V2.1.0, the Primary Setup Tool is already integrated in the UPS Manager 
(from Version V4.71.x). 

The following procedure is then required: 

● "Device configuration" tab 

● Select network adapter 

● Device configuration → DC-UPS → Update list 
 

Additional information is contained in the Primary Setup Tool manual. This manual and 
further links can be found at 
(http://support.automation.siemens.com/WW/view/en/19440762). 

Preconditions 

● The SITOP UPS1600 is connected with the client (PG/PC) via the Ethernet interface. 

● The Primary Setup Tool is installed on the client. 

● Firewall settings that are necessary: 

– Communication via 5000 is permitted. 

– Echo request (ping) is permitted. 

http://support.automation.siemens.com/WW/view/en/19440762
http://support.automation.siemens.com/WW/view/en/19440762
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Procedure 

1. Start the Primary Setup Tool. 

2. Select the "Settings > Select interface" menu command. 
The "Set PG/PC interface" dialog opens. 

 
3. Select the interface with which the client is connected with the SITOP UPS1600. 

Click "OK" to close the "Set PG/PC interface" dialog. 
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4. Select the menu command "Network > Search". 
SITOP UPS1600 appears in the tree view as "DC-UPS :" with its MAC address and its IP 
address. 

 
5. Open the SITOP UPS1600 entry and select "Ind. Ethernet interface". 

In the right-hand section, the configuration menu for the Ethernet interface of the SITOP 
UPS1600 opens. 
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6. Configure the Ethernet interface as specified by the network administrator. 

7. Select the SITOP UPS1600 in the Tree view. 

Loading to the device is not possible while an interface is selected. 

 
8. Select menu command "Module > Download", to load the configuration to the device. 

Alternatively, you can start loading using the "Load" button in the toolbar. 

 

Configuring the connection in the SITOP UPS Manager 
A basic setting is the configuration of the client (PC/PG) as master or slave. The 
consideration of possible application situations can help here: 

 
● The local computer is the only computer at the SITOP UPS1600. 

Local computer = master PC 

● The local computer is one of several computers and performs the master function. 
Local computer = master PC 

● The local computer is one of several computers at the SITOP UPS1600 and operates as 
slave. 
Local computer = slave PC 

In the master-slave configuration, the SITOP UPS1600, the master PC and the slave PC are 
connected at the same physical Ethernet. Only the master PC communicates directly with 
the SITOP UPS1600. The slave PC receives the control signals from the SITOP UPS 
Manager of the master PC. 

 

 Note 

Up to SITOP UPS Manager Version 4.12, the master PC can only manage 1 slave PC. From 
version 4.12.5 and higher, up to 8 slaves can be managed. 
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Configuring the local computer as master PC 
1. Select "General settings > Device configuration". 

2. Activate the "Ethernet" checkbox and the "Master-PC" checkbox. 

3. If the message appears as to whether you wish to restart the SITOP UPS Manager, 
confirm this with "Yes". 

The SITOP UPS Manager is restarted. 

4. Select "Hardware configuration > Ethernet configuration". 

5. Enter the IP address of the master PC in the field "IP address of the master PC". A 
selection box is displayed next to field "IP address of the master PC", which lists all of the 
available IP addresses of the client (PC/PG). Selecting an IP address automatically 
inserts this address in field "IP address of the master PC". 

 
  Note 

Also at the local computer, the IP address of the master PC must be specified in the 
SITOP UPS Manager if a master-slave configuration is to be used. 

 

6. Enter the IP address of the SITOP UPS1600 in the "IP address of the DC-UPS" field. 

7. If the message appears as to whether you wish to restart the SITOP UPS Manager, 
confirm this with "Yes".  
The SITOP UPS Manager is restarted. 

The connection lamps light up green, the connection as master PC to the SITOP UPS1600 
is established, if the (local) PC is connected as master PC to the SITOP UPS1600. 

 

Configuring the client as slave PC 
1. Select "General settings > Device configuration". 

2. Activate the "Ethernet" checkbox and the "Slave PC" checkbox. 

3. If the message appears as to whether you wish to restart the SITOP UPS Manager, 
confirm this with "Yes".  
The SITOP UPS Manager is restarted. 

4. Select "Hardware configuration > Ethernet configuration". 

5. Enter the IP address of the master PC in the field "IP address of the master PC". 

6. If the message appears as to whether you wish to restart the SITOP UPS Manager, 
confirm this with "Yes".  
The SITOP UPS Manager is restarted. 

The connection lamps light up green, the connection as slave PC to the master PC is 
established, if the (local) PC is connected as master PC to the SITOP UPS1600. 
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3.6.6 Establishing a connection via USB 
1. Connect the SITOP UPS1600 using a USB cable with the client (PC/PG). 

 
2. Select "General settings > Device configuration". 

3. Activate the "USB (UPS1600)" checkbox. 

4. If, in the lower area, a blue bar with the message "Configuration changed, restart 
application now." appears, click on the bar to restart the UPS. Clicking on "x" only 
minimizes the UPS Manager. You can maximize the UPS Manager again by clicking on 
the associated symbol in the task bar.  
The SITOP UPS Manager is restarted. 

5. Check that the connection lamps light green. 

The connection lamps light green, the connection to the SITOP UPS1600 via USB has 
been established, if the (local) PC is connected as master PC to the SITOP UPS1600. 

 

3.6.7 Configuration in the SITOP UPS Manager 
Once you have connected the SITOP UPS1600 and the SITOP UPS Manager, you have the 
following configuration options: 

● Create a new configuration. 

● Load a configuration from a data medium or from a device. 

● Change a configuration. 

● Store a configuration on a data medium or load it into a device. 

Procedure 

1. Make the required hardware configuration in SITOP UPS Manager. 

2. Click in the save bar "Configurations" on the "Download" button. The configuration is 
loaded to the SITOP UPS1600 . 

3. Change the hardware configuration in the SITOP UPS Manager to address your specific 
requirements. 

4. Click in the save bar "Configurations" on the "Download" button to transfer the 
configuration to the SITOP UPS1600. Click on "Save file", to save the configuration to a 
file. This means that you can restore the SITOP UPS1600 configuration at a later point in 
time – or transfer the configuration to other devices. 
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 Note 

When saving or loading a HW configuration, the entry in "Base unit > Location" is not 
accepted/changed. 

 

3.6.7.1 General settings 
Under "Software configuration > General settings", specify the maximum size of the log file in 
Kbytes and where it is saved.  

From SITOP UPS Manager V4.12.5 and higher, under "Software configuration > General 
settings" you can also specify as to whether the window of the SITOP UPS Manager should 
always be in the foreground. 

Log file 
1. Select "Software configuration > General settings". 

2. Enter the maximum file size in kbytes in the "Size of log file" dialog box. 

3. Click on "Browse" 

4. Select the directory in which the log file should be stored. 

5. Confirm with "Select folder". 

The maximum size and the storage location of the log file has been saved. 

3.6.7.2 Configuring the SITOP UPS1600 
Using the SITOP UPS Manager, you can configure the SITOP UPS1600 and its energy 
storage device, and then load to the device (if it is an uncoded battery – for UPS1100, the 
values are automatically identified). To change the charge parameters switch-in threshold or 
buffer time, you must set the corresponding rotary coding switch to the "REN" position. 

1. To do this, select "Hardware configuration > Base device" or "Hardware configuration > 
Energy storage". 

2. Enter the desired values. 

3. Click on "Download" 

Configuring the basic device (base unit) 
The following parameters are available under "Hardware configuration> Base unit". 

 
Parameter Value range Default setting 
Location Free text – 
Connection threshold 21 - 25 V 22.5 V 
Buffer time 1 - 32767 s 600 s 
Maximum buffer time 1) Yes / No No 
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Parameter Value range Default setting 
Additional buffer time after the PC was powered down 3) 1 - 300 s 60 s 
Expected buffer current 1) 0 - 40 A 0 A 
Reset time 1 - 120 s 5 s 
Enable reset after buffering Yes / No No 
Downtime alarm 0 - 20000 ms 100 ms 
Wait time for stable input voltage 0.2 - 65 s 1.0 s 
R test interval 2) 1 - 65535 h 4 h 
 1) Parameter only available from V2.0.0 and higher 

2) Parameter only available from V2.1 and higher 
3)  valid from V2.0.4 or V2.1 

● Location: Details of the location identification where the SITOP UPS1600 is installed. 

● Connection threshold: If the connection threshold value is fallen below, the 
SITOP UPS1600 starts buffering. If the value of the connection threshold is reached or 
undershot again later, the SITOP UPS1600 stops buffering. 

● Buffer time: Length of time during which the system should be buffered by the 
SITOP UPS1600. 

● Maximum buffer time: The MAX setting means that buffering is realized for as long as 
possible. The device only shuts down when the battery has discharged down to the 
defined stop buffering voltage. The value entered for the "Buffer time" parameter is not 
relevant in this case. 

● Additional buffer time after PC shutdown: The time in which the system is buffered by the 
SITOP UPS1600 once the PC has been shut down. 

● Expected buffer current: Load current, which is expected at the device output during 
buffer operation. Please adjust the correct application load current required. For current 
settings between 0 A and rated current, the display in the diagram "Remaining buffer 
time" is adapted. If a value of 0 A is entered, then for this parameter, the average value of 
the actual load current measured at the output over the last 10 min is assumed. The 
value of this parameter is used when calculating the remaining buffer time. The entered 
value may not exceed the rated device current. 

 
  Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, 
to determine the expected buffer time, instead of the expected buffer current, the actually 
measured buffer current is used. 

 

● Reset time: Time, in which the output voltage of the SITOP UPS1600 is switched off, 
although in the meantime the input voltage has returned. This function allows IPCs to 
automatically restart. 

● Enable reset time after buffering: If the value is set to "Yes", the SITOP UPS1600 shuts 
down the output for the selected interrupt time if, in the meantime, the input voltage 
returns after the buffer time has expired. Using this function, after the SITOP UPS1600 
has been powered down, an IPC can be switched on again, for example. 
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● Downtime alarm: The time in which no alarm is issued to the system although it is 
buffered. 

● Wait time for stable input voltage: The time in which no alarm is issued to the system 
although the connection threshold has been undershot. 

● R test interval: The time interval between battery tests can be set using the parameter. 

To reset the parameters to their initial value, click the "Reset to initial values" button. All 
parameters for the base device will be reset to their initial value. 

Configuring the energy storage 
The characteristic values of a SITOP UPS1100 battery module are automatically read by the 
coding. If a SITOP UPS1100 battery module is used, activate the "SITOP UPS1100 battery" 
checkbox. 

If you are using a different battery, activate the "Use third-party battery" checkbox. Enter the 
rated values of the other battery. The following parameters are available under "Hardware 
configuration> Energy storage". 

 
Parameter Value range 
Battery capacity 0.1 - 3,200 Ah 
End-of-charge voltage 24 - 30 V 
Charge current 0.001 - 5 A 
Faulty battery voltage 1 - 18 V 

● Battery capacity: Total capacity of the installed batteries 

● End-of-charge voltage: The charging completes when the selected end-of-charge voltage 
is reached. 

● Charge current: The battery is not charged with more than the selected charge current. 
The manufacturer's details for the permitted charge current of the battery must be 
observed. If several batteries are connected, the smallest permitted charge current 
applies. 

● Faulty battery voltage: If the battery voltage falls below this value, it will be considered as 
being defective by the SITOP UPS1600 and is not charged. 

To reset the parameters to their initial value, click the "Reset to initial values" button. All 
parameters for the energy storage will be reset to their initial value. 
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3.6.8 Behavior of the SITOP UPS Manager 
The monitoring of the uninterruptible power supply by the SITOP UPS Manager permits 
other applications to be started event driven.  

In the event of a power failure, the SITOP UPS Manager can use the network to perform a 
controlled shutdown of the devices connected to the uninterruptible power supply in the 
specified order, or place them in a defined standby state. 

Alarms and notifications can also be sent to the system or to users (SMS, e-mail). 
 

The applications can be started depending on the following events and factors: 

● Power failure 

● Power return 

● State of the buffer readiness by the SITOP UPS1600: 

– General buffer readiness 

– Remaining buffer time 

● State of the SITOP UPS1600 battery: 

– Battery charge 

– for recommended battery replacement 

● State of the communication interface: 

– Connection established/interrupted 

● System alarm status 

– At least one alarm is active/no longer active 

Storing an application 
In the various submenus, you can store applications that will be started depending on the 
above-mentioned events and factors. Examples of such applications are: 

● Batch scripts or runnable files, for example, to shut down a computer in the network. 

● Applications that inform the user about the state of the power supply. 

● Applications that protect licenses assigned to computers (floating licenses) from being 
lost because of power failure. 

Procedure 

1. Open the appropriate submenu under "Software configuration". 

2. Activate the checkbox to start the application for the desired event. 

3. Click on "Browse" to select an application. 

4. Select the required application in a directory. 

The application path is displayed. 
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5. To check whether the application will performed correctly, click the "Start" button. 

6. Enter the time in minutes and seconds after which the application should be started. 

 

 Note 

It is recommended that only applications without user interface – or those that automatically 
exit themselves without any manual intervention – are started. 

 

Behavior during buffer mode 
Make the settings under "Software configuration > Buffer operation" vor.  

The following options are available: 

● Start application on power failure. 

● Start application after power return. 

● Show SITOP UPS Manager on power failure. 

● Show SITOP UPS Manager after power return. 

● Shut down PC on power failure. 

 

 NOTICE 

If the buffer time (see Section Configuring the SITOP UPS1600 (Page 119)) is set shorter 
than this time, the SITOP UPS1600 switches off before the PC has been shut down. The 
PC is then no longer protected. In master-slave operation, the time required to run down 
the master must be longer than the time required for the slave. 
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Use the "upsshutdown.exe" program 
After installing UPS-Managers (from version V4.71 and higher), file "upsshutdown.exe" is 
located under the following path: 
C:\Users\Public\Documents\SitopUPSManager\commands\shutdown   
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In the settings for the UPS Manager under SW configuration, activate the following: 

1. Activate "Switch off UPS after manual shutdown"under "General settings" 

 
2. Under buffer operation, activate "Start application on power failure" and specify the path 

to your batch data, e.g. to 
C:\Users\Public\Documents\SitopUPSManager\commands\shutdown\runupsshutdown.ba
t. (adapt to the specific requirements) 

3. Under buffer operation, deactivate "Shut down PC on power failure" 
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Description of the program arguments "upsshutdown.exe": 

upsshutdown.exe -[c][r][s]  
c: PC is shut down  
s: S command is sent to the UPS. The UPS is shut down without any additional delay.  
r: R command is sent to the UPS. After the PC has been shut down (no response to ping), 
the UPS shuts down after waiting for time "Additional buffer time after PC shutdown".    

Example for runupsshutdown.bat: 

@echo off 
set var = C:\Users\Public\Documents\SitopUPSManager\commands\shutdown  
echo "% var %" cd "% var %"  
dir > info.txt  
upsshutdown.exe -cr 

Behavior for missing buffer readiness 
Make the settings under "Software configuration > Not ready for buffering". 

The following options are available: 

● Start the application if buffer mode is not possible. 

● Start the application when buffer readiness returns 

● Open the SITOP UPS Manager if buffer mode is not possible 

● Open the SITOP UPS Manager when buffer readiness returns. 
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Behavior when battery replacement required 
Make the settings under "Software configuration > Battery replacement". 

The following options are available: 

● Start the application if battery replacement is recommended (from SITOP UPS Manager 
V4.12.5 and higher). 

● Start the application once the battery has been replaced. 

● Open the SITOP UPS Manager if battery replacement is recommended (from SITOP 
UPS Manager V4.12.5 and higher). 

● Open the SITOP UPS Manager once the battery has been replaced. 

Behavior depending on the battery charge 
Make the settings under "Software configuration > Battery charge". 

The following options are available: 

● Start the application when the battery charge is > 85 % of the maximum. 

● Start the application when the battery charge is < 85 % of the maximum. 

● Open SITOP UPS Manager when the battery charge is > 85 % of the maximum. 

● Open SITOP UPS Manager when the battery charge is < 85 % of the maximum. 

 

 Note 

From UPS Manager Version V4.71, a percentage value of the battery charge can be 
programmed where an action should be initiated. 

 

Behavior depending on the remaining buffer time 
Make the settings under "Software configuration > Remaining buffer time". Specify the 
minimum buffer time under "Hardware configuration > Base Unit" in entry "Buffer time". 

The following options exist in the "Remaining buffer time" submenu: 

● Start the application if the desired buffer time cannot be achieved. 

● Start the application if the desired buffer time can be achieved again. 

● Display the SITOP UPS Manager if the desired buffer time cannot be achieved. 

● Display the SITOP UPS Manager if the desired buffer time can be achieved again. 

Response when communication to the SITOP UPS1600 is interrupted 
Make the settings under "Software configuration > Communication interface".  

The following options are available: 

● Start the application if there is a connection to the SITOP UPS1600. 

● Start the application if the connection to the SITOP UPS1600 is interrupted. 
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● Open the SITOP UPS Manager if there is a connection to the SITOP UPS1600. 

● Open the SITOP UPS Manager if the connection to the SITOP UPS1600 was interrupted. 

Behavior for pending system alarms 
Make the settings under "Software configuration > System alarms". Reasons for a system 
alarm are contained in the alarms list (see Section Troubleshooting (Page 183)). 

The following options exist in the "System alarms" submenu: 

● Start the application if at least one system alarm is active. 

● Start the application if no system alarm is active. 

● Open the SITOP UPS Manager if at least one system alarm is active. 

● Open the SITOP UPS Manager if no system alarm is active. 

3.6.9 Display and visualization 
The "Display" menu item shows information about the device data and parameters as well as 
the state of the power supply. 

The following display options exist: 

● Active alarms 

● Alarm history 

● Operating data: Data and parameters of the basic device and the energy storage device 

● Trend charts: 

– Load current over time 

– Input voltage over time 

– Remaining buffer time over time 

 
  Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer 
mode, to determine the expected buffer time, instead of the expected buffer current, 
the actually measured buffer current is used.  

 

– Battery temperature over time 

– Battery charge over time 

– Charge current over time 

● Online functions: 

– Updating the firmware 
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Displaying pending alarms 
1. Select "Display > Pending alarms". 

The pending alarms are displayed in a tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date of the alarm arrival 

● Help: Description of the alarm 

Displaying the alarm history 
1. Select "Display > Alarm history". 

The alarm history is displayed in a tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Time: The time and date when the alarm comes and goes 

● Alarm: 

– incoming: Occurrence of the alarm event 

– outgoing: Rectification of the alarm event 

Data and parameters SITOP UPS1600 
1. Select "Display > Operating data". 

2. Under "Base Unit" you can find data and parameters of the SITOP UPS1600. 

The following data are displayed: 

● Order number 

● Serial number 
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● SW version 

● HW product version 

The following parameters are displayed: 

● Buffer mode 

● Remaining buffer time 

 
  Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, 
to determine the expected buffer time, instead of the expected buffer current, the actually 
measured buffer current is used.  

 

● Input voltage 

● Load current 

● Ready for buffering 

Energy storage data and parameters 
1. Select "Display > Operating data". 

2. The data and parameters of the energy storage device can be found under "Energy 
storage". 

The following data are displayed: 

● Order number 

● Serial number 

● SW version 

The following parameters are displayed: 

● Battery capacity 

● Battery charge level 

● Battery temperature 

● Measured charge current 
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Trend charts 
You have the possibility of graphically displaying values about the power supply under 
"Display> Trend chart", for instance the load current over time: 

 
The following trend charts can be selected: 

● Load current over time 

● Input voltage over time 

● Remaining buffer time 

 
  Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, 
to determine the expected buffer time, instead of the expected buffer current, the actually 
measured buffer current is used.  

 

● Battery temperature over time 

● Battery charge over time 

● Charge current over time 
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Procedure 

1. Select "Display > Trend diagram". 

2. Select "Base Unit" to display trend diagrams for SITOP UPS1600 values 

or 

select "Energy storage" to display trend diagrams for the energy storage device values. 

3 diagrams are available below both points. 

3. Click the appropriate button to display the required trend diagram. 

 

3.6.10 Determining the firmware version 
 

The firmware version of the SITOP UPS1600 can be determined as follows using the UPS 
Manager: 

Precondition 

The SITOP UPS1600 is connected to your PC via USB. 

Also possible for a connection via Ethernet with software version> V2.0 - and manager 
version > 4.60.1 
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Procedure 

1. Start the UPS Manager. 

2. Using the menu command "Display > Operating data > Base unit" the firmware version of 
the SITOP UPS1600 is displayed. 

 
In the example shown, firmware version V2.0.1 is installed on the SITOP UPS1600. 

3.6.11 Firmware update 
 

 WARNING 

The SITOP UPS1600 is reset while updating the firmware. For safety reasons, the output is 
switched off. 

Ensure that no damage is caused to the plant or system. 

Ensure that the PG/PC and/or all switches, routers and gateways that are used have an 
independent power supply during the firmware update. 

 



Engineering and remote access  
3.6 SITOP UPS Manager 

 SITOP UPS1600 / UPS1100 
134 Manual, 04.2017, A5E37775406-8-76 

 WARNING 

Firmware update with UPS-Manager 

If for the firmware update, the UPS Manager is used, please note that for a firmware update 
from version V2.1 to V2.2 or higher, then a UPS Manager with version V4.72 or higher must 
be used. This also applies to firmware updates from V2.2.0 to higher versions. 

 

 Note 

Install the current version of the SITOP UPS Managers, before you start the firmware 
update. It is possible that an older version (less than V4.5X) of the SITOP UPS Managers 
does not support this firmware update. The installation file for the SITOP UPS Manager is 
available at no charge on the SITOP home page (http://www.siemens.com/sitop) or directly 
(https://support.industry.siemens.com/cs/ww/en/view/75854607). 

 

 Note 

Do not switch-off the devices during the firmware update. 
 

The files for updating the firmware (firmware updates) are available online under 
(http://support.automation.siemens.com/WW/view/en/79207181). Different firmware updates 
are offered depending on the amp rating of the SITOP UPS1600. 

 

 Note 
Observe the compatibility of the firmware! 

Other firmware updates are not compatible. 

Determine the amp rating of your SITOP UPS1600 and download the appropriate firmware 
update. 

 

 Note 

It is not possible to downgrade the device firmware to a release with a version number lower 
than the firmware installed in the device itself. Information on how to read out the firmware 
release from the device is provided in Section Determining the firmware version (Page 132). 

 

 Note 
"Reset to Factory" function: 

All configuration parameters are reset to the default setting; 0.0.0.0 is used for the IP 
address. A new IP address must then be assigned, as otherwise there is no connection to 
the UPS Manager or TIA Portal. 

 

See also 
Display and visualization (Page 128) 

http://www.siemens.com/sitop
https://support.industry.siemens.com/cs/ww/en/view/75854607
http://support.automation.siemens.com/WW/view/en/79207181
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Preconditions 

● The SITOP UPS1600 has been correctly connected and linked with the system. 

● PG/PC with SITOP UPS Manager is connected with the system. 

Procedure 

1. Select "Display > Online functions". 

2. Select "Update firmware". 

3. To select the path to the directory with the unzipped files, click on the "Browse" button. 
In this directory, select the "ups10a.upd", "ups20a.upd" or "ups40a.upd" file. 

4. Click on the "Start" button. 
The firmware is updated. 

5. A message appears in the window area after the successful update. 

6. Manually restart the SITOP UPS1600 by interrupting the SITOP UPS1600 power supply. 
Restore the power supply to the SITOP UPS1600. 

The firmware update has been performed successfully. 

3.7 Web server 
The web server is used to monitor the SITOP UPS1600. It operates independently of 
UPS Manager and PROFINET access. 

New functions of the web server from V2.1 and higher: 

● Write access 

● User administration 

● Access via https 

3.7.1 Accessing the web server 
A Web browser is used for the access and operation. 

The following Web browsers are suitable: 

● Internet Explorer V8 (on MS Windows XP) 

● Internet Explorer V10 (on MS Windows 7) 

● Internet Explorer V11 (on MS Windows 7) 

● Mozilla Firefox from V40 (on MS Windows 7) 

● Google Chrome from V44 (on MS Windows 7) 
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Preconditions 
● The computer with installed web browser is connected with the SITOP UPS1600 via 

Ethernet. 

● The Web browser can display SVG graphics. From version V2.1 and higher, it is no 
longer necessary that SVG graphics are supported. 

If your web browser cannot display SVG graphics, then "Please install the SVG viewer for 
a correct display" message appears on the start screen. To permit the correct display, 
perform the following steps: 

– Download the SVG update at (http://www.savarese.com/software/svgplugin). 

– Install the SVG update. 

– If required, restart your computer. 

● The SITOP UPS1600 has an IP address that you know. 

● Web server access is activated. 

The following sections explain how to activate access to the web server: 

– For SIMATIC STEP 7 in the TIA Portal at Parameterizing the UPS1600 (Page 58). 

– For SIMATIC STEP 7 at Parameter assignment (Page 77). 

– Users without SIMATIC STEP 7, must proceed as follows (for software version 
V2.1.1): 

Device in the state when supplied: 

1. Turn both rotary coding switches into the REN and OFF positions. 
2. Switch the device off and on again. Please wait approximately 1 minute as a new 
certificate is created due to the IP address change.  
   The device can now be accessed via https://192.168.20.220. 
4. Login with name "admin" and password "admin". 
5. Under "HW Configuration -> General -> Web server -> Settings" the web server 
must be permanently activated. ("Activate web server on this module"). 
6. Under "HW Configuration -> General -> Communication interface", IP address, 
subnet mask and router address can be set. 
7. To transfer changes to the device, the "Download to device" button must be 
pressed.  
8. Now turn the rotary coding switches to the required position and switch the device 
off and on again. Please wait approximately 1 minute as a new certificate is created 
due to the IP address change. 
The device can now be accessed at the new IP address. 

If the IP address was already changed, then the state when originally shipped must be 
restored. You can do this, for example, using the Primary Setup Tool and function 
"Reset" under "Module" - or using the PRONETA tool and function "Reset network 
parameters". 

 

– Users without SIMATIC STEP 7, must proceed as follows (from software version 
V2.1.2 and higher): 

1. Turn both rotary coding switches into the REN and OFF positions. 
   The device is now accessible via https://192.168.20.220 (if the device was 

http://www.savarese.com/software/svgplugin
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previously in the state when originally shipped with IP address 0.0.0.0) – or using the 
already set IP address. Under certain circumstances you must wait approximately 1 
minute because a new certificate must be created due to the IP address change. 
3. Login with name "admin" and password "admin". 
4. Under "HW Configuration -> General -> Web server -> Settings" the web server 
must be permanently activated. ("Activate web server on this module"). 
5. Under "HW Configuration -> General -> Communication interface", IP address, 
subnet mask and router address can be set. 
6. To transfer changes to the device, the "Download to device" button must be 
pressed. Under certain circumstances you must wait approximately 1 minute because 
a new certificate must be created due to the IP address change. 
7. Now turn the rotary coding switches to the required position. 
The device can now be accessed at the previously set IP address or the new IP 
address. 

Procedure 
1. Connect the client (PG, PC) via the PROFINET interface with the CPU. 

2. Open the web browser. 
In the address dialog box of the web browser, enter the IP address of the 
SITOP UPS1600 in the form http://ww.xx.yy.zz (input example: http://192.168.0.14). 

The start page of SITOP UPS1600 is opened. You can navigate to further menus from the 
start page. 
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3.7.2 The web server user interface 

 
① Menu selection 
② Navigation submenus 
③ "License information" button 
④ "Logout" button 
⑤ Language selection 
⑥ "Download to device" button 
⑦ Editor area 

The menu selection ① allows you to access menus "Diagnostics" and "HW configuration" 
and the various submenus. The functions of the menus are described in the following 
sections. 

You access the submenus from the navigation submenus ②. 

The associated settings possible in the selected submenu are made in the editor area ⑦.  

You load the configuration to the devices by pressing button ⑥. 

The language selection ⑤ is used to select the user interface language of the web server. 
The German, English, French, Italian, Spanish, and Chinese languages are available. 

Click on the "Logout" ④ button to log out from the current web server session. The web 
server can only be accessed by logging in again. 

You can download the license information of the UPS1600 system using the "License 
information" ③ button. 
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Grayed out menus 
If the SITOP UPS1600 was assigned a SIMATIC S7 control as I/O device, or the 
SITOP UPS Manager is connected to the SITOP UPS1600, then the web server is in the 
read-only mode. The following applies in the read-only mode: 

● No write access is possible; the parameter settings can only be read (input values shown 
in gray, valid for software version up to V2.0) 

● Firmware cannot be updated, the item is hidden. 

3.7.3 Functions of the web server 
The functions of the web server are split up between the two menus "Diagnostics" and "HW 
Configuration".  

Use the "Download to device" function to load changes that you have made to the device, 
see Loading the configuration (Page 141). 

Diagnostics 
You can find the following submenus here: 

● Alarms: 
For an overview of past and active alarms, see Alarm monitoring (Page 141). 

● Operating data: 
For an overview of the operating data, see View the data of the SITOP UPS1600 (basic 
device) (Page 143) and Viewing the energy storage data (Page 144) 

● Online functions with the options: 

– Firmware update 

– Reset to factory setting 

For the online functions, see Online functions (Page 145). 

HW configuration 
Here, in the following areas you can make changes: 

● Configuring the PROFINET interface, see General (Page 146) 

● Changing the web server settings, see Web server (Page 148) 

● Configuring the OPC UA interface, see OPC UA server (Page 149). 

● Making PN security settings, see Improved PN security (Page 151). 

● Managing users, see User administration (Page 151). 

● Configuring basic devices and energy storage devices, see Device configuration 
(Page 153) 

You can save the configurations and load the existing configurations into the device, see 
Load / Save (Page 157). 
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3.7.4 Determining the firmware version 
The firmware version of the SITOP UPS1600 can be determined as follows via Ethernet 
using the web server: 

Using the menu command "Diagnostics > Operating data > Base unit" the firmware version 
of the SITOP UPS1600 is displayed. 

 
In the example shown, firmware version V2.2.0 is installed on the SITOP UPS1600. 

3.7.5 Firmware update with web server 

Precondition 
● The SITOP UPS1600 has been correctly connected and linked with the system. 

● PG/PC with the actual web browser is connected to the system and is logged on. 
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 Note 

Administrator rights for the web server are required in order to update the firmware. 
 

Procedure 
1.  Select "Diagnostics > Online function > Firmware update" 

2. Click on button "Select file". Select the appropriate update file. 

3. Click on button "Run update". 

Firmware update starts. 

A message is displayed after the successful update. 

4. Manually restart the SITOP UPS1600 by interrupting the SITOP UPS1600 power supply. 

5. Reconnect the SITOP UPS1600 power supply. 

The firmware update has been performed successfully. 

3.7.6 Loading the configuration 

 
You can download the actual configuration from the web server directly to the device using 
the "Download to device" button. 

Procedure for saving the configuration 

1. Click on the "OK" button to load the configuration. 

2. Acknowledge the confirmation prompt. 

3.7.7 Diagnostics 

3.7.7.1 Alarm monitoring 
You can use the web server to obtain information about active alarms and the history of the 
alarms. Every alarm that concerns the SITOP UPS1600 and the connected battery modules 
is recorded. You can display active alarms using "Diagnostics > Alarms > Pending alarms". 
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Pending alarms 
The currently pending system alarms are provided in this list. 

 

Displaying the alarm history 
1. Select menu "Diagnostics". 

2. Select the "Alarm history" entry under "Alarms" in the navigation. 

The alarm history is displayed in a tabular form. 

 
The individual columns contain the following information: 

● Name: A descriptive name of the alarm 

● Date and time: The time and date when the alarm comes and goes 

● Incoming/outgoing: 

– incoming: Occurrence of the alarm event 

– outgoing: Rectification of the alarm event 

 

 Note 
The alarm history is displayed only when no further communications relationships to the 
SITOP UPS1600 have been established. 

Examples for further communications relationships are communication relationships via 
STEP 7 or the SITOP UPS Manager. 
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3.7.7.2 View the data of the SITOP UPS1600 (basic device) 

 
1. Select menu "Diagnostics" 

2. Select the "Base unit" entry under "Operating data" in the navigation. 

Here, you can find the following information: 

● Data of the SITOP UPS1600: 

– Order number 

– Serial number 

– SW version 

– HW product version 

● Operating mode (normal or buffer mode) 

● Ready for buffering 
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● Remaining buffer time 

 
  Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, 
to determine the expected buffer time, instead of the expected buffer current, the actually 
measured buffer current is used.  

 

● Current input voltage 

● Output voltage 

● Load current 

3.7.7.3 Viewing the energy storage data 

 
Figure 3-3 Diagnostics energy storage devices 

1. Select menu "Diagnostics" 

2. Select the "Energy storage" entry under "Operating data" in the navigation. 

Here, you can find the following information about the connected energy storage devices:  

● Order number 

● Serial number 

● SW version 

● HW product version 

● Battery charge level 

● Battery temperature 

● Measured charge current 

● Battery voltage 



 Engineering and remote access 
 3.7 Web server 

SITOP UPS1600 / UPS1100 
Manual, 04.2017, A5E37775406-8-76 145 

3.7.7.4 Online functions 

Firmware update 

 
The firmware update process is described in detail in the "Firmware update readme", which 
is provided with the firmware update download package.  

Follow the instructions provided there carefully. The files for updating the firmware are 
available online at: (https://support.industry.siemens.com/cs/ww/en/view/79207181) 

Refer also to Section Firmware update with web server (Page 140). 

Reset to factory settings 

 
A reset to the factory settings deletes all hardware and software configurations stored in the 
SITOP UPS1600 and restores the factory settings.  

https://support.industry.siemens.com/cs/ww/en/view/79207181
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This affects, for example: 

● IP address 

● Device name 

● Parameter values for the SITOP UPS1600 and assigned supplementary modules. 

● "Web server activated" setting. Web server is de-activated. 

Procedure 

1. Select menu "Diagnostics". 

2. Select submenu "Online functions". 

3. Select entry "Reset to factory setting". 

4. In the editor area, click on "Reset to factory settings". 

5. Acknowledge the confirmation prompt with "OK". 

3.7.8 HW configuration 

3.7.8.1 General 
You have the following options under menu item "HW Configuration > General": 

● Configuring the PROFINET interface 

● Making settings for the web server 

● Making settings for the OPC UA server 

● Making settings for the NTP client 

● Making settings for PROFINET security 

● Managing users 
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PROFINET interface 

 
You have the option of configuring the PROFINET interface regarding the following points: 

● General I&M (identification & maintenance) 

– Defining the location ID 

– Defining the contact 

– Defining the device name 

● Defining whether the IP address is dynamically assigned (activate DHCP) or whether it 
should be fixed. 

Procedure 

1. Select the "Hardware configuration" menu. 

2. Select submenu "General". 

3. Select the "Communication interface" entry. 

4. In the editor area, under "Device name" enter the required device name. 

5. To dynamically assign the IP address: Activate checkbox "Source IP address via DHCP". 
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6. To assign a fixed IP address: Activate checkbox "Fixed IP address" and enter the 
appropriate parameters in the editor area. 

7. Load the data to the device, see Loading the configuration (Page 141). 

3.7.8.2 Web server 
Here, you can make general settings and define which actions should be automatically 
executed. 

Settings 

 
 
Parameters Value range Default setting 
Activate web server on this module Yes/no No 
Permit access only with HTTPS Yes/no Yes 
Log off automatically after 15 minutes Yes/no No 
Update interval 0 / 5 s / 10 s / 20 s / 30 

s / 60 s 
0 = no automatic up-
date 

● Activate web server on this module 

Define as to whether the device may be accessed via the web server. 

● Permit access only with HTTPS 

Define whether access is only permissible via HTTPS. 
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● Download certificate 

You can download the certificate for encrypted connection via HTTPS by pressing the 
"Download certificate" button. 

● Log off automatically after 15 minutes 

Define whether a user should be automatically logged off after closing the web server. 

● Update interval 

Define the interval in which the actual values are sent to the web server. 

3.7.8.3 OPC UA server 
Here, you configure the OPC UA server. 

Settings 
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General 
● OPC UA server activated 

Define as to whether device can be accessed via the OPC UA interface. If the option is 
activated, then the SITOP PSU8600 acts as OPC UA server. 

● Unencrypted access activated 

If the option is activated, then unencrypted access via the OPC UA client is possible. 
Activating the option is not recommended. 

● OPC UA server port 

The preset port number is 4840. You can enter another port number. 

3.7.8.4 NTP client 
You configure the NTP client under "HW configuration > General > OPC UA server > 
Settings". 

 
If the NTP client is activated, then the local time is synchronized with the specified time of 
the specified NTP server. 

The NTP update interval is automatically and dynamically adapted between 64 seconds and 
68 minutes 16 seconds. 
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The time of the last synchronization and the next scheduled synchronization are displayed. 

● NTP client activated 

Here, activate the NTP client. 

● NTP server address 1 … 4 

Enter up to 4 IP addresses of NTP servers. 

3.7.8.5 Improved PN security 

Settings 

 
Activate these options in order to protect the system against changes initiated externally. 

● AR configuration locked 

● DCP write protection activated 

3.7.8.6 User administration 
You can access user administration under "HW configuration > General >Improved PN 
security > User administration ". 
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User administration 
Here, you can change the administrator password and set up the system so that guests can 
access the system - and up to 14 additional user accounts with different authorization levels. 

 

Procedure for changing the administrator password 
 

 Note 

Users "admin" and "guest" are preset and cannot be deleted. 
 

1. Select the "Hardware configuration" menu. 

2. Select submenu "General > Improved PN security". 

3. Select entry "User administration". 

4. Enter the new password in the editor area, in line "admin" under "Password". 

 
  Note 

The password must satisfy the following minimum requirements: 
• min. 8 characters 
• min. 1 uppercase letter 
• min. 1 lowercase letter 
• min. 1 digit 
• min. 1 special character 

The following characters are possible: ^[a-z0-9A-Z\\-_]+$ 
 

5. Enter the new password again under "Confirm password". 

6. Load the data to the device, see Loading the configuration (Page 141). 
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 Note 

For security reasons, when installing for the first time, the default password should be 
changed. Further, it is recommended that passwords are regularly changed. 

 

Procedure for setting up a guest access 

1. Select the "Hardware configuration" menu. 

2. Select submenu "General > Improved PN security". 

3. Select entry "User administration". 

4. Enter a password in the editor area under "guest" and select the individual access rights 
for guest access. 

5. Enter the password again under "Confirm password". 

6. Load the data to the device. 

Procedure for setting up a user account  

1. Select the "Hardware configuration" menu. 

2. Select submenu "General > Improved PN security". 

3. Select entry "User administration". 

4. In the editor area, click on "Add new user" and in this line enter the name for the new 
user. 

5. Select the individual access rights for the new user. 

6. Enter a password for the new user - and repeat this to confirm the password. 

7. Load the data to the device. 

3.7.8.7 Device configuration 
You set the parameters for basic devices and energy storage devices under menu item "HW 
Configuration > Device configuration". 
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Basic device configuration 

 

"Buffering" parameters 
 
Parameter Value range Initial value 
Connection threshold 21 - 25 V 22.5 V 
Buffer time 1 - 32767 s 600 s 
Maximum buffer time 1) Yes / No No 
Additional buffer time after PC shutdown. 3) 1 - 300 s 60 s 
Expected buffer current 1) 0 - 40 A 0 A 
Reset time:  5 s 
Enable reset after buffering Yes / No No 
 1) Parameter only available from SW version V2.0 and higher 

2) Parameter only available from SW version V2.1 and higher 
3) Valid from V2.0.4 or V2.1 
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● Switch-in threshold 
Setting the switch-in threshold. 

● Buffer time 
Length of time during which the system should be buffered by the SITOP UPS1600. 

● Maximum buffer time 

The setting means that buffering is realized for as long as possible. The device only shuts 
down when the battery has discharged down to the defined stop buffering voltage. The 
value entered for the "Buffer time" parameter is not relevant in this case.  

● Additional buffer time after PC shutdown 
Time during which the system should be buffered by the SITOP UPS1600 after the PC 
was shut down. 

● Expected buffer current 

Load current, which is expected at the device output during buffer operation. Please 
adjust the correct application load current required. For current settings between 0 A and 
rated current, the display in the diagram "Remaining buffer time" is adapted. 

If a value of 0 A is entered, then for this parameter, the average value of the actual load 
current measured at the output over the last 10 min is assumed. The value of this 
parameter is used when calculating the remaining buffer time. The entered value may not 
exceed the rated device current. 

 
  Note 

From the instant in time when the SITOP UPS1600 is switched over into the buffer mode, 
to determine the expected buffer time, instead of the expected buffer current, the actually 
measured buffer current is used.  

 

● Enable reset after buffering 
If the value is set to "Yes" then the output voltage is interrupted after the selected buffer 
time expires if, in the meantime, the input voltage returns. This option is useful, when, for 
example, computer networks are protected by the UPS that can be activated by a reset 
when the power supply is restored. For buffer time "MAX", the output voltage is not 
interrupted. 

"Signaling" parameter 
 
Parameter Value range Default setting 
Downtime alarm 0 - 20,000 ms 100 ms 
Wait time for stable input voltage 0.2 - 65 s 1 s 

● Downtime alarm 
The time in which no alarm is issued to the system although it is buffered. 

● Wait time for a stable input voltage 
Time where the input voltage must continually lie above the connection threshold so that 
buffering is exited and a transition is made into normal operation. 
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"Maintenance" 
 
Parameter Value range Default setting 
R test interval 1 … 65535 h 4 h 

R test: The battery state is determined by subjecting it to a cyclic load. 

Energy storage device configuration 

 
"Energy storage" has two different areas that depend on the battery type being used. First 
select whether you are using a SITOP UPS1100 battery module or some other energy 
storage. 

Using a SITOP UPS1100 battery module 

No additional parameterization. 

Using a different battery module 
 
Parameter Value range Default setting 
Battery capacity 0.1 - 3,200 Ah 10 Ah 
End-of-charge voltage 24 - 30 V 27.3 V 
Charge current 0.001 - 3 or 4 or 5 A 0.3 A 
Faulty battery voltage 1 - 18 V 6 V 

● Battery capacity 

Total capacity of the installed batteries. 

● End-of-charge voltage 
Maximum voltage up to which the battery may be charged. 

● Charge current 
The battery is not charged with more than the selected charge current. The 
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manufacturer's details for the permitted battery charge current must be observed. 
Further, the following, device-dependent values apply: 

– SITOP UPS1600 10 A: Maximum permissible charge current 3,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 2,000 mA 

– SITOP UPS1600 20 A: Maximum permissible charge current 4,000 mA 
Derating for Tu > 40 °C or Uin  < 24 V: 3,000 mA 

– SITOP UPS1600 40 A: Maximum permissible charge current 5,000 mA 
Derating for Tu > 40 °C or Uin < 24 V: 3,000 mA 

Faulty battery voltage 
If the battery voltage falls below this value, it is considered as being faulty by the 
SITOP UPS1600 and is not charged. 

3.7.8.8 Load / Save 
Configurations made in the web server can be saved as zip file. Saved configurations can be 
loaded back to the web server. 

 

Procedure for saving the configuration 

1. Select the "Hardware configuration" menu. 

2. Select submenu "Load/Save". 

3. The zip file now displayed can be saved as a file using the "Save target as" function of 
the shortcut menu (call by pressing the right-hand mouse key). 

4. Enter a file name. 

5. Click on "OK" to save the configuration as zip file. 

 

Procedure for loading the configuration 

1. Select the "Hardware configuration" menu. 

2. Select submenu "Load/Save". 
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3. In the editor area, click on "Browse", and in the file dialog, select the path where the 
configuration file should be saved. 

4. Click on the "OK" button to load the configuration. 

3.8 OPC UA server 

3.8.1 Introduction 
OPC UA (Open Platform Communications - Unified Architecture) for non-proprietary 
communication in automation systems. 

You can find information in the Internet at opcfoundation.org 
(https://opcfoundation.org/about/opc-technologies/opc-ua/). 

3.8.2 Preconditions 
 

 Note 
Example of an installation 

Using "UaExpert" as example, this section describes how, using a client, you access 
SITOP UPS1600 data. 

 

● UaExpert V1.4.4 is installed. 

The OPC UA client for Microsoft Windows can be downloaded from the Internet site of 
Unified Automation: 

https://www.unified-automation.com/downloads/opc-ua-clients.html (https://www.unified-
automation.com/downloads/opc-ua-clients.html) 

● Main module SITOP UPS1600 operates with firmware version v2.2.0 or higher. 

● The IP address of SITOP UPS1600 is configured. 

● The OPC UA server of the SITOP UPS1600 is activated. 

 

 Note 

For OPC UA, every device is assigned a profile, which describes the capability of the 
particular device. 

The OPC UA server of the SITOP UPS1600 corresponds to the "Micro Embedded Device 
Server" profile. 

 

https://opcfoundation.org/about/opc-technologies/opc-ua/
https://www.unified-automation.com/downloads/opc-ua-clients.html
https://www.unified-automation.com/downloads/opc-ua-clients.html
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 Note 

Additional information on the OPC UA client is provided in the online documentation in menu 
"Help > UaExpert Manual". 

 

3.8.3 Activating the OPC UA server via the SITOP UPS1600 web server 

Start the web server of the SITOP UPS1600 in the MANUAL mode 
 

 Note 

The MANUAL mode permits read access operations and restricted write access operations. 

Preconditions: 
• The settings of the SITOP UPS1600 correspond to the factory settings ("out-of-the-box"). 
• The SITOP UPS1600 web server is activated, see "Accessing the web server 

(Page 135)". 
• The required IP address is already configured, see "Functions of the web server 

(Page 139)". 
 

Changing the IP address 
1. Navigate to "HW configuration > General > Communication interface". 

2. Activate "Fixed IP address" 

3. Under "Fixed IP address" enter the preferred IP address and the subnet mask. 

4. Click on "Download to device". 

 
  Note 

New IP address is immediately activated. 

The connection to the web server is immediately interrupted. 
 

5. Wait at least 2 minutes. 

6. In the web browser, call the web server again by entering the new IP address. 
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7. On the web server homepage, select "Login". 

8. As login, enter admin - and as password, also admin. 

 
  Note 

For security reasons, the default password should be immediately changed. Further, it is 
recommended that passwords are regularly changed. The password must satisfy the 
following minimum requirements: 
• min. 8 characters 
• min. 1 uppercase letter 
• min. 1 lowercase letter 
• min. 1 digit 
• min. 1 special character 

The following characters are possible: ^[a-z0-9A-Z\\-_]+$ 
 

Activating the OPC-UA server and starting the web server for REMOTE operation 
1. Navigate to "HW Configuration > General > OPC UA server > Settings". 

2. Activate option "OPC UA server activated". 

3. Click on "Download to device". 

The OPC UA server is activated. 

3.8.4 Establishing a connection to the OPC UA server of the SITOP UPS1600 
 

 Note 

The "Ua Expert" program is displayed in English. 
 

1. Launch the "Ua Expert" program. 

2. In the main menu, select "Server > Add". 

 
3. In the "Add Server" dialog box, click on "Double click to Add Server …". 
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4. In dialog "Enter Url", enter the protocol being used, the IP address of the 
SITOP UPS1600 and the number of ports. 

 
The preset port number for OPC UA is 4840. 

Another port number can be set using the web server, PROFINET or OPC UA. 

5. In dialog "Add Server" in area "Authentication Settings", enter the logon information for 
the SITOP UPS1600. 

6. Click on the newly created server link "opc.tcp:\\…". 
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7. Select the connection type and enter the appropriate login data. 

For security reasons we recommend using an encrypted connection type 
(Basic128Rsa15 or Basic256). 

 
Default Username: admin 

Default password: admin 

8. Select SITOP UPS1600 in the project tree. 

9. Click on symbol "Connect Server". 

 
In area "Address Space", the data objects available for the SITOP UPS1600 are shown in a 
tree structure. 
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3.8.5 Working with the OPC UA client 

3.8.5.1 Displaying SITOP UPS1600 parameters 

Browse nodes - display parameters 
Input and output data – as well as the operating states of the SITOP UPS1600 – are 
displayed in area "Address Space" in a tree-like structure as nodes. The properties of a 
marked node are displayed in area "Attributes". 

 

Subscribe to a node 
The actual values of a subscribed node are permanently displayed in area "Data Access 
View". 

To subscribe to a node, drag the appropriate node from area "Address Space" - and drop 
into area "Data Access View". 
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A subscription can only be made to nodes of NodeClass "Variable" . 

3.8.5.2 Changing the value of a node 
Write access operations to values are not permitted in order to avoid making undesirable 
changes. 

Write access is made possible by calling method "InitLock". After 10 seconds, access is 
automatically blocked again. 

Permitting write access 
 

 Note 
Write access only for devices with PROFINET interface 

Write access via OPC UA is not supported by devices with USB interface (... - 1AY0). 
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1. In the "Address Space" select <Root> → <Objects> → <DeviceSet> → <UPS1600> → 
<Lock> → <InitLock>. 

2. Right click on method "InitLock" and in the shortcut menu, select "Call …". 

 
3. In the "Call InitLock" dialog box, click on "Call". 

 
Figure 3-4 "Call InitLock on Lock" dialog 
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3.8.5.3 Calling a method 

Calling a method from the "MethodSet" 
The call is described using example "SynchronizeSystem". 

 

 Note 

Methods are shown in the UA client with the symbol . 
 

1. In "Address Space" select <Root> → <Objects> → <DeviceSet> → <UPS1600> → 
<MethodSet> → <SynchronizeSystem>. 

2. Right click on method "SynchronizeSystem" and in the shortcut menu, select "Call …". 

 
The result of the method call is displayed in a dialog. 
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3.8.6 SITOP UPS1600 parameters in the OPC UA client 

3.8.6.1 Introduction 
The OPC UA client uses the following symbols: 
 

 
Object 

 Object (supported modules) 

 Method 

 Variable with other attributes (EURange, EngineeringUnits, EnumStrings) 

 Variable 

Information on the selected object is displayed in area "Attributes". Relationships to other 
objects are displayed in area "References". 

A dialog is displayed when calling a method. "InputArguments" and "OutputArguments" can 
be entered here. 

Values that can be changed (e.g. IP addresses or path data) can be directly edited in area 
"Attributes". 

3.8.6.2 ActualBatteryState 
 
Display name Data type Definition Description 
BatteryChange 
Recommended 

Boolean PropertyType Battery capacity is insufficient to achieve the specified buffer 
time. 

BatteryCharge Byte AnalogItemType Battery charge level in percent 
BatteryChargeVoltage Float AnalogItemType Voltage used to charge battery during the constant charging 

phase. 
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Display name Data type Definition Description 
BatteryConnection 
Fault 

Boolean PropertyType The connection to the battery has been interrupted or has a 
high impedance. 

BatteryCount Byte PropertyType Number of connected batteries. Only coded batteries are 
counted. 

BatteryVoltage Float AnalogItemType Current battery voltage 

3.8.6.3 ActualBufferState 
 
Display name Data type Definition Description 
BufferMode Enumeration MultiState 

DiscreteType 
Indicates buffer mode 

BufferReady Boolean PropertyType Sufficient buffer readiness 
BufferRemainingTime UInt32 AnalogItemType Estimated remaining buffer time. The remaining buffer time 

is calculated using the current battery charge level and 
average current over 10 minutes. 

3.8.6.4 ActualChargingState 
 
Display name Data type Definition Description 
ChargeMeasured 
Current 

Float AnalogItemType Measured battery charge current 

ChargeSufficient Boolean PropertyType When this flag is set, the required charge level has been 
achieved 

3.8.6.5 ActualState 
 
Display name Data type Definition Description 
DeviceAlarmLed Object Sitop_1600_ 

LedType 
Status of LED "Alarm" 

DeviceBatteryFaultLed Object Sitop_1600_ 
LedType 

Status of LED "BatteryFault" 

DeviceBattery 
Over85Led 

Object Sitop_1600_ 
LedType 

Status of LED "BatteryOver85" 

DeviceCalculated 
Capacity 

Float AnalogItemType Available battery capacity 

DeviceCalculated 
Health 

Byte AnalogItemType State of health (SoS) as percentage of the rated capacity 

DeviceInputCurrent Float AnalogItemType Measured input current of SITOP UPS1600 
DeviceInputVoltage Float AnalogItemType Input voltage 
DeviceInputVoltageOK Boolean PropertyType Input voltage has exceeded the configured threshold volt-

age. Connected devices are powered with the input supply. 
DeviceLoadCurrent Float AnalogItemType Measured output current of SITOP UPS1600 
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Display name Data type Definition Description 
DeviceMaxCurrent Float AnalogItemType Maximum output current supported by the SITOP UPS1600 
DeviceOutputCurrent Float AnalogItemType Measured output current of SITOP UPS1600 
DeviceOutputVoltage Float AnalogItemType Maximum output voltage 
DeviceP1LinkLed Object Sitop_1600_ 

LedType 
Status of LED "P1" 

DeviceP2LinkLed Object Sitop_1600_ 
LedType 

Status of LED "P2" 

DeviceRunLed Object Sitop_1600_ 
LedType 

Status of LED "RUN" 

DeviceSFLed Object Sitop_1600_ 
LedType 

Status of LED "SF" 

DeviceSWSettings 
Valid 

Boolean PropertyType This object provides information about whether the SW 
parameters or the parameters at the rotary switches are 
used. The desired setting is selected on rotating switch for 
threshold voltage. 

DeviceStateLed Object Sitop_1600_ 
LedType 

Status of LED "OK": Device status 

DeviceTemperature Sbyte AnalogItemType Device temperature 
DeviceTotalOperating 
Time 

UInt32 AnalogItemType Battery-specific data: Total time for which battery was in 
buffer mode during its service life 

3.8.6.6 ActualUpdateState 
 
Display name Data type Definition Description 
UpdateProgress Integer PropertyType Update progress 
UpdateState Enumeration MultiState 

DiscreteType 
Update status 

3.8.6.7 Alarm 
 
Display name Data type Definition Description 
AlarmBattery 
ConnectionBroken 

Boolean PropertyType Connection to battery interrupted - check connection and 
fuse 

AlarmBattery 
ConnectionHigh 
Resistive 

Boolean PropertyType High-resistance connection to battery - check battery power 
cable 

AlarmBatteryDeep 
Discharge 

Boolean PropertyType Battery is deep discharged - no buffering possible 

AlarmBatteryDeep 
DischargeNoCharging 
Possible 

Boolean PropertyType Battery is deep discharged - replace battery 

AlarmBatteryDefekt Boolean PropertyType Battery defective - check fuse and battery voltages 
AlarmBatterySOHTest Boolean PropertyType Battery 'state of health' (SOH) tests are in progress 



 Engineering and remote access 
 3.8 OPC UA server 

SITOP UPS1600 / UPS1100 
Manual, 04.2017, A5E37775406-8-76 171 

Display name Data type Definition Description 
AlarmBatteryTest Boolean PropertyType Battery 'state of health' (SOH) tests are in progress. Output 

of SITOP UPS1600 is connected to the battery to detect the 
actual capacity of the battery. 

AlarmBufferMode 
NotPossible 

Boolean PropertyType Buffer mode not possible - check settings, cabling, fuse, and 
battery voltages 

AlarmBuffer 
TimerReset 

Boolean PropertyType PC is shutting down 

AlarmBuffering Boolean PropertyType Device is in buffer mode 
AlarmCommunication 
ToDeviceFailed 

Boolean PropertyType PROFINET connection available - SITOP UPS1600 is de-
fective 

AlarmDevice 
Failure 

Boolean PropertyType Device failure 

AlarmDevice 
Overtemperature 

Boolean PropertyType Output and battery charging is switched off to prevent dam-
age to the device. 

AlarmDevice 
ParameterCorrupt 

Boolean PropertyType SITOP UPS1600 parameters corrupt - try to update the 
software 

AlarmDevice 
PoweredUp 

Boolean PropertyType Device powered up 

AlarmDevice 
TemperatureHigh 

Boolean PropertyType Device temperature is very high! Provide cooling or turn off 
unnecessary consumers. 

AlarmDevice 
TemperatureLow 

Boolean PropertyType Device temperature is very low. Care for higher ambient 
temperature. 

AlarmDevice 
TurnedOff 

Boolean PropertyType SITOP UPS1600 off - buffer time exceeded or PC was shut 
down 

AlarmFirmware 
UpdateOK 

Boolean PropertyType Previous software update was successful - SITOP UPS1600 
is operational again. 

AlarmFuseBroken Boolean PropertyType Fuse is defective. 
AlarmInpu 
tVoltageHigh 

Boolean PropertyType Input voltage exceeds 30 V. SITOP UPS1600 is not opera-
tional. 

Alarm 
InsufficientCharge 

Boolean PropertyType Set buffer time can currently not be achieved due to low 
battery charge. 

AlarmLow 
VoltageMode 

Boolean PropertyType Input voltage of SITOP UPS1600 is too low. 
SITOP UPS1600 Buffer is not ready for buffering. 

AlarmOutputTurnedOff Boolean PropertyType Output of SITOP UPS1600 has been switched off due to the 
execution of a command or because an error situation has 
occurred (e.g. temperature or output current too high). 

AlarmOutputTurnedOn Boolean PropertyType Output of SITOP UPS1600 has been switched on again due 
to the execution of a command or because an error situation 
has been remedied. 

AlarmOverCurrent Boolean PropertyType Output current of SITOP UPS1600 is too high. Output will 
be switched off for 20s. The output will be switched on again 
after 20 s. 

AlarmResetExecuted Boolean PropertyType Input voltage to SITOP UPS1600 was OK again before the 
buffer time expired. Connected devices are reset by switch-
ing off the SITOP UPS1600 outputs for the configured time. 

AlarmSurplusBattery Boolean PropertyType More than 6 batteries are connected. Connect only up to 6 
batteries at the Energy Storage Link. 
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Display name Data type Definition Description 
AlarmUnknownBattery Boolean PropertyType Data from the battery cannot be read correctly. Battery is  

defective or not supported by SIEMENS. 
AlarmWrongBattery 
Configuration 

Boolean PropertyType Different battery types connected. Only batteries of the 
same type can be operated together. 

AlarmWrongBattery 
Polarity 

Boolean PropertyType Wrong battery polarity - check battery connections. 

3.8.6.8 Battery 
 
Display name Data type Definition Description 
BatteryCapacity 
Setpoint 

Float AnalogItemType Total battery capacity in Ah 

BatteryDefectVoltage 
Setpoint 

Float AnalogItemType If battery voltage is lower than this value, the battery is con-
sidered defective 

BatteryIgnoreCoding 
Setpoint 

Boolean PropertyType When this parameter is set to '1', data from the coded bat-
tery is ignored. The data is taken from the parameter as-
signment in this case. 

3.8.6.9 Buffering 
 
Display name Data type Definition Description 
BufferExpected 
CurrentSetpoint 

Float AnalogItemType Estimated average output current during buffer mode 

BufferThreshold 
Setpoint 

Float PropertyType Trigger voltage for buffering - buffering is activated below 
this value 

BufferTime2Setpoint UInt16 AnalogItemType Additional buffer time after PC shutdown (valid only in con-
junction with SITOP UPS Manager) 

BufferTimeSetpoint UInt16 AnalogItemType Desired buffering time before device switches off 
BufferingEnableSet-
point 

Boolean PropertyType Enable buffering 

BufferingEndVoltage 
Setpoint 

Float AnalogItemType When battery voltage is lower than this voltage, the battery 
charge is no longer sufficient. Buffering is stopped. 

BufferingValid 
SupplyVoltage 
TimeSetpoint 

Float AnalogItemType When the SITOP UPS1600 is in buffer mode, time for which 
the input voltage must be OK again before SITOP UPS1600 
buffering is stopped and connected devices are operated 
again with input supply. 



 Engineering and remote access 
 3.8 OPC UA server 

SITOP UPS1600 / UPS1100 
Manual, 04.2017, A5E37775406-8-76 173 

3.8.6.10 Charging 
 
Display name Data type Definition Description 
ChargingCurrent 
Setpoint 

Float AnalogItemType Charge current 

ChargeEndVoltage 
Setpoint 

Float AnalogItemType Battery voltage when charging changes to trickle charging. 
Battery is charged 100 %. 

3.8.6.11 General 
 
Display name Data type Definition Description 
AlarmInvalidSupply 
VoltageTimeSetpoint 

Float AnalogItemType Alarm filter: an alarm is only sent if it is pending for longer 
than the configured time 

DeviceOutputEnable 
Setpoint 

Boolean PropertyType DeviceOutputEnableSetpoint 

ResetEnableSetpoint Boolean PropertyType When input voltage returns during buffering, the output is 
switched off for a configurable time in order to reset con-
nected devices  

ResetTimerSetpoint Byte AnalogItemType Time for which the output of SITOP UPS1600 is switched off 
when connected devices are reset. 

ResistorTestInterval 
Setpoint 

Byte AnalogItemType Battery test interval 

3.8.6.12 Hardware 
 
Display name Data type Definition Description 
HardwareBattery 
ProfileClamp 

Enumeration MultiState 
DiscreteType 

The charge characteristic for batteries on signal terminals is 
set. This setting is only applied if hardware settings are 
effective. 

HardwareBuffer 
ThresholdSwitch 

Enumeration MultiState 
DiscreteType 

Trigger voltage for buffering - buffering is activated below 
this value 

HardwareBuffer 
TimeSwitch 

Enumeration MultiState 
DiscreteType 

Desired buffering time before device switches off 

HardwareBuffering 
EnableClamp 

Boolean PropertyType Enable buffering 

HardwareEnable 
ResetClamp 

Boolean PropertyType When input voltage returns during buffering, the output is 
switched off for a configurable time in order to reset con-
nected devices  

HardwareStartFrom 
BatteryClamp 

Boolean PropertyType Setting for 'Start from battery' on signal terminal 
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3.8.6.13 Identification 
 
Display name Data type Definition Description 
IdentificationContact 
Setpoint 

String[64] PropertyType Contact  

IdentificationDevice 
NameSetpoint 

String[32] PropertyType PROFINET device name 

IdentificationLocation 
Setpoint 

String[44] PropertyType Location ID 

3.8.6.14 Lock 
 
Display name Data type Definition Description 
BreakLock Method Method  
ExitLock Method Method  
InitLock Method Method  
Locked Boolean PropertyType Locked 
LockingClient String[16] PropertyType LockingClient 
LockingUser Unsigned PropertyType LockingUser 
RemainingLockTime Duration PropertyType RemainingLockingTime 
RenewLock Method Method  

3.8.6.15 MethodSet 
 
Display name Data type Definition Description 
AddUser Method Method Adds a user. 
ChangeUserPassword Method Method Changes a user password. 
ClearAlarmHistory Method Method Deletes the alarm history. 
DeleteUser Method Method Removes a user. 
DownloadDevice 
Configuration 

Method Method Downloads the device configuration. 

RemoteReset Method Method Executes a remote reset. 
RemoteReset2 Method Method Executes a remote reset. 
ResetSystem Method Method Resets the system to the initial state. 
ResetToFactory 
Settings 

Method Method Reset to factory settings. 

SetNetworkParameter Method Method Sets the network parameters. 
ShowAlarmHistory Method Method Shows the alarm history. 
ShowPending 
AlarmList 

Method Method Shows the list of active alarms. 

UpdateFirmware Method Method Updates the firmware. 
UploadAlarmHistory Method Method Uploads the alarm history. 
UploadCertificate Method Method Uploads a certificate. 
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Display name Data type Definition Description 
UploadDevice 
Configuration 

Method Method Uploads the device configuration. 

UploadLicence 
Information 

Method Method Uploads license information. 

UploadPendingAlarm 
List 

Method Method Uploads the list of active alarms. 

3.8.6.16 Network 
 
Display name Data type Definition Description 
NetworkDHCPEnable Boolean PropertyType DHCP enable 
NetworkGateway String[16] PropertyType Router address 
NetworkIP String[16] PropertyType IP address 
NetworkSubnetmask String[16] PropertyType Subnet mask 

3.8.6.17 NTP 
 
Display name Data type Definition Description 
NTPEnableSetpoint Boolean PropertyType NTP client activated 
NTPServer1Setpoint String PropertyType NTP server address 1 
NTPServer2Setpoint String PropertyType NTP server address 2 
NTPServer3Setpoint String PropertyType NTP server address 3 
NTPServer4Setpoint String PropertyType NTP server address 4 
NTPUpdateIntervall 
Setpoint 

UInt32 AnalogItemType  

NTP client status 
 
Display name Data type Definition Description 
NTPLastSynchronisa-
tionTime 1) 

 PropertyType Last synchronization instant 

NTPNextSynchronisa-
tionTime 1) 

 PropertyType Next synchronization instant 

 1) read only 
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3.8.6.18 OPC UA 
 
Display name Data type Definition Description 
OPCUAServerEnable 
Setpoint 

Boolean PropertyType OPC UA server activated 

OPCUAServerPort 
Setpoint 

Integer PropertyType OPC UA server port 

OPCUAUnencrypted 
AccessEnable 
Setpoint 

Boolean PropertyType Unencrypted access activated 

3.8.6.19 ParameterSet 
 /  

All variables of the SITOP UPS1600 are listed together under the "ParameterSet" node. 

3.8.6.20 PROFINET 
 
Display name Data type Definition Description 
PNARSetupLocked 
Setpoint 

Boolean PropertyType AR configuration locked 

PNDCPReadonly 
EnableSetpoint 

Boolean PropertyType ODCP write protection activated 

3.8.6.21 SubDevices 
In folder "SupportedTypes", variables and methods are listed, which are available for the 
buffer modules. 

SITOP UPS1100 

ActualBufferState 
 
Display name Data type Definition Description 
BufferTime UInt32 AnalogItemType Desired buffering time before device switches off 
BufferingEndVoltage Float AnalogItemType When battery voltage is lower than this voltage, the battery 

charge is no longer sufficient. Buffering is stopped. 
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ActualChargingState 
 
Display name Data type Definition Description 
ChargeCurrent Float AnalogItemType Actual charging current used to charge battery. 
ChargeEndVoltage Float AnalogItemType Battery voltage when charging changes to trickle charging. 

Battery is charged 100 %. 
ChargeTotalCurrent Float AnalogItemType Battery-specific data: Total charge to the battery during its 

service life 

ActualState 
 
Display name Data type Definition Description 
ModuleCalculated 
Capacity 

Float AnalogItemType Available battery capacity 

ModuleCalculated 
Health 

Byte AnalogItemType State of health (SoS) as percentage of the rated capacity 

ModuleCapacity Float AnalogItemType Capacity 
ModuleChange 
Recommended 

Boolean PropertyType Battery capacity is insufficient to achieve the specified buffer 
time. 

ModuleCompound Enumeration MultiState 
DiscreteType 

Connected device 

ModuleConnection 
Fault 

Boolean PropertyType Connection to battery interrupted - check connection and 
fuse 

ModuleManufactoring 
Date 

Date PropertyType Manufacturing date of the battery modules. 

ModuleMax 
Temperature 

Sbyte AnalogItemType Maximum specified operating temperature of the battery. 

ModuleMin 
Temperature 

Sbyte AnalogItemType Minimum specified operating temperature of the battery. 

ModuleStandbyTime UInt32 AnalogItemType Battery-specific data: Time for which battery was connected 
but no power was consumed. 

ModuleStateLed Object Sitop_1600_ 
LedType 

ModuleStateLed 

ModuleTemperature Sbyte AnalogItemType Battery temperature 
ModuleTotalCulled 
Current 

Float AnalogItemType Battery-specific data: Time for which battery was connected 
and power was consumed. 

Alarm 
 
Display name Data type Definition Description 
AlarmBatteryChange 
Canceled 

Boolean PropertyType Battery replacement canceled - battery parameters are not 
reset 

AlarmBatteryChange 
FInished 

Boolean PropertyType Battery replacement finished - counters have been reset 

AlarmBatteryChange 
Started 

Boolean PropertyType Battery replacement started by user 

AlarmBattery 
CommunicationFault 

Boolean PropertyType Communication with formerly known battery is no longer 
possible - check communication 
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Display name Data type Definition Description 
AlarmBatteryDefect Boolean PropertyType Battery defective - check fuse and battery voltages 
AlarmBattery 
ParametersCorrupt 

Boolean PropertyType Battery defective - replace battery 

AlarmBattery 
TemperatureHigh 

Boolean PropertyType Battery temperature too high - battery life will be shortened 

AlarmBattery 
TemperatureLow 

Boolean PropertyType Battery temperature too low - reduced output current 

AlarmFuseBroken Boolean PropertyType Fuse is defective. 
AlarmNewBattery 
Detected 

Boolean PropertyType A new battery was connected. The battery will be included 
in the calculation of the total capacity and the charge pa-
rameters. 

Additional parameters 
 
Display name Data type Definition Description 
DeviceManual String PropertyType  
HardwareRevision String PropertyType Product state 
Manufacturer LocalizedText PropertyType  
Model LocalizedText PropertyType  
OrderNumber String[20] PropertyType Order number/MLFB 
RevisionCounter Int32 PropertyType  
SerialNumber String[16] PropertyType Serial number 
SlotId UInt16 PropertyType  
SoftwareRevision Integer PropertyType Software version/SWD 
MaxModuleCount Byte PropertyType  

ParameterSet 

 /  

All variables of the SITOP UPS1100 buffer module are listed together under the 
"ParameterSet" node. 

 
Display name Data type Definition Description 
AlarmBatteryChange 
Canceled 

Boolean PropertyType Battery replacement canceled - battery parameters are not 
reset 

AlarmBatteryChange 
FInished 

Boolean PropertyType Battery replacement finished - counters have been reset 

AlarmBatteryChange 
Started 

Boolean PropertyType Battery replacement started by user 

AlarmBattery 
CommunicationFault 

Boolean PropertyType Communication with formerly known battery is no longer 
possible - check communication 

AlarmBatteryDefect Boolean PropertyType Battery defective - check fuse and battery voltages 
AlarmBattery 
ParametersCorrupt 

Boolean PropertyType Battery defective - replace battery 

AlarmBattery 
TemperatureHigh 

Boolean PropertyType Battery temperature too high - battery life will be shortened 
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Display name Data type Definition Description 
AlarmBattery 
TemperatureLow 

Boolean PropertyType Battery temperature too low - reduced output current 

AlarmFuseBroken Boolean PropertyType Fuse is defective. 
AlarmNewBattery 
Detected 

Boolean PropertyType A new battery was connected. The battery will be included 
in the calculation of the total capacity and the charge pa-
rameters. 

BufferTime UInt32 AnalogItemType Desired buffering time before device switches off 
BufferingEndVoltage Float AnalogItemType When battery voltage is lower than this voltage, the battery 

charge is no longer sufficient. Buffering is stopped. 
ChargeCurrent Float AnalogItemType Actual charging current used to charge battery. 
ChargeEndVoltage Float AnalogItemType Battery voltage when charging changes to trickle charging. 

Battery is charged 100%. 
ChargeTotalCurrent Float AnalogItemType Battery-specific data: Total charge to the battery during its 

service life 
ModuleCalculated 
Capacity 

Float AnalogItemType Available battery capacity 

ModuleCalculated 
Health 

Byte AnalogItemType State of health (SoS) as percentage of the rated capacity 

ModuleCapacity Float AnalogItemType Capacity 
ModuleChange 
Recommended 

Boolean PropertyType Battery capacity is insufficient to achieve the specified buffer 
time. 

ModuleCompound Enumeration MultiState 
DiscreteType 

Connected device 

ModuleConnection 
Fault 

Boolean PropertyType Connection to battery interrupted - check connection and 
fuse 

ModuleMax 
Temperature 

Sbyte AnalogItemType Maximum specified operating temperature of the battery. 

ModuleMin 
Temperature 

Sbyte AnalogItemType Minimum specified operating temperature of the battery. 

ModuleStandbyTime UInt32 AnalogItemType Battery-specific data: Time for which battery was connected 
but no power was consumed. 

ModuleStateLed Object Sitop_1600_ 
LedType 

ModuleStateLed 

ModuleTemperature Sbyte AnalogItemType Battery temperature 
ModuleTotal 
CulledCurrent 

Float AnalogItemType Battery-specific data: Time for which battery was connected 
and power was consumed. 

3.8.6.22 UserManagement 
 
Display name Data type Definition Description 
AddUser Method Method Adds a user. 
ChangeUserPassword Method Method Changes the password for the user. 
DeleteUser Method Method Deletes the user. 
UsermanagementUser 
1 … 16 

SitopUserType SitopUserType  
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Display name Data type Definition Description 
AccessLevel1Setpoint Boolean PropertyType Can read data 
AccessLevel2Setpoint Boolean PropertyType Can read device configuration 
AccessLevel3Setpoint Boolean PropertyType Can write device configuration to device 
AccessLevel4Setpoint Boolean PropertyType Can read device settings 
AccessLevel5Setpoint Boolean PropertyType Can write device configuration to device 
AccessLevel6Setpoint Boolean PropertyType Can read alarm list 
AccessLevel7Setpoint Boolean PropertyType Can delete and save alarm list 
AccessLevel8Setpoint Boolean PropertyType Can change operating mode 
AccessLevel9Setpoint Boolean PropertyType Can perform firmware update 
AccessLevel10S 
etpoint 

Boolean PropertyType Can call special functions 

AccessLevel11 
Setpoint 

Boolean PropertyType Can administer users 

UserName String[16] PropertyType User name [1 … 16] 

3.8.6.23 Web server 
 
Display name Data type Definition Description 
WebserverAutoLogout 
EnableSetpoint 

Boolean PropertyType Log off automatically after 15 minutes 

WebserverAutoReload 
EnableSetpoint 

Boolean PropertyType Activate automatic update. 

WebserverEnable 
Setpoint 

Boolean PropertyType Activate web server on this module. 

Webserver 
HttpAccessEnable 
Setpoint 

Boolean PropertyType Permit access only with HTTPS 

WebserverReload 
TimeSetpoint 

Enumeration MultiState 
DiscreteType 

Update interval: 

3.8.6.24 Additional 
These nodes are listed at the first level in the object tree 

 
Display name Data type Definition Description 
DeviceManual String PropertyType Address (path in the file system or URL / web address) of 

the operating instructions for the device. 
Hardware Revision String PropertyType Revision status of the device hardware. 
Manufacturer LocalizedText PropertyType Name of the company that manufactured the device 
Model LocalizedText PropertyType  
ModuleItemNumber UInt32 PropertyType  
OrderNumber String[20] PropertyType  
RevisionCounter Int32 PropertyType Incremental counter that specifies how often the static data 

in the device was modified. 
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Display name Data type Definition Description 
SerialNumber String PropertyType ID, which uniquely identifies the device for the device manu-

facturer 
SoftwareRevision String PropertyType Revision status of the device software. 

3.8.7 OPC UA performance 
OPC UA provides the option of collectively transferring modified actual values in the form of 
a subscription. The minimum pole interval of such a subscription is 100 ms. A maximum of 
150 data nodes can be simultaneously monitored, independent of whether these data nodes 
are assigned one or various subscriptions. 

OPC UA does not support any type of realtime communication, neither for actual values 
(read data) nor for setpoints (written data). As a consequence, it is not possible to specify an 
update/refresh rate or a maximum data flow rate. 

3.8.8 Recommissioning after a basic device has been replaced - or after restoring the 
factory settings 

If, for service reasons it is necessary to replace the basic device - or store the factory 
settings, then please observe the following notes: 

1. Brand new basic devices or basic devices, where the factory settings have been restored, 
have no IP address. However, this is generally necessary so that the device can be 
accessed using OPC UA. Proceed as described in Chapter General (Page 146), Section 
"communication interface" to assign the device a certain IP address. 

2. The configuration must be loaded to the device. This can be done in the following ways: 

● Proceed as described in Chapter Load / Save (Page 157) to load a valid configuration 
into the device (previously saved via web server). 

● Load a valid configuration to the device via OPC UA. Ensure that the necessary user 
account is available in the device for access via OPC UA. The latter can be created using 
a web server, see Chapter Web server (Page 148). 
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 Troubleshooting 4 
 

 

You can obtain additional information on an active alarm from the help text. 
The extended error type is used to interpret alarms in S7 function blocks that you have 
programmed yourself. 

The severity indicates the severity of the alarm: 

● D = diagnostics 

● MD = Maintenance Demanded 

● MR = Maintenance Required 

● F = Failure (module has failed) 

 
Error 
Type 

Ex-
tended 
Error 
Type 

Severity Alarm Text Help Text 

256 1 F Software corrupted Software is corrupt - try to update the software 
256 2 MR Wrong checksum Internal error: Communication disrupted 
256 3 MR Parameter corrupt Attempting to write to an unknown or read-only object. 
256 4 MR Unknown parameter Attempting to set a parameter that is not known by UPS1600. 
256 5 MR Wrong message length Internal error: Communication disrupted 
256 6 MR Wrong parameter Parameter value is not within the specified range 
256 7 MR Command not accepted An incorrect command was sent to the UPS1600 
256 8 MR Communication error: 

Wrong length field 
Syntax error in command 

256 9 MR Wrong request Error in sent message: Unknown request sent. 
256 10 MR Cannot write to object Attempting to write a parameter that is "read-only" 
256 11 MR Object pending UPS1600 cannot provide data for the requested object. 
256 12 MR Battery not available Attempting to access a battery that is not available. Either the 

battery with the requested number was never connected or 
communication with this battery was interrupted. 

256 13 MR EEPROM write error Saving UPS1600 parameters failed. Device is defective. 
256 14 MR Unknown alarm Internal error: Wrong parameter at execution of test command. 
256 15 MR Command outside range An incorrect command was sent to the UPS1600 
256 16 MR Software update is being 

performed 
The command sent cannot be executed as long as the pro-
gram is running. 

256 17 MR No software update Cannot execute the sent command because no software up-
date has been started. 

256 18 MR Wrong battery number Attempting to retrieve data about a battery which does not 
exist or is not connected. 

256 19 MR Wrong address Wrong Flash address in software update - software update file 
is corrupt. 
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Error 
Type 

Ex-
tended 
Error 
Type 

Severity Alarm Text Help Text 

256 20 MR Write error Cannot write to Flash - hardware may be defective 
256 21 MR Read error Unable to read EEPROM. Device is defective. 
256 22 MR Wrong device ID An attempt was made to update the software with an update 

file that is not suitable for the UPS1600. 
256 23 MR Corrupt data record Error during software update - try to update the software again 
256 24 MR Wrong update An attempt was made to update the software with an invalid 

update file. The update file is probably too old. 
256 25 MR Too much data An entry in the software update cannot contain more than 32 

bytes of reference data. 
256 26 F Device failure Device failure 
256 27 F No boot loader available No boot loader available 
257 1 MD Buffer mode is not possible Buffer mode is not possible - check settings, cabling, fuse, and 

battery voltages 
257 2 MD Device temperature critical 

(too high) 
Device temperature is very high! Ensure adequate cooling or 
disconnect unnecessary loads. 

257 3 MD Device temperature critical 
(too low) 

Device temperature is very low! Ensure a higher ambient tem-
perature. 

257 4 F High-resistance connection 
to battery 

High-resistance connection to battery - check battery power 
cable 

257 5 F Connection to battery inter-
rupted 

Connection to battery interrupted - check connection and fuse 

257 6 MD Unknown battery Data from the battery cannot be read correctly. Battery is de-
fective or not supported by SIEMENS. 

257 7 MR Overcurrent Output current of UPS1600 is too high. Output will be switched 
off for 20s. The output will be switched on again after 20s. 

257 8 MR Reset buffer timer PC is shutting down 
257 9 MR UPS1600 off UPS1600 off - buffer time exceeded or PC was shut down 
257 10 MR Output switched off The UPS1600 output was shut down as result of executing an 

instruction or an error situation (e.g. overtemperature, exces-
sive output current). 

257 11 MR Output switched on The UPS1600 output was switched on again as result of exe-
cuting an instruction or the correction of an error situation. 

257 12 MR Reset executed Input voltage at UPS1600 was OK again before the buffer time 
expired. Connected devices are reset by switching off the 
UPS1600 outputs for the configured time. 

257 13 MR Battery test A cyclic battery test will be performed 
Remark:  
For firmware versions from V2.2 - and for versions V2.0.× from 
version V2.0.5, the alarm is deactivated. 

257 14 MR Software update successful Previous software update was successful - UPS1600 is opera-
tional again. 

257 15 MR Input voltage is too high Input voltage exceeds 30 V. UPS1600 is not operational. 
257 16 MD Surplus battery More than 6 batteries are connected. Connect a maximum of 6 

batteries to the Energy Storage Link. 
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Error 
Type 

Ex-
tended 
Error 
Type 

Severity Alarm Text Help Text 

257 17 F UPS1600 parameters cor-
rupt 

UPS1600-parameters corrupt - try to update the software. 

257 18 F Device overtemperature Output and battery charging is switched off to prevent damage 
to the device. 

257 20 MR Low voltage mode Input voltage of UPS1600 is too low. UPS1600 is not ready for 
buffering. 

257 21 MR Buffering Device is in the buffer mode. 
257 22 MR Communication with device 

failed 
PROFINET connection available - UPS1600 is defective 

257 23 MR Device powered up Device powered up 
257 24 F Wrong battery polarity Wrong battery polarity - check battery connections. 
257 26 MR Insufficient charge level Set buffer time can currently not be achieved due to low bat-

tery charge. 
257 27 MR Deep discharge battery Battery is deep discharged - no buffering possible 
258 1 F Battery defective (battery 

index: {1:d}) 
Battery defective - check the fuse and the battery voltages 

258 2 F Deep discharge battery, no 
charging possible (battery 
index: {1:d}). 

Battery is deep discharged - replace battery 

258 3 MD Battery temperature high 
(battery index: {1:d}) 

Battery temperature too high - battery life will be shortened 

258 4 MD Battery temperature low 
(battery index: {1:d}). 

Battery temperature too low - reduced output current 

258 5 F Communication with battery 
fault (battery index: {1:d}) 

Communication with formerly known battery is no longer pos-
sible - check communication 

258 6 MR New battery detected (bat-
tery index: {1:d}) 

A new battery was connected. The battery will be included in 
the calculation of the total capacity and the charge parameters. 

258 7 F Wrong battery configuration 
(battery index: {1:d}) 

Different battery types connected. Only batteries of the same 
type can be operated together. 

258 8 MD Battery parameters corrupt 
(battery index: {1:d}). 

Battery defective - replace battery 
Remark: 
Alarm is deactivated. 

258 9 MR Battery replacement started 
(battery index: {1:d}) 

Battery replacement started by user 

258 10 MR Battery replacement fin-
ished (battery index: {1:d}) 

Battery replacement finished - counters have been reset 

258 11 MD Battery replacement can-
celed (battery index: {1:d}) 

Battery replacement canceled - battery parameters are not 
reset 

258 12 F Fuse is defective (battery 
index: {1:d}) 

Fuse is defective. 
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4.1 Hardware fault 
For an internally identified software or hardware fault/error, the following response occurs: 

• LED 1 (O.K./BAT.) lights up red 
• LED 2/3/4 are dark 
• Alarm 13 (Device failure) is sent 
• UPS1600 output shuts down 

Response from V2.0.4 or V2.1 and higher: 
The output is only shut down for a software error (internal software error, software update 
not completed, software checksum is incorrect). 
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 Mounting/removing 5 
5.1 SITOP UPS1600 
 

 WARNING 

Installing the device in a housing or a control cabinet 

The SITOP UPS1600s are built-in units. They must be installed in a housing or control 
cabinet where only qualified personnel have access. 

 

The device can be mounted in a control cabinet on standard TH35×7.5/15 mounting rails 
(according to EN 60715). 

 

 WARNING 

Use in hazardous zones 

If the device is to be used in a hazardous zone (II 3G Ex nA nC IIC T4 Gc) it must be 
installed in a distribution box with degree of protection IP54 or higher. This distribution box 
must comply with the requirements of EN 60079-15. 

 

Mounting 

To mount the device, position it with the mounting rail guide at the upper edge of the 
standard mounting rail and press down to lock it into place. If this is too difficult, press slider 
⑩ at the same time, as described under "Removal". 

Removal 

To remove, carefully open the slider ⑩ using a screwdriver or by hand (see Figure 5-1 
Removal (example 6EP4136-3AB00-2AY0) (Page 188)) and disengage the device at the 
bottom edge of the standard mounting rail. Then you can remove the device from the upper 
edge of the standard mounting rail. 
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Figure 5-1 Removal (example 6EP4136-3AB00-2AY0) 

5.1.1 Signal connector 

Mounting 

Push connector on socket ④ in the housing. 

Removal 

To remove the signal connector, press the release lever (4b) (see Figure 5-2 
Mounting/removal: Signal connector (Page 188)) and then remove the connector. 

 
Figure 5-2 Mounting/removal: Signal connector 
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5.1.2 USB connector 
For deployment in an explosion-endangered environment, a USB connector with strain relief 
must be used. 

Mounting 

Push the connector onto the socket in the housing until the strain relief (6b) snaps into the 
housing (6a). 

Removal 

To remove the USB connector, press to release the strain relief (6b) (see Figure 5-3 
Mounting/removal: USB connector (Page 189)) and then remove the connector. 

 
Figure 5-3 Mounting/removal: USB connector 
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5.1.3 PROFINET/Ethernet connector 
For use in a hazardous zone, a PROFINET/Ethernet connector with strain relief must be 
used. 

Mounting 

Push the connector onto the socket in the housing until the strain relief (5b) snaps into the 
housing (5a). 

Removal 

To remove the PROFINET/Ethernet connector, press to release the strain relief (5b) (see 
Figure 5-4 Mounting/removal: Ethernet (Page 190)) and then remove the connector. 

 
Figure 5-4 Mounting/removal: Ethernet 
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5.2 SITOP UPS1100 
 

 WARNING 

Mounting the device in a housing or a control cabinet 

The SITOP UPS1100 battery modules are built-in units. They must be mounted in a 
housing or control cabinet where only qualified personnel have access. 

 

All devices are suitable for direct wall mounting. 
Devices 6EP4131-0GB00-0AY0 (1.2 Ah), 6EP4132-0GB00-0AY0 (2.5 Ah), 6EP4133-
0GB00-0AY0 (3.2 Ah) and 6EP4133-0JB00-0AY0 (5 Ah) can also be snapped onto a 
standard mounting rail TH35×15 (EN 60715), and device 6EP4131-0GB00-0AY0 (1.2 Ah) 
also onto a standard mounting rail TH35×7.5 (EN 60715). 

The lower part of the control cabinet or the coolest location in the control cabinet should be 
chosen as mounting location. 

 

 WARNING 

Use in hazardous zones 

When the device is installed in a hazardous zone (II 3G nA IIC T4 Gc), not permissible for 
6EP4133-0JB00-0AY0 (5 Ah), then this must be installed in a distribution box with degree 
of protection IP54 or higher. This distribution box must comply with the requirements of 
EN 60079-15. 

 

Mounting 

See Chapter Dimensions and weight for the holes for wall mounting SITOP UPS1100 
(Page 42). 

To mount the device on a standard mounting rail, place it with the standard mounting rail 
guide at the upper edge of the standard mounting rail and snap it in downwards. If this is too 
difficult, push the device downwards while pressing on the rail as described for "Removal". 

 

 Note 

The fuses should be inserted in the fuse holder only when commissioning the device 
(charged batteries). 

 

 Note 

The lead acid batteries are fully charged when the device is delivered. The LiFePo battery 
(5 Ah) is only charged up to a maximum of 30 % of the nominal charge (to comply with 
transport regulations). 

 

Removal 

To remove the device, pull it forcibly downwards while removing it from the lower edge of the 
standard mounting rail (see Figure 5-5 Removal (example 6EP4133-0GB00-0AY0 (3,2 Ah)) 
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(Page 192)). Then you can remove the device from the upper edge of the standard mounting 
rail. 

 
Figure 5-5 Removal (example 6EP4133-0GB00-0AY0 (3,2 Ah)) 
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 Mounting position, mounting clearances 6 
6.1 SITOP UPS1600 

6.1.1 Standard mounting position 
The device is mounted on standard mounting rails EN 60715 35×7.5/15. The device must be 
mounted vertically in such a way that the input terminals and the output terminals are at the 
bottom to ensure correct cooling. 

A clearance of at least 50 mm should be maintained above and below the device. 

No clearance is required at the side. 

Output current as a function of the ambient temperature 

 
Figure 6-1 6EP4134-3AB00-... Output current in the standard mounting position 

 
Figure 6-2 6EP4136-3AB00-... Output current in the standard mounting position 
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Figure 6-3 6EP4137-3AB00-... Output current in the standard mounting position 
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6.1.2 Other mounting positions 
For mounting positions that deviate from the standard mounting position, derating factors 
(reduction of the output power or the permissible ambient temperature) must be observed in 
accordance with the following diagrams. 

 

 Note 

In the case of mounting positions that deviate from the standard mounting position, reduced 
mechanical resistance of the devices against vibration and shock must be expected. 

Particularly when installing on a vertically fastened standard mounting rail, additional 
measures may be required, e.g. to prevent the device from slipping on the standard 
mounting rail. 

 

6.1.2.1 6EP4134-3AB00-... 

 
Figure 6-4 6EP4134-3AB00-... Mounting position 1 

 
Figure 6-5 6EP4134-3AB00-... Mounting position 2 
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Figure 6-6 6EP4134-3AB00-... Mounting position 3 

 
Figure 6-7 6EP4134-3AB00-... Mounting position 4 

 
Figure 6-8 6EP4134-3AB00-... Mounting position 5 
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6.1.2.2 6EP4136-3AB00-... 

 
Figure 6-9 6EP4136-3AB00-... Mounting position 1 

 
Figure 6-10 6EP4136-3AB00-... Mounting position 2 

 
Figure 6-11 6EP4136-3AB00-... Mounting position 3 
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Figure 6-12 6EP4136-3AB00-... Mounting position 4 

 
Figure 6-13 6EP4136-3AB00-... Mounting position 5 
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6.1.2.3 6EP4137-3AB00-... 

 
Figure 6-14 6EP4137-3AB00-... Mounting position 1 

 
Figure 6-15 6EP4137-3AB00-... Mounting position 2 

 
Figure 6-16 6EP4137-3AB00-... Mounting position 3 
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Figure 6-17 6EP4137-3AB00-... Mounting position 4 

 
Figure 6-18 6EP4137-3AB00-... Mounting position 5 
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6.2 SITOP UPS1100 

6.2.1 Standard mounting position 
The device is suitable for the direct wall mounting. Devices 6EP4131-0GB00-0AY0 (1.2 Ah), 
6EP4132-0GB00-0AY0 (2.5 Ah), 6EP4133-0GB00-0AY0 (3.2 Ah) and 6EP4133-0JB00-
0AY0 (5 Ah) can also be snapped onto a standard mounting rail TH35×15 (EN 60715), and 
device 6EP4131-0GB00-0AY0 (1.2 Ah), also onto a standard mounting rail TH35×7.5 
(EN 60715). It should also be mounted at the coolest point in the control cabinet (e.g. in the 
lower part of the control cabinet). The device must be mounted vertically in such a way that 
the terminals are at the bottom. 

No clearance is required at the side. 

6.2.2 Other mounting positions 
 

 Note 

In the case of mounting positions that deviate from the standard mounting position, reduced 
mechanical resistance of the devices against vibration and shock must be expected. 

Particularly when installing on a vertically fastened standard mounting rail, additional 
measures may be required, e.g. to prevent the device from slipping on the rail. 

 

All mounting positions have been released, except the following: 
For UPS1100 1.2 Ah: Mounting position (2) (see the following diagram) 
all other UPS1100: Mounting position (5) (see the following diagram) 

 
Figure 6-19 Mounting positions forbidden for the UPS1100 
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6.3 Altitude derating 

Output current as a function of the altitude derating 
 

 
Figure 6-20 Altitude derating 

Details see chapter Environmental conditions (Page 225) 
 

 Note 

Only applies to the UPS1600. For UPS1100 (with the exception of UPS1100 2.5 Ah) 
operation at altitudes of 4000 m above sea level is not permissible. 
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 Installation 7 
 

 
 

 Note 

When installing the devices, the relevant country-specific regulations must be complied with. 

The 24 V supply voltage must be SELV in accordance with EN60950-1 and EN50178. 

Only qualified personnel are allowed to install the device/system and set it into operation. 

It is not permissible that the connections are attached or detached in operation. 
 

 Note 
for SITOP UPS1100 

It is recommended that the batteries are only stored fully charged. 

The lead acid batteries are fully charged when the device is delivered. The LiFePo battery 
(5 Ah) is only supplied charged up to a maximum of 30 % of the nominal charge (to comply 
with transport regulations).  

The self-discharge rate of the batteries is approx. 3%/month for a temperature of 20° C. This 
value is temperature dependent and becomes more unfavorable for an increasing 
temperature, and more favorable for a decreasing temperature. 

The fuses should only be inserted in the fuse holder when commissioning the device. 

When storing UPS1100 battery modules and completely cabled/wired systems (with 
UPS1600 and fuse inserted in the UPS1100), it should be taken into account that an 
additional discharge current of 300 µA flows. 

SITOP UPS1100 1.2 Ah is only recommended in conjunction with SITOP UPS1600 10 A. 

SITOP UPS1100 2.5 Ah, 3.2 Ah and 5 Ah are only recommended in conjunction with 
SITOP UPS1600 10 A and 20 A. 

 

When using battery modules without Energy Storage Link, it must be ensured that the 
selected batteries match the data of the UPS1600 (static and dynamic load current, charge 
current). 
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Figure 7-1 Wiring 
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7.1 Connecting the SITOP UPS1600 at its input 
SITOP UPS1600 is designed to be connected to a 24 V DC supply. The 24 V supply voltage 
must be SELV in accordance with EN60950-1 and EN50178. 

 
Figure 7-2 Input side connection 

The 24 V power supply is connected at the "IN+", and "IN-" ① terminals (see Figure Input 
side connection (Page 205)). 

Cables must be used that are suitable for at least 90 °C (only for applications for UL508). 

7.2 Connecting the SITOP UPS1600 at its output 
The output of the SITOP UPS1600 is no-load, overload and short-circuit proof. If an overload 
occurs, the electronic current limiting function limits the output current to a maximum value 
(see Section Technical data (Page 211)). 

 
Figure 7-3 Output-side connection 

The output voltage is connected at the "OUT+" and "OUT–" ② terminals (see Figure Output-
side connection (Page 205)). Ensure that the output cables are dimensioned correctly for the 
maximum output current rms value and fused accordingly. 

The deployed cables must be suitable for temperatures of at least 90° C. (only for 
applications for UL508) 
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7.3 Connecting the BAT SITOP UPS1600 

 
Figure 7-4 BAT connection 

The "BAT+" and "BAT-" ③ connections (see Figure BAT connection (Page 206)) are used to 
connect the SITOP UPS1600 with one or more SITOP UPS1100 battery modules. Ensure 
that the cables are dimensioned correctly for the maximum output current rms value of the 
SITOP UPS1600. 

For wiring, see Figure Wiring (Page 204). 

Cables must be used that are suitable for at least 90 °C (only for applications for UL508). 

Maximum cable length 3 m 

7.4 USB interface 
Maximum USB cable length 5 m 

7.5 PROFINET/Ethernet connection 
Maximum length of the PROFINET/Ethernet cable 100 m (90 m BASIC- Link plus 2 x 5 m 
CHANNEL- Link) 
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7.6 SITOP UPS1100 connections 
 

 
Connections 1.2 Ah/2.5 Ah/3.2 Ah/5 Ah 

 
Connections 7/12 Ah 

Connection X1 ① 

The connections "X1+" and "X1-" are used to transfer power between the SITOP UPS1600 
and the SITOP UPS1100. 

1. Ensure that the cables are dimensioned corresponding to the fuses in the 
SITOP UPS1100 and the impedances between SITOP UPS1600 and SITOP UPS1100 
are the same. 

2. Only connect charged batteries with one another. 

Connection X2 ② 

Connections "X2-1" and "X2-2" serve to transfer data between SITOP UPS1600 and 
SITOP UPS1100 (see Figure Wiring (Page 204)). 

When several battery modules are used, note the following: 

● Up to 6 battery modules of the same type can be connected together in parallel. 

● If different battery modules are connected in parallel, the relay REL2 is energized and de-
energized at regular intervals (battery defective). No calculations with regard to charge 
and remaining buffer time are performed. The battery modules are not charged, but 
buffering is possible. 

● If more than 6 battery modules are connected in parallel, the relay REL2 is energized and 
de-energized at regular intervals (battery defective). No calculations with regard to charge 
and remaining buffer time are performed. Charging and buffering, however, is possible. 
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7.7 Maintenance 

7.7.1 Battery 
SITOP UPS1100 devices contain 2 maintenance-free batteries. 
 
Device type Battery type 
6EP4131-0GB00-0AY0 (1.2 Ah) YUASA NP1,2-12  
6EP4132-0GB00-0AY0 (2.5 Ah) Hawker Energy CYCLON 0810-0075 2.5-12 
6EP4133-0GB00-0AY0 (3.2 Ah) YUASA NP3,2-12 or B.B.Battery BP3,6-12 
6EP4133-0JB00-0AY0 (5 Ah) NEC ALM12V7s 
6EP4134-0GB00-0AY0 (7 Ah) YUASA NP7-12 or B.B.Battery BP7-12 
6EP4135-0GB00-0AY0 (12 Ah) YUASA NP12-12 or B.B.Battery BP12-12 

When replacing the batteries, always use batteries with the same batch number 
(approximately the same charge state). 

The rechargeable batteries must be disposed of, discharged according to the applicable 
regulations. 

When storing, installing and operating the buffer batteries, the regulations of VDE 0510 Part 
2 / EN 50272-2 or the applicable national regulations must be observed. 

The self-discharge rate of the batteries is approx. 3%/month for a temperature of 20° C. This 
value is temperature dependent and becomes more unfavorable for an increasing 
temperature, and more favorable for a decreasing temperature. 

7.7.2 Battery replacement 
See Figure 7-5 Maintenance (Page 209) and Figure 7-6 Wiring schematic (Page 209) 

1. Remove the screws ⑨ using a Torx T10 screwdriver. 

2. Open the cover. 

3. Press button ⑧ for at least 2 s. 

LED ④ flashes 

4. Remove fuse ③ 

5. Replace the batteries. 

6. Press the button for at least 2 s 

LED ④ stops flashing and lights continuously. 

7. Insert the fuse. 

8. Close the cover (screw). 
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Pressing the button resets the following functions: 

● Operating hours counter 

● Buffer time counter 

● Summed charge current 

● Summed load current 

● Calculated capacity 

 

 Note 

Replace the battery only in normal operation, not in backup operation. 
 

 
Figure 7-5 Maintenance 

 
Figure 7-6 Wiring schematic 
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 Technical data 8 
 

 
 

 Note 

Technical data apply for a rated input voltage, rated load and 25 °C ambient temperature if 
nothing else is specified. 

 

8.1 Input data 

8.1.1 SITOP UPS1600 
 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Input voltage 
Uin rated/range 

24 V DC/21 - 29 V 

Connection threshold for 
buffering 
 
• Remark 

22.5 V DC ± 3 % (factory setting),  
setting range: 21 V DC, 21.5 V DC, 22 V DC, 22.5 V DC, 23 V DC, 24 V DC, 25 V DC or via 
software. 
The connection (switch-in) threshold must be at least 0.5 V lower than the input voltage (meas-
ured at the input terminal under load). 
After reaching the minimum input voltage at the DC UPS module, the module cannot buffer for 
a maximum of 1.5 seconds. 

Input current Iin rated Approx. 14 A  
at the maximum charge cur-
rent (3 A) 

Approx. 25 A  
at the maximum charge cur-
rent (4 A) 

Approx. 46 A  
at the maximum charge cur-
rent (5 A) 

Reverse polarity protec-
tion 

Yes 
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8.1.2 SITOP UPS1100 

Charge current 

● The charge current is limited by the maximum permissible charge current of the UPS1600 
(see Chapter SITOP UPS1600 (Page 213)) 

● When a battery module is connected, the charge current is max. 0.3C A. 

● For several battery modules connected in parallel, the max. charge current is 0.3C A 
multiplied by the number of batteries connected in parallel. 

Recommended end-of-charge voltage (standby use), dependent on the battery temperature 
 

 6EP4131-0GB00- ... (1.2 Ah) 
6EP4133-0GB00- ... (3.2 Ah) 
6EP4134-0GB00- ... (7 Ah) 
6EP4135-0GB00- ... (12 Ah) 

6EP4132-0GB00- ... (2.5 Ah) 6EP4133-0JB00- ... (5 Ah) 

At -10 °C - 29.0 V 29.28 V 
At 0 °C - 28.6 V 29.52 V 
At 10 °C 27.8 V 28.3 V 29.16 V 
At 20 °C 27.3 V 27.9 V 28.8 V 
At 30 °C 26.8 V 27.5 V 28.8 V 
At 40 °C 26.6 V 27.2 V 28.8 V 
At 50 °C - 26.8 V 27.8 V 
At 60 °C - 26.4 V - 

 

 

 Note 

Battery module UPS1100 5 Ah with LiFePo batteries can only be used in conjunction with 
UPS1600 from software version V2.1 and higher. 

 

See also 
SITOP UPS1600 (Page 213) 

Output data (Page 213) 
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8.2 Output data 

8.2.1 SITOP UPS1600 
 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Output voltage  
for normal operation 

Input voltage Uin approx. - 0.2 V 

Output voltage  
for buffer mode 

27 V DC (no-load); 24 V (50 % rated battery current); 
22 V (100 % rated battery current); 18.5 V (deep discharge protection) 

Power-up characteristics Start delay < 1 s 
Typical voltage increase: < 60 ms 

Output +BAT/-BAT for nor-
mal operation 
• Remark 

I-U charging characteristic (initially fast charge current, then charge retention). 
 
For one connected battery module the max. charge current is 0.3C A, for several battery 
modules connected in parallel, the charge current is 0.3C A multiplied by the number of 
batteries connected in parallel, however, limited by the maximum permissible charge cur-
rent of the UPS1600. 

End-of-charge voltage Automatic temperature-controlled setting with the SITOP UPS1100 battery modules 
Output current – rated value 10 A 20 A 40 A 
Power boost for 30 ms 30 A 60 A 120 A 
Extra power for 5 s/min 15 A 30 A 60 A 

• Remark When using the UPS1100 5 Ah, Extra Power is permissible for 1 s/min. 

Charge current Max. 3 A 
Automatic setting for 
UPS1100; otherwise 0.3 A, 
0.8 A or 3 A can be selected 
(by software or jumper (see 
Table 2-5 Charge current 
(Page 29))) 

Max. 4 A 
Automatic setting for 
UPS1100; otherwise 0.8 A, 
1.75 A, 4 A can be selected 
(by software or jumper (see 
Table 2-5 Charge current 
(Page 29))) 

Max. 5 A 
Automatic setting for 
UPS1100; otherwise 0.8 A, 
1.75 A, 4 A can be selected 
(by software or jumper (see 
Table 2-5 Charge current 
(Page 29))) 

• Remark The charge current can be automatically reduced if the charge current plus the load current 
at the UPS1600 results in an overload of the feeding power supply. 
The charge current can also be reduced if the ambient temperature of the UPS1600 is 
higher than 40 °C - or if the input voltage at the UPS1600 is less than 24 V. 
Derating: 
10 A: 3 A→2 A 
20 A: 4 A→3 A 
40 A: 5 A→3 A 
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8.2.2 SITOP UPS1100 
 

 6EP4131- 
0GB00-...  
(1.2 Ah) 

6EP4132- 
0GB00-...  
(2.5 Ah) 

6EP4133- 
0GB00-...  
(3.2 Ah) 

6EP4133- 
0JB00-...  
(5 Ah) 

6EP4134- 
0GB00-...  
(7 Ah) 

6EP4135- 
0GB00-...  
(12 Ah) 

Output 
voltage 
rated value 

24 V DC 

Rated 
voltage 
range  

22 - 27 V DC 22 - 27 V DC 22 - 27 V DC 22 - 28.8 V DC 22 - 27 V DC 22 - 27 V DC 

Output 
current 
rated value 

10 A 20 A 20 A 20 A 40 A 40 A 

Power boost  
for 30 ms 

30 A 60 A 60 A 60 A 120 A 120 A 

Extra Power  
for 5 s/min 

15 A 30 A 30 A - 60 A 60 A 

Extra Power  
for 1 s/min 

- - - 30 A - - 

Battery  
fuse  
(pluggable) 

15 A / 32 V 25 A / 32 V 25 A / 32 V 25 A/32 V 2 × 25 A/32 V 2 × 25 A/32 V 

Remark: 

The lead acid batteries are fully charged when the device is delivered. The LiFePo battery 
(5 Ah) is only supplied charged up to a maximum of 30 % of the nominal charge (to comply 
with transport regulations). 
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8.3 Backup times 
 

Output current 6EP4131- 
0GB00- 
... (1.2 Ah) 

6EP4132- 
0GB00- 
... (2.5 Ah) 

6EP4133- 
0GB00- 
... (3.2 Ah) 

6EP4133- 
0JB00- 
... (5 Ah) 

6EP4134- 
0GB00- 
... (7 Ah) 

6EP4135- 
0GB00- 
... (12 Ah) 

1 A 34 minutes 1.7 h 2.5 h 5.2 h 5.4 h 10.3 h 
2 A 11 minutes 54.6 minutes 1 h 2.5 h 2.6 h 4.8 h 
3 A 9 minutes 32.9 minutes 39 minutes 1.7 h 1.6 h 3 h 
4 A 6 min 20.6 minutes 27 minutes 1.25 h 1.2 h 2.3 h 
6 A 3.5 minutes 14.3 minutes 17.5 minutes 50.6 minutes 41 minutes 1.4 h 
8 A 2 minutes 10.5 minutes 12 minutes 37.8 minutes 28 minutes 1 h 
10 A 1 minute 7.2 minutes 9 minutes 30.2 minutes 22 minutes 48.6 minutes 
12 A - 6 minutes 7 minutes 25.1 minutes 17 minutes 40.3 minutes 
14 A - 4.5 minutes 5 minutes 21.6 minutes 15 minutes 33.6 minutes 
16 A - 4.1 minutes 4 minutes 18.8 minutes 12.5 minutes 26 minutes 
20 A - 2.9 minutes 1 minute 12.9 minutes 9 minutes 19.6 minutes 
30 A - - - - 4.6 min 12.1 min 
40 A - -- - - 2.8 min 8.5 min 

8.4 Efficiency 

Table 8- 1 SITOP UPS1600 

 6EP4134-3AB00-0AY0 (10 A) 
6EP4134-3AB00-1AY0 (10 A) 

6EP4134-3AB00-2AY0 (10 A) 

Efficiency at Uin rated, Iout rated, approx. 97.5 % 97.3 % 
Power loss at Uin rated, Iout rated, approx. 6 W 7 W 

 

 

 6EP4136-3AB00-0AY0 (20 A) 
6EP4136-3AB00-1AY0 (20 A) 

6EP4136-3AB00-2AY0 (20 A) 

Efficiency at Uin rated, Iout rated, approx. 97.7 % 97.5 % 
Power loss at Uin rated, Iout rated, approx. 10 W 11 W 

 

 

 6EP4137-3AB00-0AY0 (40 A) 
6EP4137-3AB00-1AY0 (40 A) 

6EP4137-3AB00-2AY0 (40 A) 

Efficiency at Uin rated, Iout rated, approx. 98.5 % 98.3 % 
Power loss at Uin rated, Iout rated, approx. 15 W 17 W 
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8.5 Protection and monitoring 

Table 8- 2 SITOP UPS1600 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Current limitation 
 Typ. 
• Remark 

30 A 
 
Power boost with 300 % Iout rated 
for typ. 30 ms 

60 A 
 
Power boost with 300 % Iout rated 
for typ. 30 ms 

120 A 
 
Power boost with 300 % Iout rated 
for typ. 30 ms 

Short-circuit protec-
tion 

Shutdown after 30 ms 

Reverse polarity 
protection 

With respect to the input voltage Uin and with respect to batteries 

Overload/short-circuit 
indicator 

Yes, restart in normal operation 

 

Table 8- 3 SITOP UPS1100 

 6EP4131-
0GB00-... 
(1.2 Ah) 

6EP4132-
0GB00-... 
(2.5 Ah) 

6EP4133-
0GB00-... 
(3.2 Ah) 

6EP4133-
0JB00-...  
(5 Ah) 

6EP4134-
0GB00-... 
(7 Ah) 

6EP4135-
0GB00-... 
(12 Ah) 

Short-circuit 
protection 

Yes, fuse 

Reverse 
polarity pro-
tection 

Yes 

8.6 MTBF 
 

 6EP4134-3AB00- ... (10 A) 
6EP4136-3AB00- ... (20 A) 
6EP4137-3AB00- ... (40 A) 

Mean Time Between Failures SN29500: > 320000 h at 40 °C, rated load, 24h operation 
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8.7 Mechanical system 

8.7.1 SITOP UPS1600 

Table 8- 4 SITOP UPS1600 10 A / 20 A 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 

 ... -0AY0 ... -1AY0 ... -2AY0 ... -0AY0 ... -1AY0 ... -2AY0 
Connection system Screw-type terminal 
Connections / DC input IN+, IN-: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / DC output OUT+, OUT-: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / BAT BAT+, BAT-: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / signal con-
nector 

X2 (1 - 14): 1 screw terminal each for 0.2 - 1.5 mm² solid/finely stranded 

Width of the housing 50 mm 50 mm 50 mm 50 mm 50 mm 50 mm 
Height of the housing 138.7 mm 138.7 mm 138.7 mm 138.7 mm 138.7 mm 138.7 mm 
Depth of the housing 125 mm 125 mm 125 mm 125 mm 125 mm 125 mm 
Installation width 50 mm 50 mm 50 mm 50 mm 50 mm 50 mm 
Mounting height 238.7 mm 238.7 mm 238.7 mm 238.7 mm 238.7 mm 238.7 mm 
Weight, approx. 0.38 kg 0.4 kg 0.44 kg 0.39 kg 0.41 kg 0.45 kg 
Product feature /  
of the housing / 
housing that can be lined 
up next to one another 

Yes 

Type of mounting / 
wall mounting 

No 

Type of mounting /  
rail mounting 

Yes 

Type of mounting /  
S7-300 rail 
mounting 

No 

Mounting Can be snapped onto standard TH35x7,5/15 mounting rails (EN 60715) 
 

Table 8- 5 SITOP UPS1600 40 A 

 6EP4137-3AB00- ... (40 A) 

 ... -0AY0 ... -1AY0 ... -2AY0 
Connection system Screw-type terminal 
Connections / DC input IN+, IN-: 1 screw terminal each for 0.5 - 16 (4) mm² solid (finely stranded) 
Connections / DC output OUT+, OUT-: 1 screw terminal each for 0.5 - 16 (4) mm² solid (finely stranded) 
Connections / BAT BAT+, BAT-: 1 screw terminal each for 0.5 - 16 (4) mm² solid (finely stranded) 
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 6EP4137-3AB00- ... (40 A) 

 ... -0AY0 ... -1AY0 ... -2AY0 
Connections / signal con-
nector 

X2 (1 - 14): 1 screw terminal each for 0.2 - 1.5 mm² solid/finely stranded 

Width of the housing 70 mm 70 mm 70 mm 
Height of the housing 138.7 mm 138.7 mm 138.7 mm 
Depth of the housing 150 mm 150 mm 150 mm 
Installation width 70 mm 70 mm 70 mm 
Mounting height 238.7 mm 238.7 mm 238.7 mm 
Weight, approx. 0.65 Kg 0.65 Kg 0.7 kg 
Product feature /  
of the housing / 
housing that can be lined 
up next to one another 

Yes 

Type of mounting / 
wall mounting 

No 

Type of mounting / 
rail mounting 

Yes 

Type of mounting /  
S7-300 rail mounting 

No 

Mounting Can be snapped onto standard TH35x7,5/15 mounting rails (EN 60715) 

8.7.2 SITOP UPS1100 

Table 8- 6 SITOP UPS1100 1.2 Ah / 2.5 Ah / 3.2 Ah 

 6EP4131-0GB00- ...  
(1.2 Ah) 

6EP4132-0GB00- ...  
(2.5 Ah) 

6EP4133-0GB00- ... 
(3.2 Ah) 

Connection system Screw-type terminal 
Connections / DC input X1-1, X1-2: 1 screw terminal each for 0.2 - 6 (4) mm² solid (finely stranded) 
Connections / signal terminal X2-1, X2-2: 1 screw terminal each for 0.14 - 4 (2.5) mm² solid (finely stranded) 
Width of the housing 89 mm 265 mm 190 mm 
Height of the housing 130.3 mm 115 mm 169.3 mm 
Depth of the housing 106.7 mm 76 mm 78.7 mm 
Installation width 89 mm 265 mm 190 mm 
Mounting height 145.3 mm 130 mm 184.3 mm 
Weight, approx. 1.9 kg 3.7 kg 3.8 kg 
Product feature /  
of the housing / 
housing that can be lined up 
next to one another 

Yes 

Type of mounting / 
wall mounting 

Yes 
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 6EP4131-0GB00- ...  
(1.2 Ah) 

6EP4132-0GB00- ...  
(2.5 Ah) 

6EP4133-0GB00- ... 
(3.2 Ah) 

Type of mounting / rail mount-
ing 

Yes 

Type of mounting /  
S7-300 rail mounting 

No 

Mounting Wall mounting, can be 
snapped onto standard 
TH35x7,5/15 mounting rails 
(EN 60715) 

Wall mounting, can be snapped onto standard TH35x15 
mounting rails (EN 60715) 

 

Table 8- 7 SITOP UPS1100 7 Ah / 12 Ah 

 6EP4133-0JB00- ... (5 Ah) 6EP4134-0GB00- ... (7 Ah) 6EP4135-0GB00- ... (12 Ah) 
Connection system Screw-type terminal Screw-type terminal 
Connections / DC input X1-1, X1-2: 1 screw terminal 

each for 0.2 - 6 (4) mm² solid 
(finely stranded) 

X1-1, X1-2: 1 screw terminal each for 0.2 - 16 mm² sol-
id/finely stranded 

Connections / signal terminal X2-1, X2-2: 1 screw terminal 
each for 0.14 - 4 (2.5) mm² 
solid (finely stranded) 

X2-1, X2-2: 1 screw terminal each for 0.14 - 4 (2.5) mm² 
solid (finely stranded) 

Width of the housing 189 mm 186 mm 253 mm 
Height of the housing 186 mm 186 mm 186 mm 
Depth of the housing 112.7 mm 110.3 mm 110 mm 
Installation width 189 mm 186 mm 253 mm 
Mounting height 201 mm 201 mm 201 mm 
Weight, approx. 3.4 kg 6.1 kg 9.3 kg 
Product feature /  
of the housing / 
housing that can be lined up 
next to one another 

Yes  

Type of mounting / 
wall mounting 

Yes  

Type of mounting / 
rail mounting 

Yes  

Type of mounting /  
S7-300 rail mounting 

No  

Mounting Wall mounting, can be 
snapped onto standard 
TH35x15 mounting rails 
(EN 60715) 

Wall mounting 
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8.8 Dimension drawing 
see Section Dimensions and weight (Page 39) 

 

CAD data that can be downloaded from the Internet: 

6EP4134-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00813) 

6EP4134-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00816) 

6EP4134-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00819) 

6EP4136-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00810) 

6EP4136-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00807) 

6EP4136-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00804) 

6EP4137-3AB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01019) 

6EP4137-3AB00-1AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01022) 

6EP4137-3AB00-2AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01025) 

6EP4131-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00829) 

6EP4132-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01013) 

6EP4133-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00832) 

6EP4134-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00835) 

6EP4135-0GB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01016) 

6EP4133-0JB00-0AY0 
(http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01105) 

http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00813
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00816
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00819
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00810
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00807
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00804
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01019
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01022
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01025
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00829
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01013
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00832
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_00835
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01016
http://www.automation.siemens.com/bilddb/index.aspx?objKey=G_KT01_XX_01105
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9.1 Safety 
 

 6EP4134-3AB00- ..., 6EP4136-3AB00- ..., 6EP4137-3AB00- ... 
6EP4131-0GB00- ..., 6EP4132-0GB00- ..., 6EP4133-0GB00- ..., 6EP4134-0GB00- ..., 
6EP4135-0GB00- ..., 6EP4133-0JB00- ... 

Protection class Class III 
Degree of protection (EN 
60529) 

IP20 

Test voltage See Table 9-1 Test voltage (Page 222) 
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9.2 Test voltage 
 

 
Figure 9-1 Test voltage diagram 

Only applicable for UPS1600 with PROFINET (-2AY0). 

Only the manufacturer can perform the type test and production test; users can also perform 
the field test.  

Preconditions for performing the field test:  

Test (A) 

● Connect the input, output, BAT and signaling contact with one another and measure with 
respect to PE 

Test (B) 

● Connect all PROFINET cables and measure with respect to PE (input, output, BAT signal 
connector and PE are connected with each other) 

Table 9- 1 Test voltage 

 Test time Input, output, BAT ↔ PE (A) PROFINET ↔ PE (B) 
Type test 60 s 700 VDC 2200 VDC 

60 s 500 VAC 1500 VAC 
Production test 1 s 200 VDC  

1 s 140 VAC  
Field test 1 s 200 VDC 2200 VDC 

1 s 140 VAC 1500 VAC 
 Remark:  

Tripping current for DC measurement: 0 mA 
Tripping current for AC measurement: <100 mA 
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9.3 Approvals 
 

 6EP4134-3AB00- ... 
6EP4136-3AB00- ... 
6EP4137-3AB00- ... 

6EP4131-0GB00-0AY0 
6EP4132-0GB00-0AY0 
6EP4133-0GB00-0AY0 
6EP4133-0JB00-0AY0 
6EP4134-0GB00-0AY0 
6EP4135-0GB00-0AY0 

CE marking Yes, (2004/108/EG) Yes, (2004/108/EG and 2006/66/EG) 
UL/cUL approval cULus-listed (UL 508, CSA 22.2 No. 107.1),  

File E197259 
cURus-Recognized (UL 1778, CSA C22.2 No. 
107.1),  
File E219627 

Explosion protection EPS 13 ATEX 1 607 X IECEx EPS 14.0063X II 
3G Ex nA nC IIC T4 Gc;  
cCSAus HazLoc Class I, Div 2, Group A,B,C,D 
T4;  
cULus HazLoc Class I, Div 2, Group A,B,C,D 
T4 

EPS 13 ATEX 1 607 X IECEx EPS 14.0063X II 
3G Ex nA IIC T4 Gc;  
cCSAus HazLoc Class I, Div 2, Group A,B,C,D 
T4;  
cURus HazLoc Class I, Div 2, Group A,B,C,D 
T4 
6EP4133-0JB00-0AY0: No explosion protection 
certification 

CB certification Yes, (IEC 60950-1) Yes, (IEC 60950-1) 
Marine approvals GL GL 

9.4 EMC 
 

  6EP4134-3AB00- ... (10 A) 
6EP4136-3AB00- ... (20 A) 
6EP4137-3AB00- ... (40 A) 
6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4132-0GB00-0AY0 (2.5 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 
6EP4135-0GB00-0AY0 (12 Ah) 

6EP4133-0JB00-0AY0 
(5 Ah) 

Electrostatic discharge EN 61000-4-2 6 kV contact, 8 kV air 5 kV contact, 8 kV air 
Electromagnetic fields EN 61000-4-3 80 - 1000 MHz 10 V/m 

1400 - 2000 MHz 10 V/m 
2000 - 2700 MHz 10 V/m 
895 - 905 MHz and 1.89 GHz 10 V/m 

High-speed transient disturbance 
variables (burst) 

EN 61000-4-4 2 kV at DC input/output 

Surge voltages EN 61000-4-5 500 V symmetrical/unsymmetrical at the DC input/output, 1 kV un-
symmetrical at signal connections 
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  6EP4134-3AB00- ... (10 A) 
6EP4136-3AB00- ... (20 A) 
6EP4137-3AB00- ... (40 A) 
6EP4131-0GB00-0AY0 (1.2 Ah) 
6EP4132-0GB00-0AY0 (2.5 Ah) 
6EP4133-0GB00-0AY0 (3.2 Ah) 
6EP4134-0GB00-0AY0 (7 Ah) 
6EP4135-0GB00-0AY0 (12 Ah) 

6EP4133-0JB00-0AY0 
(5 Ah) 

High-frequency fields EN 61000-4-6 10 V; 0.15 - 80 MHz 
Magnetic fields EN 61000-4-8 Not applicable 
Emitted interference EN 55022 Class B 
Generic standards EN 61000-6-2 Immunity for industrial environments 

EN 61000-6-3 Emission for residential areas 
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 Environmental conditions 10 
 

 

Table 10- 1 UPS1600 

 6EP4134-3AB00- ... (10 A) 6EP4136-3AB00- ... (20 A) 6EP4137-3AB00- ... (40 A) 
Ambient temperature -25 ... 70 °C for natural convec-

tion (self convection) 
-25 ... 60 °C for natural convec-
tion (self convection) 
15 A (derating) at 60° ... 70° C 

-25 ... 60 °C for natural convec-
tion (self convection) 
30 A (derating) at 60° ... 70° C 

Tested according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-78 humid heat, constant 
• EN 60068-2-14 temperature change 

Remark: The service life of the UPS1100 battery modules (decrease to 50 % of the original ca-
pacity) depends on the battery temperature, at approximately 20 °C: 4 years, 30 °C: 2 years, 
40 °C: 1 year 

Transport and storage 
temperature 

-40 ... 85 °C  
Tests (packed for shipping) according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-30 humid heat, cyclic 

Humidity class Climatic class 3K3 according to EN 60721, 5 - 95 % no condensation 
Degree of pollution 2 
Mechanical  
stress in operation 

Tested according to: 
• EN 60068-2-6 Vibration, test Fc: 

3.5 mm deflection in the range 5 – 9 Hz 
1 g acceleration in the range 9 – 150 Hz 

• EN 60068-2-27 shock, test Ea: 
acceleration 150 m/s2 , test duration 11 ms 

Damaging gases Tested according to: 
• EN 60068-2-42 sulfur dioxide 
• EN 60068-2-43 hydrogen sulfide 

Air pressure Operation: 
• 1080 - 795 hPa (-1000 - 2000 m) 
• For operation at altitudes of 2000 m up to 6000 m above sea level: 

output must be derated by -7.5 % / 1000 m or 
the ambient temperature must be reduced by 5 K / 1000 m 
see Figure 6-20 Altitude derating (Page 202) 

Storage: 
• 1080 - 660 hPa (-1000 - 3500 m) 
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Table 10- 2 UPS1100 

 6EP4131-0GB00-0AY0 
(1.2 Ah) 
6EP4133-0GB00-0AY0 
(3.2 Ah) 
6EP4134-0GB00-0AY0 
(7 Ah) 
6EP4135-0GB00-0AY0 
(12 Ah) 

6EP4132-0GB00-0AY0 
(2.5 Ah) 

6EP4133-0JB00-0AY0 
(5 Ah) 

Ambient temperature 0 ... 40 °C for natural con-
vection (self convection)  
1.2 / 3.2 / 7 Ah:  
From product version 3:  
-15 ... 50 °C for natural con-
vection (self convection)  
12 Ah:  
From product version 2:  
-15 ... 50 °C for natural con-
vection (self convection) 

-20 ... 60 °C for natural con-
vection (self convection) 
 

-20 ... 50 °C for natural con-
vection (self convection) 

Tested according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-78 humid heat, constant 
• EN 60068-2-14 temperature change 

 

Remark: The service life of the UPS1100 battery modules 
(decrease to 50 % of the original capacity) depends on the 
battery temperature, at approximately 20 °C: 4 years, 30 °C: 
2 years, 40 °C: 1 year 

 

Transport and storage tem-
perature 

-20 ... 50 °C -40 ... 60 °C -40 ... 60 °C 
Tests (packed for shipping) according to: 
• EN 60068-2-1 cold 
• EN 60068-2-2 dry heat 
• EN 60068-2-30 humid heat, cyclic 

 

Humidity class Climatic class 3K3 according to EN 60721, 5 - 95 % no 
condensation 

 

Degree of pollution 2  
Mechanical stressing in 
operation 

Tested according to: 
• EN 60068-2-6 Vibration, test Fc: 

3.5 mm deflection in the range 5 – 9 Hz 
1 g acceleration in the range 9 – 150 Hz 

• EN 60068-2-27 shock, test Ea: 
acceleration 150 m/s2 , test duration 11 ms 
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 6EP4131-0GB00-0AY0 
(1.2 Ah) 
6EP4133-0GB00-0AY0 
(3.2 Ah) 
6EP4134-0GB00-0AY0 
(7 Ah) 
6EP4135-0GB00-0AY0 
(12 Ah) 

6EP4132-0GB00-0AY0 
(2.5 Ah) 

6EP4133-0JB00-0AY0 
(5 Ah) 

Damaging gases Tested according to: 
• EN 60068-2-42 sulfur dioxide 
• EN 60068-2-43 hydrogen sulfide 

 

Air pressure Operation: 
• 1080 - 795 hPa (-1000 - 2000 m) 
• Operation at altitudes of 4000 m above sea level and 

higher is not permissible (exception, 2.5 Ah). 
• Operation at installation altitudes of 2000 - 6000 m 

above sea level: 
output power derating of -7.5 % / 1000 m - or 
reduction of the ambient temperature by 5 K / 1000 m 
see Figure 6-20 Altitude derating (Page 202) 

Storage: 
• 1080 - 660 hPa (-1000 - 3500 m) 
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 Environment 11 
 

 

The devices are in conformance with RoHS. 

As a rule, only non-silicon precipitating materials are used. 

Disposal guidelines 
Packaging and packaging aids can and should always be recycled. The product itself may 
not be disposed of as domestic refuse. 

 

 Note 

The rechargeable batteries must be disposed of, discharged according to the applicable 
regulations. 
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 Service & Support 12 
 

 

Technical support 

Technical support for all IA/DT products can be accessed through the following 
communication channels: 

● Telephone: + 49 (0) 911 895 7222 

● Internet: 
 Online support request form (http://www.siemens.de/automation/support-request) 

Technical documentation on the Internet 

Operating instructions and manuals for SITOP are available in the Internet: 
Operating instructions/manuals (http://www.siemens.com/sitop/manuals) 

SITOP power supply homepage 

General news about our power supplies is available in the Internet at the SITOP home page: 
SITOP (http://www.siemens.com/sitop) 

Information material 

SITOP information can be downloaded from the Internet: 
Information and download center (http://www.siemens.com/sitop-infomaterial) 

CAx data 

2D/3D data and circuit diagram macros can be downloaded from the Internet: 
Siemens image database (http://www.siemens.com/sitop-cax) 

Request all CAx data via the CAx download manager: 
CAx shopping cart (http://www.siemens.com/cax) 

SITOP Selection Tool 

Simply and quickly select the optimum the power supply or DC-UPS: 
SITOP Selection Tool (http://www.siemens.com/sitop-selection-tool) 

Online catalog and ordering system 

The online catalog and the online ordering system are available through the Industry Mall 
homepage: 
Industry Mall (http://www.siemens.com/industrymall/de) 

http://www.siemens.de/automation/support-request
http://www.siemens.com/sitop/manuals
http://www.siemens.com/sitop
http://www.siemens.com/sitop-infomaterial
http://www.siemens.com/sitop-cax
http://www.siemens.com/cax
http://www.siemens.com/sitop-selection-tool
http://www.siemens.com/industrymall/de
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Contact persons 

If you have any questions regarding the use of our products, then contact the Siemens 
contact person in your regional Siemens sales office. 

You can find these addresses as follows: 

● On the Internet (http://www.automation.siemens.com/partner) 

● In Catalog CA 01 

http://www.automation.siemens.com/partner
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